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 1
I n t r o d u c t i o n
The Acoustics Module is an optional package that extends the COMSOL 
Multiphysics modeling environment with customized user interfaces and 
functionality optimized for the analysis of acoustics. Like all modules in the 
COMSOL family, it provides a library of prewritten ready-to-run models that make 
it quicker and easier to analyze discipline-specific problems.

This particular module solves problems in the general areas of acoustics, 
acoustic-structure interaction, and vibration. The application modes included here 
are fully multiphysics enabled, making it possible to couple them to any other 
physics application mode in COMSOL Multiphysics or the other modules. Explicit 
demonstrations of these capabilities are supplied with the product, a prominent 
example being a model of a loudspeaker involving both electromechanical and 
acoustic-structural couplings.

The documentation set for the Acoustics Module consists of two books. The one 
in your hands, the Acoustics Module User’s Guide, introduces you to the basic 
functionality in the module, reviews basic modeling techniques, and includes 
reference material of interest to those working in acoustics. The second book in the 
set, the Acoustics Module Model Library, contains several ready-to-run models 
that illustrate real-world applications of the module. Each model comes with an 
introduction covering basic theory and the modeling purpose as well as 
 1



2 |  C H A P T E R  
step-by-step instructions that illustrate how to set it up. Further, we supply these 
models as COMSOL Multiphysics Model MPH-files so you can import them into 
COMSOL Multiphysics for immediate execution. This way you can follow along with 
the printed discussion as well as use them as a jumping-off point for your own 
modeling needs.

We hope you find these models useful. If you have any feedback on the models in this 
set, please let us know. Likewise, we welcome your suggestions for additional models 
that we could add to the library. Finally, if in your work you have developed a model 
you think would be a good candidate for inclusion in this model set, please let us hear 
about it. In any case, feel free to contact us at info@comsol.com.

New Features in the Acoustics Module 3.4

This new release of the Acoustics Module includes a number of valuable new 
capabilities, including the following features:

• New application modes for piezoelectric modeling.

• Ultraweak variational formulation (UWVF) for efficient simulations of pressure 
acoustics.

• Piezoelectric Material Properties database with material properties for 23 common 
piezoelectric materials.

• Improved Model Library including new models of ultrasound scattering, using the 
ultraweak variational formulation, a SAW (surface acoustic wave) gas sensor, and a 
piezoacoustic transducer.

Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
1 :  I N T R O D U C T I O N



the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.

• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates COMSOL Script codes.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
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 2
A c o u s t i c s  M o d u l e  O v e r v i e w  
This manual describes the Acoustics Module, an optional add-on package for 
COMSOL Multiphysics designed to assist you in solving and modeling acoustical 
problems. Here you find an introduction to the modeling stages of the Acoustics 
Module, including some illustrative models as well as information that serves as a 
reference source for more advanced modeling.
 5
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C apab i l i t i e s

What Can the Acoustics Module Do?

The Acoustics Module is a collection of application modes for COMSOL Multiphysics 
adapted to a broad category of acoustics simulations in fluids and solids. Those who 
are not familiar with computational techniques but have a solid background in 
acoustics should find this module extremely beneficial. It can serve equally well as an 
excellent tool for educational purposes.

Because the Acoustics Module is smoothly integrated with all of the COMSOL 
Multiphysics functionality, you can couple a simulation in this module to an arbitrary 
simulation defined in any of the COMSOL Multiphysics application modes. This 
forms a powerful multiphysics  model that solves all the equations simultaneously.

You can transform any model developed with the Acoustics Module into a model 
described by the underlying partial differential equations. This offers a unique way to 
see the underlying physical laws of a simulation. You can also export the simulation 
data and results to COMSOL Script or MATLAB. Alternatively, save the model as a 
Model M-file, a script file that runs in both COMSOL Script and MATLAB. This 
enables you to incorporate models with other products in those technical computing 
environments and to efficiently run parametric studies.

Which Problems Can You Solve?

The Acoustics Module application modes handle acoustics in fluids and solids. The 
application modes for acoustics in fluids support transient, eigenfrequency, 
time-harmonic, and boundary modal analysis in pressure acoustics and aeroacoustics 
in compressible, irrotational velocity fields. The application modes for solids support 
static, transient, eigenfrequency, and frequency response analysis. Further, by coupling 
fluid and solid application modes, you can solve problems involving acoustic-structure 
interaction.

All categories are available in both 2D and 3D. In 2D the Acoustics Module offers 
in-plane application modes for problems with a planar symmetry as well as 
axisymmetric application modes for problems with a cylindrical symmetry. In addition, 
you can use the fluid acoustics application modes with 1D and 1D axisymmetric 
geometries.
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Examples of applications that you can successfully simulate with the Acoustics Module 
include mufflers, loudspeakers, microphones, sound and noise in buildings, 
underwater acoustics, engine noise and vibration, pressure waves in geophysics, and 
ultrasonic sensors. For a more detailed description of many of these applications, refer 
to the matching book that comes with this product, the Acoustics Module Model 
Library.
C A P A B I L I T I E S  |  7
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Fundamen t a l s  o f  A c ou s t i c s

What Is Acoustics?

Acoustics is the physics of sound. Sound is the sensation, as detected by the ear, of very 
small rapid changes in the air pressure above and below a static value. This static value 
is atmospheric pressure (about 100,000 pascals), which varies slowly. Associated with 
a sound pressure wave is a flow of energy. Physically, sound in air is a longitudinal wave 
where the wave motion is in the direction of the movement of energy. The wave crests 
are the pressure maxima, while the troughs represent the pressure minima.

Sound results when the air is disturbed by some source. An example is a vibrating 
object, such as a speaker cone in a hi-fi system. It is possible to see the movement of a 
bass speaker cone when it generates sound at a very low frequency. As the cone moves 
forward, it compresses the air in front of it, causing an increase in air pressure. Then it 
moves back past its resting position and causes a reduction in air pressure. This process 
continues, radiating a wave of alternating high and low pressure at the speed of sound.

Some Standard Acoustics Problems

An acoustics analysis can often be categorized as one of the following standard 
problems or scenarios:

• The radiation problem—A vibrating structure (a speaker, for example) radiates 
sound into the surrounding space. A far-field boundary condition or a PML 
(perfectly matched layer) is necessary to model the unbounded domain.

• The scattering problem—An incident wave impinges on a body and creates a 
scattered wave. A far-field radiation boundary condition or a PML is necessary.

• The sound field in an interior space (such as a room)—The acoustic waves stay in 
a finite volume so no radiation condition is necessary.

• Coupled fluid-elastic structure interaction (structural acoustics)—If the radiating 
or scattering structure consists of an elastic material, you must consider the 
interaction between the body and the surrounding fluid. In the multiphysics 
coupling, the acoustic analysis provides a load (the sound pressure) to the structural 
analysis, and the structural analysis provides accelerations to the acoustic analysis.
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• The transmission problem—An incident sound wave propagates into a body, which 
can have different acoustic properties. Pressure and acceleration are continuous on 
the boundary.

• Aeroacoustic problems—Sound (noise) is generated by turbulent fluid motion or by 
the interaction between a fluid and a surface.

The Acoustics Module provides application modes with accompanying boundary 
conditions and example models for all these types of acoustics analyses.

Depending on the basic dependent variable used to model the acoustic field, the 
acoustical application modes can be divided in two main categories: 

• Pressure Acoustics—The dependent variable is the acoustic pressure, p. 

• Aeroacoustics—The dependent variable is the potential, , for the acoustic 
particle-velocity field, . In the typical situation, the fluid is in motion with 
a total velocity, vtot = V + v, split into a stationary background-flow velocity, V, and 
the particle velocity, v, associated with the acoustic waves.

φ
v φ∇=
F U N D A M E N T A L S  O F  A C O U S T I C S  |  9
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 3
M o d e l i n g  A c o u s t i c s
The goal of this chapter is to familiarize you with the modeling procedure in the 
Acoustics Module. Because this module is totally integrated with COMSOL 
Multiphysics, the modeling process is similar. This chapter also contains an example 
model illustrating the central aspects of the simulation process; it steps you through 
all the stages of modeling—from geometry creation to postprocessing. A number 
of additional models of differing complexity are presented—complete with 
step-by-step instructions—in the Acoustics Module Model Library. All example 
models are also provided as COMSOL Multiphysics MPH-files ready for execution.

Format for the Model Descriptions

The way COMSOL Multiphysics orders its toolbar buttons and menus mirrors the 
basic procedural flow during a modeling session. You work your way from left to 
right in the process of modeling, defining, solving, and postprocessing a problem 
using the COMSOL Multiphysics graphical user interface (GUI). Thus, this 
manual as well as the accompanying Acoustics Module Model Library manual and 
the COMSOL Multiphysics Model Library maintain a certain style convention 
when describing models. The format includes headlines that correspond to each 
major step in the modeling process; the headlines also roughly correspond to the 
various GUI modes and menus. 
 11
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M O D E L  N A V I G A T O R

The Model Navigator appears when you start COMSOL Multiphysics or when you 
restart completely within COMSOL Multiphysics by selecting New from the File menu 
or by clicking on the New toolbar button. On the New tab in the Model Navigator you 
specify the application mode, names of dependent variables, and the analysis type: 
static, time-harmonic, transient, mode analysis or eigenfrequency. You can also set up 
a combination of application modes from the Acoustics Module, COMSOL 
Multiphysics, or any other available module. See the section “Creating and Opening 
Models” on page 20 in the COMSOL Multiphysics Quick Start and Quick Reference 
 for more information about the Model Navigator.

O P T I O N S  A N D  S E T T I N G S

This section reviews basic settings, for example, those for the axes and grid spacing. All 
settings are accessible from the Options menu, and some can be reached by 
double-clicking on the Status bar. It is often convenient to use the Constants dialog box 
to enter constant parameters for the model or use the dialog boxes that you reach by 
pointing to Expressions to enter expression variables. Advanced models may also need 
coupling variables. COMSOL Multiphysics maintains a user-defined library of 
materials accessible through the Materials/Coefficients Library dialog box.

G E O M E T R Y  M O D E L I N G

The process of setting up a model’s geometry requires knowledge of how to use the 
Draw menu and the Draw toolbar. For 2D the details appear in the section “Creating 
a 2D Geometry Model” on page 39 of the COMSOL Multiphysics User’s Guide. For 
3D you find them under “Creating a 3D Geometry Model” on page 56 of the same 
book.

B O U N D A R Y  C O N D I T I O N S

You specify the boundary conditions for a model in the Boundary Settings dialog box. 
For details, see “Specifying Boundary Conditions” on page 234 in the COMSOL 
Multiphysics User’s Guide. You find the boundary conditions for each acoustics 
application mode in the chapters about the Acoustics Module application modes.

S U B D O M A I N  S E T T I N G

You specify equation parameters and material properties in the Subdomain Settings 

dialog box. For details see “Specifying Subdomain Settings and PDE Coefficients” on 
page 205 in the COMSOL Multiphysics User’s Guide. The physical parameters of 
specific interest for acoustics modeling appear in the chapters about the Acoustics 
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Module application modes, where you can also learn about the derivation of the 
equations as well as the boundary conditions.

S C A L A R  V A R I A B L E S

In the Application Scalar Variables dialog box you can examine and modify the values of 
predefined application-specific scalar variables such as the excitation frequency.

M E S H  G E N E R A T I O N

The program must mesh the geometry before it can solve the problem. Sometimes it 
is sufficient to click the Initialize Mesh button on the Main toolbar. In other cases you 
need to adjust settings in the Free Mesh Parameters dialog box and the other 
mesh-generation tools on the Mesh menu. Read more about meshing in “Creating 
Meshes” on page 286 of the COMSOL Multiphysics User’s Guide.

C O M P U T I N G  T H E  S O L U T I O N

To solve a problem, for most cases simply click the Solve button on the Main toolbar. 
In other cases it might be necessary to adjust the solver properties, which you do in 
the Solver Parameters dialog box. For details see “Selecting a Solver” on page 360 of 
the COMSOL Multiphysics User’s Guide.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The powerful visualization of COMSOL Multiphysics tools are accessible in the 
program’s Postprocessing mode, but to use them you must be familiar with the Plot 

Parameters dialog box and the other postprocessing tools on the Postprocessing menu. 
See “Postprocessing Results” on page 420 in the COMSOL Multiphysics User’s 
Guide for details.

A D D I T I O N A L  P O S T P R O C E S S I N G

For further postprocessing calculations, you can export the solution to COMSOL 
Script or MATLAB. Details of modeling by programming are available in the 
COMSOL Multiphysics Scripting Guide.
 |  13
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Bu i l d i n g  and S o l v i n g  an A c ou s t i c s  
Mode l

Introduction

This is an introduction to modeling in the Acoustics Module. The step-by-step 
instructions take you through the process of setting up a model of the sound field 
created by a cylindrical down-firing subwoofer placed on a floor. The important result 
of the simulation is the contribution to the system’s mechanical impedance induced by 
the coupling between the speaker membrane and the air inside and outside the speaker 
enclosure. A polar plot of the far-field is also presented to demonstrate the subwoofer’s 
uniform intensity distribution.

Model Definition

Figure 3-1: The geometry of the subwoofer with a slice removed to show its interior. In the 
illustration the floor is cut off but in the model it is assumed to extend to infinity.

Figure 3-1 shows the geometry simulated in this model. A down-firing cylindrical 
subwoofer is placed on a floor bounding an infinite half-space. The subwoofer 
enclosure has a height of 0.7 m and a diameter of 0.4 m. The bottom of the subwoofer 
is dominated by a 12-inch (0.3 m diameter) membrane. The top has a vent with a 
diameter of 0.1 m.
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The membrane vibrates harmonically with the acceleration  where a0 = 
100 m/s2, and ω = 2π f is the angular frequency (rad/s). The frequencies considered 
is f = 50–70 Hz, which are in the high end of the frequency range that subwoofers are 
typically used for. It is assumed that the walls of the enclosure are perfectly rigid. The 
acoustic medium is air with a density of 1.25 kg/m3 and a sound speed of 343 m/s.

The feet that the speaker would need to stand on are judged to have a negligible effect 
on the sound field. With this assumption, all geometric features and physics have a 
rotational symmetry with respect to the axis of the speaker. This makes it natural to set 
the model up in a 2D axisymmetric application mode.

Results and Discussion

By assuming the membrane is inflexible, you can write Newton’s second law for the 
voice coil and membrane as

 (3-1)

where the forces acting on the system have been split in an applied force, Fext, an 
electrical force opposing the movement of the coil, Femf, a mechanical part, Fm, 
independent of the acoustic environment, and a term, Fa, containing only the effects 
of the fluid loading on the membrane. The external force is typically proportional to 
the applied voltage, while the latter three contributions are proportional to the velocity 
and directed to oppose the movement. Introducing corresponding mechanical 
impedances and using the time-harmonic assumption, it holds that

 (3-2)

If you know the three impedances as functions of frequency, you can predict the 
system’s electrical and mechanical behavior. The electrical force can be measured or 
simulated with a blocked voice coil, while Zm is directly related to the mass of the voice 
coil and membrane as well as to the stiffness of the baffle keeping the voice coil 
centered. These contributions are therefore independent of the environment in which 
the speaker operates.

The acoustic contribution to the mechanical impedance, on the other hand, depends 
on the enclosure geometry and on reflecting surfaces in the immediate surroundings. 
In Figure 3-2 you can study the real and imaginary parts of  Za as functions of 
frequency in the simulated range. The real part represents radiation and acts as a 
resistance in the electromechanical system while the imaginary part represents a 
reactance. 

a a0eiωt
=

ma Fext Femf Fm Fa+ + +=

Fext v iωm Zemf Zm Za+ + +( )=
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Figure 3-2: The resistive (real) and reactive (imaginary) parts of the contribution of the 
air to the speaker’s mechanical impedance.

Note that the reactance switches sign from positive to negative at approximately 
60 Hz. This means that at frequencies below this visible resonance the surrounding air 
acts as an added mass on the membrane, while at higher frequencies its action is 
spring-like.

Figure 3-3 displays the far-field sound pressure level in the rz-plane as a polar plot 
where the distance from the origin represents the intensity heard by a far-away observer 
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multiplied by the observation distance squared. Hence it is normalized so that, on 
average, it equals the local intensity at a distance of 1 m.

Figure 3-3: Far-field sound level in dB normalized to a distance of 1 m from the floor 
below the subwoofer. The large wavelength compared to the size of the speaker system makes 
the response very uniform.

Modeling in COMSOL Multiphysics

This model is set up in 2D axisymmetry using the Pressure Acoustics application mode, 
which is described in detail in Chapter 5. The modeled physical domain is a hemisphere 
with a radius of 1 m. To minimize the effect of nonphysical reflections at the exterior 
boundary of this domain, an absorbing perfectly matched layer (PML) is added outside 
of it. For information about PMLs in acoustics, see the subsection “Perfectly Matched 
Layers (PMLs)” on page 37.

The membrane is modeled with zero thickness. To allow the pressure field to be 
discontinuous across the membrane, the interior and the exterior of the loudspeaker 
are set up as an assembly with two different parts, connected only at the vent. To learn 
more about assemblies, see “Using Assemblies” on page 92 of the COMSOL 
Multiphysics User’s Guide.
B U I L D I N G  A N D  S O L V I N G  A N  A C O U S T I C S  M O D E L  |  17
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Model Library path: Acoustics_Module/Tutorial_Models/
cylindrical_subwoofer

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Start COMSOL Multiphysics.

2 In the Model Navigator, select Axial symmetry (2D) from the Space dimension list.

3 From the list of application modes select Acoustics Module>Pressure 

Acoustics>Time-harmonic analysis.

4 Click OK.

G E O M E T R Y  M O D E L I N G

1 Choose Draw>Specify Objects>Line. Enter the following space-separated list of 
coordinates:

2 From the Style list, select Closed polyline (solid), then click OK.

3 Choose Draw>Specify Objects>Line again. Enter the following coordinates:

4 From the Style list, select Closed polyline (solid), then click OK.

5 Choose Draw>Specify Objects>Circle. Keep the default 1 for the Radius and click OK.

6 Create another circle, this time with a radius of 1.5.

7 Choose Draw>Specify Objects>Square. Set the Width to 1.5, then click OK.

8 Choose Draw>Create Composite Object. Type SQ1*(C1+C2)+CO1-CO2 in the Set 
formula edit field, then click OK.

9 Click the Zoom Extents button on the Main toolbar.

10 Click the Split Object button on the Draw toolbar.

r 0 0.06 0.15 0.18 0.18 0.05 0

z 0.2 0.2 0.12 0.12 0.78 0.78 0.78

r 0.15 0.2 0.2 0.05 0.05 0.18 0.18 0.15

z 0.1 0.1 0.8 0.8 0.78 0.78 0.12 0.12
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11 Select the objects CO1 and CO4 (by Shift-clicking in the geometry), then click the 
Union button on the Draw toolbar.

12 Choose Draw>Use Assembly.

Your geometry should now contain two objects, CO2 and CO3, and look like that in 
Figure 3-4.

Figure 3-4: Model geometry.

O P T I O N S  A N D  S E T T I N G S

This model uses a constant to represent the membrane’s peak acceleration, an 
integration variable to calculate the total force acting on the membrane, and expression 
variables to define the far-field sound pressure level and the mechanical impedance of 
the membrane-air system.

1 Open the Constants dialog box from the Options menu and define the constant a0 
according to the following table; when done, click OK.

The air load on the membrane acts in the direction normal to the membrane surface 
and with magnitude equal to the acoustic pressure. Due to the axial symmetry, the 

NAME EXPRESSION DESCRIPTION

a0 10[m/s^2] Peak acceleration
B U I L D I N G  A N D  S O L V I N G  A N  A C O U S T I C S  M O D E L  |  19
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resultant force must be in the axial direction and equal to the integral of the z 
component of the load vector

where nz is the z component of the surface unit normal (directed out from the 
acoustic domain) and the integral is taken over both sides of the membrane. Note 
that you must multiply the integrand by the factor 2πr to obtain an integral over the 
true 3D surface.

2 Choose Options>Integration Coupling Variables>Boundary Variables.

3 Select the membrane boundaries and create an integration coupling variable for the 
force acting on the membrane as follows:

4 Click OK to close the dialog box.

5 Now you will enter the expression for the impedance (see Equation 3-2 on page 
15). Choose Options>Expressions>Global Expressions and add the following 
expression:

6 Click OK.

P H Y S I C S  S E T T I N G S

Subdomain Settings
1 Choose Physics>Subdomain Settings.

2 Select Subdomain 2 and click the PML tab.

3 Select Type of PML: Spherical. Select the Absorbing in radial dir. check box.

The software’s automatic detection of the PML’s geometric properties correctly 
determines the PML’s width and inner radius, and the default value for the PML 
center point applies. The evanescent part of the wave leaving from the vent is 
expected to decay with a characteristic length much shorter than the wavelength. 
Increasing the PML scaling exponent helps the PML resolve the damping of the 
evanescent wave.

BOUNDARIES NAME EXPRESSION INTEGRATION ORDER GLOBAL DESTINATION

3, 9, 17, 20 F_a 2*pi*r*p*nz 4 yes

NAME EXPRESSION DESCRIPTION

Z_a -F_a/(a0/(i*2*pi*freq_acpr)) Mechanical impedance

Fz pnz sd
S
∫=
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4 Enter 2 in the PML scaling exponent edit field.

5 Click OK to close the dialog box.

Boundary Settings
Because the geometry of the subwoofer model is represented as an assembly, you need 
to create identity pairs where the parts of the assembly are connected and interact with 
each other. In this case the pressure is continuous across the top vent, which therefore 
must be made into an identity pair.

1 Choose Physics>Identity Pairs>Identity Boundary Pairs.

2 Click the New button. Select the check box for Boundary 18 in the Source boundaries 
list and the check box for Boundary 5 in the Destination boundaries list. Click OK to 
close the dialog box.

You need to set the inward normal acceleration on both sides of the membrane to 
drive the model. Because the membrane’s movement is in the axial direction only, 
the inward normal component of the acceleration at the surface equals the 
magnitude multiplied by the negative z component of the normal unit vector. This 
holds because the normal unit vector is directed out from the acoustics domain.

3 Choose Physics>Boundary Settings and apply the following boundary conditions; 
when done, click OK.

Far-Field Settings
If you know the pressure and normal velocity on a closed surface containing all sources 
and objects in the model, you can evaluate the far-field radiation pattern as an explicit 
integral for each direction. The far-field pattern is defined as a limit

where ρ is the distance from the center of the coordinate system and k is the wave 
number. The magnitude of the far field is comparable to the pressure at a spherical 
surface with a radius of 1 m but shows the radiation pattern experienced by a far-away 
listener.

The hard floor is excluded from the integral by noting that the radiation pattern is 
exactly the same as if replacing the floor with a mirror image of the subwoofer that is 

SETTINGS BOUNDARIES 1, 4, 6, 16 BOUNDARIES 3, 9, 17, 20

Boundary condition Axial symmetry Normal acceleration

an - -a0*nz

pfar  ρeikρ
ρ ∞→
lim p=
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instead included in the integral. You need not worry about any of these details, 
however, because the automatic far-field calculation sets up the integral for you.

1 Still in the Boundary Settings dialog box, click the Far-Field tab.

2 Select all physical boundaries of the subwoofer by Shift-clicking in the geometry or 
Ctrl-clicking in the Boundary selection list. The selected boundary numbers should 
be 3, 7–12, 17, and 19–22. Note that you must select the boundaries representing 
both sides of the membrane in order to include all contributions to the far field.

3 Click the Name edit field and enter p_far. Select another edit field on the same row 
in the table to see the default values of the settings for this far-field variable.

4 Select the Symmetry planes: z = 0 check box. Keep the default Symmetric pressure 
option. This means that the far field accounts for the perfectly reflecting floor by 
adding contributions from an imagined mirror copy (with respect to  z = 0) of the 
subwoofer.

5 Click OK.

M E S H  G E N E R A T I O N

Solutions to acoustics models are wave-like with a fixed wavelength that must be 
resolved. In addition, small features in the geometry can induce high local pressure 
gradients that must be resolved properly to obtain a consistent global solution. In this 
particular model, the wavelength is greater than 5m so the focus is on resolving the 
geometry.

1 Choose Mesh>Free Mesh Parameters.

2 Select Finer from the Predefined mesh size list.

3 Go to the Boundary page, select Boundaries 5, 7, and 18, then set the Maximum 

element size to 0.001.

4 Click OK.

5 Click the Initialize Mesh button on the Main toolbar

C O M P U T I N G  T H E  S O L U T I O N

Time-harmonic acoustics can be solved either with the stationary solver for a single 
frequency or with the parametric solver when you specify a frequency range. The 
frequency parameter freq_acpr is defined in the Application Scalar Variables dialog box 
(select Physics>Scalar Variables), but the parametric solver lets you override this—and 
almost any other variable—during the solution.

1 Choose Solve>Solver Parameters.
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2 Select the Parametric solver in the list on the left.

3 Set Name of parameter to freq_acpr and enter 30:1:70 in the List of parameter 

values edit field.

4 Click OK to close the dialog box.

5 Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the pressure field for the last parameter value, 70 Hz. By 
default, the postprocessing algorithms try to smooth discontinuous fields. To avoid 
this happening at the membrane, where the field really should be discontinuous, follow 
these steps:

1 Click the Plot Parameters button on the Main toolbar to open the Plot Parameters 
dialog box.

2 Go to the Surface page and clear the Smooth check box.

3 Click Apply to update the plot, which now resembles this screen shot:

Figure 4: Default plot showing the acoustic pressure in and around the subwoofer.
B U I L D I N G  A N D  S O L V I N G  A N  A C O U S T I C S  M O D E L  |  23



24 |  C H A P T E R
Note that the pressure drops rapidly toward zero in the PML domain. To get a better 
view of the damping try plotting the sound pressure level in dB:

1 While still on the Surface page in the Plot Parameters dialog box, choose Pressure 

Acoustics (acpr)>Sound pressure level from the Predefined quantities list. 

2 Click the Height Data tab, select the Height Data check box, then also choose Pressure 

Acoustics (acpr)>Sound pressure level from this Predefined quantities list.

3 Click OK.

With a visual inspection you can see that the pressure drop in the PML is roughly 
50 dB. This means that the part of the wave that is reflected at the exterior boundary 
experiences a total of 100 dB damping before it returns to physical domain. In other 
words, the reflected wave has virtually no effect on the solution.

Proceed to display the previously defined impedance variable Z_a as function of 
frequency:

1 Choose Postprocessing>Global Variables Plot. 

2 Enter real(Z_a) in the Expression edit field and click the > button immediately to 
the right of the field.

3 Enter imag(Z_a) in the same field and again click the > button.

4 Click the Line Settings button.

5 Select Cycle in the Line marker list and select the Legend check box.

6 Click OK, then OK again to close the Global Variables Plot dialog box and display the 
result, which should be similar to Figure 3-2.

Finally check that the far-field pressure distribution is indeed as uniform as you would 
expect from a subwoofer. The following trick gives you a polar plot where the distance 
from the origin represents the sound pressure level normalized to a distance of 1 m.

1 Choose Postprocessing>Domain Plot Parameters. 

2 Select the 70 Hz solution in the Solution to use list.

3 Click the Line/Extrusion tab and select Boundary 14.

4 Type Lp_far_acpr*z in the Expression edit field. 

5 Click the Expression option button and then click the Expression button on the 
x-axis data panel.

6 In the dialog box that appears, type Lp_far_acpr*r in the Expression edit field.
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7 Click OK, then OK again to see the plot of the far-field pressure as a function of the 
polar angle. It takes a few seconds to appear, but when it does it should look like 
Figure 3-3.

To get a clearer picture of the subwoofer and the sound field, display only the physical 
boundaries in black and suppress the PML.

1 Choose Options>Suppress>Suppress Boundaries.

2 Select Boundaries 1, 4–6, 13–16, and 18, then click OK.

3 Choose Options>Suppress>Suppress Subdomains.

4 Select Subdomain 2, then click OK.

5 Choose Postprocessing>Plot Parameters.

6 On the Height Data tab of the Surface page, clear the Height data check box.

7 On the General page of the Plot Parameters dialog box, clear the Geometry edges 
check box and select the Boundary check box in the Plot type list.

8 On the Boundary page, click the Uniform color option button. Click the Color button 
and select a black color.

9 Click OK to see the plot of the acoustic pressure again, this time with only the 
physical boundaries and no PML displayed.
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S ome A s p e c t s  o f  A c ou s t i c s  Mode l i n g

There are certain difficulties that often arise when modeling acoustics, such as the 
rather severe requirements on the mesh resolution, the modeling of artificial 
boundaries, and the modeling of real-world damping materials. This section discusses 
how to deal with these issues and describes some of the features included in the 
Acoustics Module for simplifying the modeling process.

Resolving the Waves

Solutions to acoustic problems are wave like. The waves are characterized by a 
wavelength λ in space, whose value depends on the frequency and speed of sound c in 
the medium according to λ = c/f. This wavelength has to be resolved by the mesh.

For the solution on the discrete grid to have any meaning at all there has to be at least 
two degrees of freedom (DOFs) per wavelength in the direction of propagation, but 
such coarse a solution is useless in practice. In reality, the lower limit for a fully reliable 
solution lies at about ten to twelve degrees of freedom per wavelength.

Because the direction of propagation is generally not known beforehand, it is good 
practice to aim for an isotropic mesh with about twelve DOFs per wavelength on 
average, independently of the direction. Therefore the number of DOFs in a 
sufficiently resolved mesh will be about

• 12 times the model length measured in wavelengths in 1D

• 144 times the model area measured in wavelengths squared in 2D

• 1728 times the model volume measured in wavelengths cubed in 3D

Before starting a new model, try to estimate the required number of DOFs using these 
rules of thumb. The maximum number of DOFs that can be solved for differs between 
computer systems, but a 32-bit system can usually deal with somewhere from a few 
hundred thousand up to a million DOFs. Even on a 64-bit system, more than a few 
million DOFs is cumbersome to handle.

U S I N G  L A G R A N G E  E L E M E N T S  ( D E F A U L T )

When creating an unstructured mesh for use with the default 2nd-order Lagrange 
elements, set the maximum element size, hmax, to about 0.2 λ. Because all elements in 
the constructed mesh are smaller than hmax, the limit is set larger than the actual 
required element size. After meshing the model, check the total number of DOFs 
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against the model volume and the above rules of thumb. If the mesh turns out to be 
too coarse or too fine on average, try to change hmax accordingly.

Note that unstructured meshes are generally better than structured for wave problems 
where the direction of wave propagation is not known everywhere in advance. The 
reason is that in a structured mesh, the average resolution differs very much between 
directions parallel to the grid lines and directions rotated 45 degrees about one of the 
axes.

U S I N G  T H E  U L T R A W E A K  V A R I A T I O N A L  F O R M U L A T I O N

In the ultraweak variational formulation (UWVF), the rules for how to determine a 
suitable mesh size are different. This formulation uses Ultraweak Helmholtz elements 
(shuwhelm), whose basis functions are free-space solutions to the Helmholtz equation, 
that is, plane waves. Because the finite elements in the UWVF thus contain information 
about the solution to the wave equation, the mesh elements must be larger in relation 
to the wavelength than when using ordinary Lagrange elements. As a rule of thumb, 
aim for a maximum mesh-element size, hmax, of roughly 2–3 times the wavelength. A 
too fine mesh can lead to convergence problems, while a too coarse mesh reduces the 
accuracy of the solution. Also, for the UWVF to work well, the mesh should be 
reasonably uniform.

Because it requires a much coarser mesh, the UWVF is suitable for models where the 
wavelength is small, and for which ordinary Lagrange elements therefore would need 
an excessively dense mesh.

Note: Because of the coarse mesh, when visualizing a solution computed in the 
ultraweak variational formulation, you need to raise the element refinement on the 
General page of the Plot Parameters dialog box. An element-refinement factor around 
20 gives good result for the default UWVF elements with 20 plane-wave basis 
directions.

Damping

Fluids with bulk viscosity in the same range as air or water—by far the most common 
media in acoustics simulations—exhibit practically no internal damping over the 
number of wavelengths that can be resolved on current computers. Instead, damping 
takes place through interaction with solids, either because of friction between the fluid 
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and a porous material filling the domain, or because acoustic energy is transferred to a 
surrounding solid where it is absorbed.

P O R O U S  A B S O R B I N G  M A T E R I A L S

For frequency-domain modeling, the most convenient and compact description of a 
damping material (material here refers to the homogenization of a fluid and a porous 
solid) is given by its complex wave number, kc, and complex impedance, Zc, both 
functions of frequency. Knowing these properties, you can define a complex speed of 
sound as cc = ω/kc and a complex density as ρc = kc Zc/ω.

It is possible to directly measure the complex wave number and impedance in an 
impedance tube in order to produce curves of the real and imaginary parts (the 
resistance and reactance, respectively) as functions of frequency. This data can be used 
directly as input to COMSOL Multiphysics’ interpolation functions to define kc and 
Zc in the application modes.

Sometimes, however, you cannot obtain acoustic properties directly for a material you 
want to try in a model. In that case you must resort to knowledge about basic material 
properties independent of frequency. For a highly porous material with a rigid 
skeleton, the well-known model of Delany and Bazley can estimate the complex wave 
number and impedance as functions of frequency and flow resistivity.

For further details on how to implement damping in your acoustics model, see page 
71 in the “Pressure Acoustics” chapter.

D A M P I N G  A T  B O U N D A R I E S

Acoustics in closed ducts and cavities appears to be easier to deal with than exterior 
problems because no artificial boundary condition is necessary. On the other hand, 
real-world cavity walls are usually either treated in some way (lined) or elastic in 
themselves.

The problem is that a liner typically reflects part of the wave and does so not at the 
interface with the domain but somewhere inside the liner or at its back wall against 
whatever structure is outside. This means that a liner boundary condition must contain 
more information about the outside world than an absorbing boundary. It also means 
that a real-world liner cannot be adequately described by a local boundary condition 
because waves at oblique incidence cause waves to propagate in the tangential direction 
inside the liner layer.

In fact, there seems to be no final answer as to how the process inside a porous liner is 
most accurately modeled. Various assumptions can be made about the interaction 
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between the fluid pressure waves and the liner material and about boundary conditions 
between liner and free fluid and at the back of the liner. The most accurate ways to deal 
with the situation includes modeling the actual liner layer. It is only possible to use a 
general impedance boundary condition for thin liners and when the angle of incidence 
is known for a liner that cannot be assumed locally reacting, an assumption that rarely 
holds with any justification. For an example that nevertheless uses this assumption, see 
“Flow Duct” on page 101 in the Acoustics Module Model Library.

Artificial Boundaries

In most cases, the acoustic wave pattern which is to be simulated is not contained in a 
closed cavity. That is, there are boundaries in the model which do not represent a 
physical wall or limit of any kind. Instead, the boundary condition has to represent the 
interaction between the wave pattern inside the model and everything outside. 
Conditions of this kind are generically referred to as artificial boundary conditions.

Such conditions should ideally contain complete information about the outside world, 
but this is obviously not practical. After all, the artificial boundary was introduced to 
avoid spending DOFs on modeling whatever is outside. The solution lies in trying to 
approximate the behavior of waves outside the domain using only information from 
the boundary itself. For obvious reasons, this is difficult in general.

One particular case which occurs frequently in acoustics concerns boundaries which 
can be assumed to let wave energy propagate out from the domain without reflections. 
This leads to the introduction of a particular group of artificial boundary conditions 
known as nonreflecting boundary conditions, of which two kinds are available in the 
Acoustic Module: matched boundary conditions and radiation boundary conditions. 
The former apply primarily to wave guide ports connected to a cavity, while the latter 
approximate the boundary at infinity in an exterior problem. A drawback of these 
boundary conditions is that they are not perfectly nonreflecting when subjected to a 
general incoming wave. They are described in more detail in the section “Boundary 
Conditions” on page 76 and onward.

The models “Absorptive Muffler” on page 74 and “Muffler with Perforates” on page 
154 of the Acoustics Module Model Library both use a nonreflecting boundary 
condition of the radiation type.
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Evaluating the Acoustic Field in the Far-Field Region

The Acoustics Module provides functionality for evaluating the acoustic pressure field 
in the far-field region. This section gives the relevant definitions and mathematical 
background as well as some general advice for analyzing the far field. Details on how 
to use the far-field functionality appear in the section “Far-Field Modeling” on page 
90.

T H E  N E A R - F I E L D  A N D  F A R - F I E L D  R E G I O N S

The solution domain for a scattering or radiation problem can be divided into two 
zones, reflecting the behavior of the solution at various distances from objects and 
sources. In the far-field region, scattered or emitted waves are locally planar; velocity 
and pressure are in phase with each other; and the ratio between pressure and velocity 
approaches the free-space impedance of a plane wave.

Moving closer to the sources into the near-field region, pressure and velocity 
gradually slide out of phase. This means that the acoustic field contains energy that 
does not travel outward or radiate. These evanescent wave components are effectively 
trapped close to the their source. Looking at the sound pressure level, local maxima 
and minima are apparent in the near-field region.

Naturally, the boundary between the near-field and far-field regions is not sharp. A rule 
of thumb in line with the above definitions is that the far-field region is that beyond 
the last local energy maximum, that is, the region where the pressure amplitude drops 
monotonously at a rate inversely proportional to the distance from any source or 
object, R.

A similar definition of the far-field region is the region where the radiation pattern—
the locations of local minima and maxima in space—is independent of the distance to 
the wave source. This is equivalent to the criterion for Fraunhofer diffraction in optics, 
which occurs for Fresnel numbers, F = a2/λ R, much smaller than 1. For engineering 
purposes, the following definition of the far-field region can therefore be applied:

.

In this formula, a is the radius of a sphere enclosing all objects and sources, λ is the 
wavelength, and k is the wave number. The second way of writing the expression leads 
to the useful observation that the size of the near-field region expressed in 
source-radius units is proportional to the dimensionless number k a, with a prefactor 
slightly larger than one.

R 8a2

λ
----------> 8

2π
------ka2=
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Knowing the extent of the near-field region is useful when applying radiation 
boundary conditions because these are accurate only in the far-field region. PMLs, on 
the other hand, can be used to truncate a domain already inside the near-field region.

T H E  H E L M H O L T Z - K I R C H H O F F  I N T E G R A L  R E P R E S E N T A T I O N

In many cases, solving the acoustic Helmholtz equation everywhere in the domain 
where results are requested is neither practical nor necessary. For homogeneous media, 
the solution anywhere outside a closed surface containing all sources can be written as 
a boundary integral in terms of quantities evaluated on the surface. To evaluate this 
so-called Helmholtz-Kirchhoff   integral, it is necessary to know both Dirichlet and 
Neumann values on the surface. Applied to acoustics, this means that if you know the 
pressure and its normal derivative (which is related to the normal velocity) on a closed 
surface, you can calculate the acoustic field at any point outside.

In general, the solution, p, to Helmholtz’ equation

in the homogeneous domain exterior to a closed surface, S, can be explicitly expressed 
in terms of the values of  p and its normal derivative on S:

.

Here the coordinate vector r parameterizes S. The unit vector n is the outward normal 
to the exterior infinite domain; thus, n points into  the domain that S encloses. The 
function G (R, r) is a Green’s function satisfying

.

This essentially means that the Green’s function seen as a function of  r is an outgoing 
traveling wave excited by a simple source at R. In 3D, the Green’s function therefore 
is simply

.

In 2D, the Green’s function contains a Hankel function instead of the exponential:

.

Inserting the 3D Green’s function in the general representation formula gives

∇ p∇⋅– k2 p– 0=

p R( ) G R r,( ) p r( )∇ G R r,( ) p r( )∇–( ) n⋅ Sd
S
∫=

∇ G R r,( )∇⋅– k2G R r,( )– δ 3( ) R r–( )=

G R r,( ) e ik r R––

4π r R–
------------------------=

G R r,( ) i
4
---H0

2( ) k r R–( )=
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,  (4-3)

while in 2D, the Hankel function leads to a slightly different expression

 (4-4)

For axially symmetric geometries, the full 3D integral must be evaluated. To this end, 
the Acoustics Module uses an adaptive numerical quadrature in the azimuthal direction 
on a fictitious revolved geometry in addition to the standard mesh-based quadrature 
in the rz-plane.

To evaluate the full Helmholtz-Kirchhoff integral in Equation 4-3 and Equation 4-4, 
use the Full integral option in the settings for the far-field variables (see “Specifying 
Variables for Far-Field Postprocessing” on page 90).

T H E  F A R - F I E L D  L I M I T

The full Helmholtz-Kirchhoff integral gives the pressure at any point at a finite 
distance from the source surface, but the numerical integration tends to lose accuracy 
at large distances. At the same time, in many applications the quantity of interest is the 
far-field radiation pattern, which can be defined as the limit of r | p | when r goes to 
infinity in a given direction.

Taking the limit of Equation 4-3 when | R | goes to infinity and ignoring the rapidly 
oscillating phase factor, the far field, pfar, is defined as

.

Note that the relevant quantity is | pfar| rather than pfar because the phase of the latter 
is undefined. For the same reason, only the direction of  R is important, not its 
magnitude.

Because Hankel functions asymptotically approach exponentials, the limiting 2D 
integral is remarkably similar to that in the 3D case:

.
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For axially symmetric geometries, the azimuthal integral of the limiting 3D case can be 
handled analytically, which leads to a rather complicated expression but avoids the 
numerical quadrature required in the general case. For the circumferential wave 
number m = 0, the expression is

In this integral, r and z are the radial and axial components of r, while R and Z are the 
radial and axial components of R.

To evaluate the pressure in the far-field limit according to the equations in this section, 
use the Integral approximation at r →   option in the settings for the far-field variables 
(see “Specifying Variables for Far-Field Postprocessing” on page 90).

T H E  E L K E R N E L  E L E M E N T

The above integrals can be implemented as integration coupling variables in COMSOL 
Multiphysics. However, such an approach is very inefficient because then the simple 
structure of the integration kernels cannot be exploited. In the Acoustics Module, 
convolution integrals of this type are therefore evaluated in optimized code that hides 
all details from the user. For further details, see the entry on elkernel on page 93 of 
the COMSOL Multiphysics Reference Guide.

Solving Large Acoustics Problems Using Multigrid

The following section provides some guidance for solving large acoustics problems. 
For smaller problems, using a direct solver is usually the best choice. For larger 
problems, especially in 3D, the only option is often to use an iterative method such as 
multigrid.

The underlying equation for many of the problems within acoustics is the Helmholtz 
equation. For high frequencies (or wave numbers) the matrix resulting from a 
finite-element discretization becomes highly indefinite. In such situations it can be 
problematic to use geometric multigrid with simple smoothers such as Jacobi. 
Fortunately, there exist robust and memory-efficient approaches that circumvent many 
of the difficulties associated with solving the Helmholtz equation using geometric 
multigrid.
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When using geometric multigrid as linear system solver together with simple 
smoothers, you must ensure that the Nyquist criterion is fulfilled on the coarsest mesh; 
see “Notes on the Efficiency of Smoothers” on page 522 in the COMSOL 
Multiphysics Reference Guide. If the Nyquist criterion is not satisfied, the geometric 
multigrid solver might not converge. One way to get around this problem is to use 
GMRES (see “The GMRES Iterative Solver” on page 512 in the COMSOL 
Multiphysics Reference Guide) as linear system solver with geometric multigrid as 
preconditioner. Even if the Nyquist criterion is not fulfilled for the coarse meshes of 
the multigrid preconditioner, such a scheme is more likely to converge. For problems 
with high frequencies this approach might, however, lead to a large number of 
iterations. Then it might be advantageous to use either geometric multigrid as linear 
system solver with GMRES as smoother or FGMRES (see “The FGMRES Iterative 
Solver” on page 513 in the COMSOL Multiphysics Reference Guide) as linear system 
solver with geometric multigrid as preconditioner (where GMRES is used as 
smoother). Using GMRES/FGMRES as outer iteration and smoother removes the 
requirements on the coarsest mesh. When you use GMRES as smoother for the 
multigrid preconditioner you must use FGMRES for the outer iterations because such 
a preconditioner is not constant (see Ref. 1). Use GMRES as a smoother only if 
necessary because GMRES smoothing is very time and memory consuming on fine 
meshes, especially for many smoothing steps.

To summarize, the options you can try when solving large acoustics problems are (in 
increasing order of robustness and memory requirements):

• If the Nyquist criterion is fulfilled on the coarsest mesh, try to use geometric 
multigrid as linear system solver with default smoothers. The default smoothers are 
fast and have small memory requirements. You get this option if you select 
Geometric multigrid in the Linear system solver list on the General page of the Solver 

Parameters dialog box.

• An option more robust than the above is to use GMRES as linear system solver with 
geometric multigrid as preconditioner (where default smoothers are used). GMRES 
requires memory for storing search vectors. To get this option, select GMRES as 
Linear system solver and Geometric multigrid as Preconditioner.

• If the above step does not work, try to use geometric multigrid as linear system 
solver with GMRES as smoother. See below for recommended settings for the 
smoother. When using GMRES as smoother, the software stores search vectors on 
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all multigrid levels and for both presmoothing and postsmoothing. GMRES is also 
a slower smoother than the simple iterations.

• If the solver still has problems to converge, try to use FGMRES as linear system 
solver with geometric multigrid as preconditioner (where GMRES is used as 
smoother). See below for recommended settings for the smoother and FGMRES. 
In addition to the memory used by the previous step this option also stores search 
vectors for the outer FGMRES iteration.

Note: The second option of the above four can sometimes be used successfully even 
when the Nyquist criterion is not fulfilled on coarser meshes. Because GMRES is not 
used as smoother, this option might find a solution faster than the last two options 
even if a large number of outer iterations are needed for convergence.

Try to use as many multigrid levels as needed to produce a coarse mesh for which a 
direct method can solve the problem without using a substantial amount of memory 
(see “Constructing a Multigrid Hierarchy” on page 522 in the COMSOL Multiphysics 
Reference Guide).

If the coarse mesh still is too fine for a direct solver, try using an iterative solver with 
5–10 iterations as coarse solver (see “Settings for the Coarse Solver” on page 527 in 
the COMSOL Multiphysics Reference Guide).

Use the V-cycle as Multigrid cycle (the default). If this does not work, try first the 
F-cycle and then the W-cycle.

To use GMRES as presmoother, select Presmoother in the tree in the Linear System 

Solver Settings dialog box. Try to set the Number of iterations to 2 or 3. It is also 
recommended that you turn off the preconditioner for the smoother by selecting None 
from the Preconditioner list.

When using GMRES as postsmoother, try to use somewhere between 10 and 40 
postsmoothing iterations. This makes each iteration slow, but using too few 
postsmoothing steps might decrease the convergence rate considerably. It is also 
recommended that you turn off the preconditioner for the smoother by selecting None 
from the Preconditioner list.

When using FGMRES as an outer iteration, if too much memory is needed by the 
algorithm try decreasing the Number of iterations before restart from the default 50 to, 
say, 20. If the memory requirements still are too large, and many GMRES 
S O M E  A S P E C T S  O F  A C O U S T I C S  M O D E L I N G  |  35



36 |  C H A P T E R
postsmoothing steps are used, try decreasing the Number of iterations before restart for 
the postsmoother to 5–10. Note that this might slow down the convergence rate 
considerably.

Reference

1. Saad, Y., “A flexible inner-outer preconditioned GMRES algorithm,” SIAM J. Sci. 
Statist. Comput., vol. 14, pp. 461–469, 1993.
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Pe r f e c t l y  Ma t c h ed L a y e r s  ( PML s )

In many scattering and waveguide-modeling problems, you cannot describe the 
incident radiation as a plane wave with a well-known direction of propagation. In such 
situations, consider using perfectly matched layers or PMLs (see Ref. 1). A PML is 
strictly speaking not a boundary condition but an additional domain that absorbs the 
incident radiation without producing reflections. It provides good performance for a 
wide range of incidence angles and is not particularly sensitive to the shape of the wave 
fronts. The PML formulation introduces a complex-valued coordinate transformation 
under the additional requirement that the wave impedance should not be affected.

The following section describes how to use the PMLs in the Acoustics Module to 
create planar, cylindrical, and spherical PMLs. For information about PMLs for elastic 
waves in solids, see the section “Perfectly Matched Layers (PMLs)” on page 171 in the 
“Structural Mechanics Application Modes” chapter.

PML Implementation

For a PML that absorbs waves in the coordinate direction ξ, the Acoustics Module uses 
the following coordinate transformation inside the PML:

 (4-5)

The scaled PML width, L; the coordinate of the inner PML boundary, ξ0; and the 
(actual) width of the PML, δξ, are input parameters for each orthogonal absorbing 
coordinate direction. The scaling exponent, n is an input parameter for each PML 
subdomain.

The default value for L is one wavelength, λ = cs/f, which is appropriate for acoustic 
waves propagating along the absorbing coordinate direction, ξ. To preserve the 
attenuation level for obliquely incident waves, you need to adjust the scaled PML 
width; for a wave with wave vector k, the optimal value for L in the coordinate 
direction ξ is , where is a unit vector in the ξ direction, 
and ϑ is the angle between k and .  Thus, you should multiply the default value for 
the scaled PML width by the factor | cos ϑ |−1 . Note that if you increase L, you need to 
make sure that the mesh resolution is sufficient to resolve the number of wavelengths 
that fit inside the adjusted scaled width.

ξ' sign ξ ξ0–( ) ξ ξ0–
n L

δξn
--------- 1 i–( )=

2π k eξ⋅⁄ λ ϑcos⁄= eξ
eξ
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The default value of the scaling exponent is 1, which gives a linear scaling that works 
well in most cases. For scattering problems and models where different wavelengths 
should be absorbed (outside waveguides, for example) you can increase the exponent 
somewhat, the useful range for n being roughly between 1 and 2. Increasing the 
exponent allows you to use fewer mesh elements to resolve wavelengths much smaller 
than the scaled PML width.

The parameters ξ0 and δξ get default settings that the software deduces from the drawn 
geometry and stores in so-called guess variables. You can inspect the values of the guess 
variables on the Variables page of the Subdomain Settings - Equation System dialog box 
or at the corresponding node of the Model Tree.

The default settings defined by the guess variables work nicely in most cases, but they 
might fail for PML subdomains of a nonstandard shape. Examples of geometries that 
work nicely are shown in the following figures for each of the available PML types:

• Cartesian—PMLs absorbing in Cartesian coordinate directions.

• Cylindrical—PMLs absorbing in cylindrical coordinate directions from a specified 
axis. For axisymmetric geometries the cylinder axis is the z-axis.

• Spherical—PMLs absorbing in the radial direction from a specified center point.

For each of the above PML types, you can choose the coordinate directions in which 
the PML absorbs waves, that is, for which directions a coordinate transformation of 
the type Equation 4-5 applies. To allow complete flexibility in defining a PML there 
is, in addition, a fourth option:

• User defined—General PMLs or domain scaling with user-defined coordinate 
transformations.
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Figure 4-1: A cube surrounded by typical PML regions of the type “Cartesian.”

Figure 4-2: A cylinder surrounded by typical cylindrical PML regions.
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Figure 4-3: A sphere surrounded by a typical spherical PML region.

How to Set Up a PML

This is a tutorial example showing how to add PMLs. In the Acoustic Module you can 
define perfectly matched layers by adding additional subdomains outside the 
boundaries that you want to model as absorbing. This model shows a wave 
propagating from a vibrating cylinder in two dimensions.

D O M A I N  E Q U A T I O N S

The model solves the following equation for the acoustic pressure:

To define the PMLs you introduce a new subdomain around the air domain 
representing absorbing layers. In this model the cylinder is positioned slightly off 
center in the air domain because this geometry gives a better view of how the PML 
absorbs the waves.

B O U N D A R Y  C O N D I T I O N S

The cylinder vibrates with a normal acceleration amplitude equal to 1 m/s2.

∇ 1
ρ0
------– p∇⎝ ⎠

⎛ ⎞ ω2

ρ0cs
2

--------------–⋅ 0=
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R E S U L T S

The following figure shows how the wave is absorbed by the surrounding PML. Notice 
how the amplitude quickly decreases inside the PML. Notice also that there is no 
distortion of the circular wave fronts inside the air domain because of reflection.

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator open the Acoustics Module folder, then select 
Pressure acoustics>Time-harmonic analysis.

2 Click OK.

G E O M E T R Y  M O D E L I N G

1 Draw a circle by selecting Specify Objects>Circle from the Draw menu.

2 Set the Radius to 8 and the Center to x = 0 and y = 2. Click OK.

3 Draw a new circle with radius 10 centered at x = 0 and y = 2.

4 Press Ctrl+A to select both circles. Click the Union button on the Draw toolbar.
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5 Draw a new circle with a radius of 4 and its center at the origin.

6 Press Ctrl+A to select both objects, then click the Difference button.

P H Y S I C S  S E T T I N G S

Subdomain Settings
1 Open the Subdomain Settings dialog box.

2 Click the PML tab, and select Subdomain 1.

3 Choose Cylindrical from the Type of PML list.

This activates a set of PML-related edit fields in the dialog box; see the following 
picture.

4 Set the y-coordinate of the PML center point to 2.

For the Scaled PML width and the PML scaling exponent you can use the default values, 
and the software correctly deduces the geometric PML parameters (the PML width 

in r direction, and the Inner PML radius) using the so-called guess variables.

To inspect the values of the applicable guess variables, R0_guess_acpr, do as 
follows: If the model tree is not already open, click the Model Tree button on the 
Main toolbar and select the Detail view. Choose 
[untitled]>Geom1>Equation System>Subdomain Settings>Variables>group1 in the 
model tree. All variables defined on Subdomain 1 (the annular PML region) appear 
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in the area below the model tree together with their respective values; to see the 
guess variables you need to scroll down the list.

5 Click OK to confirm the PML properties and close the dialog box.

Boundary Conditions
1 From the Physics menu, choose Boundary Settings.

2 Select Boundaries 5, 6, 9, and 10.

3 Select Normal acceleration in the Boundary condition list and set the acceleration to 1.

4 Click OK.

M E S H  G E N E R A T I O N

To resolve the waves, you need to use a finer mesh than the default. The frequency is 
100 Hz which gives a wavelength of about 3.4 m.

1 Open the Free Mesh Parameters dialog box, click the Custom mesh size button, and 
set the Maximum element size to 3.4*0.2.

2 Click OK.

3 Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.
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C O M P U T I N G  T H E  S O L U T I O N

2. Click the Solve button on the Main toolbar to compute the solution.

Reference

1. J.-P. Bérenger, “A perfectly matched layer for the absorption of electromagnetic 
waves,” J. Comput. Phys., vol. 114, pp. 185–200, 1994.
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S c a t t e r e d - F i e l d  F o rmu l a t i o n

Most common applications of acoustics can be loosely classified into cavity and duct 
problems, radiation problems, and scattering problems. The latter type differs from the 
rest in that the real quantity of interest is not the total pressure field but the, usually 
small, part of an incident wave reflected from a structure. When modeling a scattering 
problem in terms of the total pressure field, numerical noise in the large-amplitude 
incident wave tends to mask much of the detail in the all-important scattered wave.

To avoid the numerical problems associated with resolving contributions of wildly 
different amplitudes, you can choose to model only the scattered part of the pressure 
field. The basic idea is simple: write the pressure field as the sum of a known part—the 
incident wave pi—and an unknown part—the scattered field ps. Then insert this sum 
into the equation governing the total pressure field, and you obtain an equation for 
the scattered field only.

The scattered-field formulation implemented in the Acoustics Module makes one 
further assumption: that the incident field pi by itself solves the original equation with 
the scattering object removed. When the incident field is simple, like a plane wave, it 
can be prescribed explicitly, but, for example, for scattering from an object inside a 
cavity, the incident wave must be solved for as a separate dependent variable.

Selecting the scattered-field formulation alters the implementation of most boundary 
conditions. Nonreflecting boundary conditions are simplified because no incident 
wave must be accounted for. The incident field instead appears in the boundary 
conditions used at the surface of the scattering target.

When using PMLs to replace nonreflecting exterior boundary conditions in a 
scattering problem, you are forced to choose the scattered-field formulation rather 
than the full-field formulation. The reason is that it is quite difficult to apply an 
incident field on the boundary between the actual domain and the PML, and pushing 
the incident wave through the PML from the outside distorts the wave fronts if the 
PML is not planar.

Application Modes with Scattered Fields

The scattered-field formulation can be selected for the Pressure Acoustics application 
mode. It is accessible directly in the Model Navigator as the analysis type Time-harmonic 
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analysis, scattered wave. With the application mode already running, you can choose 
Scattered wave from the Solve for list in the Application Mode Properties dialog box.

The chosen name for the dependent variable (the default is p) in the Model Navigator 
represents either the total field or the scattered field according to the setting in 
Application Mode Properties dialog box. The scattered pressure is always available as 
p_s. If you solve for the total pressure, this variable is the difference between the total 
pressure and the incident field specified in the Application Scalar Variables dialog box. 
Conversely, the total pressure field is always available as p_t, which is defined as the 
sum of the incident field and the scattered field when solving only for the latter.

Example Model

The benchmark model “Scattering from a Plate with Ribs” on page 214 in the 
Acoustics Module Model Library uses PMLs to truncate the domain and is therefore 
set up using the scattered-field formulation.
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Ma t e r i a l  L i b r a r i e s

A useful feature in COMSOL Multiphysics is the Materials/Coefficients library. In 
addition to the Basic Material Properties library the Acoustics Module extends this 
library with two extra material libraries:

• MEMS Material Properties, an extended solid material library for MEMS 
applications. See “MEMS Material Properties Library” on page 48.

• Piezoelectric Material Properties, a material library with 23 common piezoelectric 
materials. See the section “Piezoelectric Material Properties Library” below.

The Basic Material Properties library is included with COMSOL Multiphysics and 
contains properties for a limited number of basic solid materials, given as constants, 
and temperature-dependent properties for air and water, given as functions.

For more information about using the Materials/Coefficients Library dialog box, see 
“Using the Materials/Coefficients Library” on page 223 in the COMSOL 
Multiphysics User’s Guide.

Piezoelectric Material Properties Library

The Piezoelectric Material Properties library ships with the Acoustics Module, MEMS 
Module, and Structural Mechanics Module. It contains the following piezoelectric 
materials:

MATERIAL

Barium Sodium Niobate

Barium Titanate

Barium Titanate (poled)

Lithium Niobate

Lithium Tantalate

Lead Zirconate Titanate (PZT-2)

Lead Zirconate Titanate (PZT-4)

Lead Zirconate Titanate (PZT-4D)

Lead Zirconate Titanate (PZT-5A)

Lead Zirconate Titanate (PZT-5H)

Lead Zirconate Titanate (PZT-5J)
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All materials define the following material properties needed for piezoelectric 
modeling:

MEMS Material Properties Library

The MEMS Material Properties library ships with the Acoustics Module, MEMS 
Module, and Structural Mechanics Module. It contains 33 materials commonly used 
in MEMS applications. The materials are divided into the following groups: Metals, 
Semiconductors, Insulators, and Polymers.

The basic structure of this library comes from the book Microsensors, MEMS, and 
Smart Devices (Ref. 3). The material properties come from two primary sources: the 
CRC Handbook of Chemistry and Physics (Ref. 1) and MacMillan’s Chemical and 
Physical Data (Ref. 2). Some of the mechanical properties in the library are instead 

Lead Zirconate Titanate (PZT-7A)

Lead Zirconate Titanate (PZT-8)

Quartz

Rochelle Salt

Bismuth Germanate

Cadmium Sulfide

Gallium Arsenide

Tellurium Dioxide

Zinc Oxide

Zinc Sulfide

Ammonium Dihydrogen Phosphate

Aluminum Nitride

MATERIAL PROPERTY DESCRIPTION

cE Elasticity matrix

e Coupling matrix, stress-charge

εrS Relative permittivity, stress-charge

sE Compliance matrix

d Coupling matrix, strain-charge

εrT Relative permittivity, strain-charge

ρ Density

MATERIAL
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more MEMS-specific values from The MEMS Handbook (Ref. 4), and most of the 
semiconductor properties are values from Ref. 5. Ref. 6 provides a valuable resource 
for cross-checking the insulation material properties.

The table below lists the materials and their corresponding groups:

MATERIAL GROUP

Aluminium (Al) Metals

Silver (Ag) Metals

Gold (Au) Metals

Chrome (Cr) Metals

Indium (In) Metals

Titanium (Ti) Metals

Iron (Fe) Metals

Nickel (Ni) Metals

Lead (Pb) Metals

Palladium (Pd) Metals

Platine (Pt) Metals

Antimon (Sb) Metals

Tungsten (W) Metals

C [100] Semiconductors

GaAs Semiconductors

Ge Semiconductors

InSb Semiconductors

Si(c) Semiconductors

Poly-Si Semiconductors

Silicon (single-crystal) Semiconductors

Al2O3 Insulators

SiC (6H) Insulators

Si3N4 Insulators

SiO2 Insulators

ZnO Insulators

Borosilicate Insulators

Nylon Polymers

PMMA Polymers
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R E F E R E N C E S
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Polymide Polymers

Polyethylene Polymers

PTFE Polymers

PVC Polymers

MATERIAL GROUP
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A p p l i c a t i o n  M o d e  O v e r v i e w  
The Acoustics Module provides a set of application modes that facilitate the 
modeling of acoustics phenomena in a wide variety of application contexts. This 
chapter gives an overview of the application modes you have at your disposal when 
creating models using the Acoustics Module.
 51
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App l i c a t i o n  Mode Gu i d e

Table 4-1 lists the application modes available in the Acoustics Module. For a detailed 
description of any of the modes, see the section on the page listed in the corresponding 
table entry.

In the table, the application modes are classified in five categories:

• Acoustics—the module’s core application modes which model the sound waves

• Structural Mechanics—application modes which allow you to model 
acoustic-structure interaction

• Piezoelectricity—application modes for modeling of piezoelectric effects.

• Fluid Dynamics—an application mode tailored for modeling irrotational flow

• Predefined Multiphysics—combinations of application modes with predefined 
couplings

The Name column shows the default name that appears as a label when you use an 
application mode. The labels are particularly important in multiphysics simulations 
where they distinguish between the application modes included in the model; each 
model defines its own set of variables, whose names are appended by an underscore 
and the unique application mode name.

The Dependent Variables column lists the dependent variables for which the mode 
formulates the underlying PDEs. Note that using weak constraints introduces 
additional dependent variables on boundaries.

Finally, the Analysis Capabilities columns indicate which analysis types each application 
mode supports.

Note: For historical reasons, the frequency domain analysis type is called 
time-harmonic in the acoustics application modes but frequency response in the 
structural mechanics context. These analysis types are however fully compatible.
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TABLE 4-1:  ACOUSTICS MODULE APPLICATION MODES
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ACOUSTICS

Pressure Acoustics acpr 64 p √ √ √

Pressure Acoustics, 
Boundary modal analysis

acbm 99 p √

Aeroacoustics acae 112 √ √ √

Aeroacoustics, 
Boundary modal analysis

acab 124 √

STRUCTURAL MECHANICS

Solid, Stress-Strain acsld u, v, w √ √ √ √ √

Axial Symmetry, 
Stress-Strain

acaxi uor, w √ √ √ √ √

Plane Strain acpn u, v √ √ √ √ √

PIEZOELECTRICITY

Piezo Solid smpz3d u, v, w, V √ √ √ √ √

Piezo Axial Symmetry smpaxi uor, w, V √ √ √ √ √

Piezo Plane Strain smppn u, v, V √ √ √ √ √

FLUID DYNAMICS

Compressible Potential 
Flow

acpf 130 Φ, ρ √ √

φ

φ
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In addition, you can perform parametric analyses using the parametric solver. Typical 
parameters to vary include the frequency and the out-of-plane or axial wave number.

When using the axisymmetric modes it is important to note that the horizontal axis 
represents the r direction and the vertical axis the z direction. Further, you must create 
the geometry in the right half plane, that is, only for positive r.

Analysis Capabilities

The Acoustics Module is primarily designed for frequency-domain simulations, 
including related eigenvalue and modal problems. Transient analysis is possible but less 
efficient from the computational point of view. The Compressible Potential Flow 
application mode is tailored to model a stationary background flow to be used in a 
subsequent time-harmonic aeroacoustics simulation. In the solid structural mechanics 
application modes, the static analysis type is included merely as a convenience.

The analysis types require different solvers and equations. In the Application Mode 

Properties dialog box you select one of the analysis types, each of which has a 
predefined solver. You can disable the choice of a predefined solver by clearing the Auto 

PREDEFINED MULTIPHYSICS

Aeroacoustics with 
Flow

acpf, 
acae

135 Φ, ρ, √ √

TABLE 4-1:  ACOUSTICS MODULE APPLICATION MODES
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select solver check box in the Solver Parameters dialog box. The following table lists the 
different analysis types with their predefined solver:

Note that the acoustics’ application modes time-harmonic analysis type and the 
structural mechanics frequency response analysis are fully compatible. The only 
difference between them is the default solver choice. Both analysis types work well with 
either the stationary or parametric solver. To manually change to a different solver, 
make a new selection in the Solver Parameters dialog box.

Read through the following analysis type descriptions to help find good candidates for 
your application.

S T A T I C  A N A L Y S I S

A static analysis solves for stationary displacements or a steady-state condition. All 
loads and constraints are constant.

T I M E - H A R M O N I C  A N D  F R E Q U E N C Y - R E S P O N S E  A N A L Y S I S

Acoustic wave propagation is modeled by equations from linearized fluid dynamics and 
solid dynamics. The full equations are time dependent, but noting that a harmonic 
excitation with a time dependence of the form  gives rise to an equally 
harmonic response with the same frequency, the time can be eliminated completely 
from the equations. Instead the angular frequency, ω, enters as a parameter.

This procedure is often referred to as working in the frequency domain or Fourier 
domain as opposed to the time domain. From the mathematical point of view, the 

ANALYSIS TYPE DEFAULT SOLVER APPLICATION MODE TYPES

Static Stationary Structural mechanics, 
Piezoelectric, Fluid 
dynamics

Time-harmonic Stationary Acoustics

Frequency response Parametric Structural mechanics, 
Piezoelectric, 

Eigenfrequency Eigenvalue Acoustics,  
Structural mechanics, 
Piezoelectric

Damped eigenfrequency Eigenvalue Structural mechanics, 
Piezoelectric

Modal analysis Eigenvalue Acoustics

Transient Time dependent All

f f̂eiωt=
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time-harmonic equation is a Fourier transform of the original time-dependent 
equations and its solution as function of ω is the Fourier transform of a full transient 
solution. It is therefore possible to synthesize a time-dependent solution from a 
frequency-domain simulation by applying an inverse Fourier transform.

Frequency domain simulation suites the finite element method, on which COMSOL 
Multiphysics and the Acoustics Module are based, very well. Therefore, choose the 
time-harmonic or frequency response analysis types over the transient whenever 
possible. Certain important software features, notably PMLs and damping due to 
porous media, are only present when using the time-harmonic and frequency response 
analysis types.

The result of a frequency response analysis is a complex time-dependent field, which 
can be interpreted as an amplitude uamp and a phase angle uphase. The actual 
displacement at any point in time is the real part of the solution:

You can visualize the amplitudes and phases as well as the solution at a specific angle 
(time). The Solution at angle parameter makes this task easy. When plotting the 
solution, COMSOL Multiphysics multiplies it by , where is the angle in radians 
that corresponds to the angle (specified in degrees) in the Solution at angle edit field. 
The plot shows the real part of the evaluated expression:

The angle is available as the variable phase (in radians) and is allowed in plot 
expressions. Both freq and omega are available variables.

Note: In a frequency response analysis, almost everything is treated as harmonic— 
prescribed pressures and displacements, velocities, and accelerations—not only the 
forces and dependent fields. Notable exceptions are certain postprocessing quantities, 
such as the sound pressure level, which by definition are time averages.

E I G E N F R E Q U E N C Y  A N A L Y S I S

If all sources are removed from a frequency-domain equation, its solution becomes 
zero for all but a discrete set of angular frequencies, ω, where the solution has a 
well-defined shape but undefined magnitude. These solutions are known as 
eigenmodes and the corresponding frequencies as eigenfrequencies.

u uamp 2πf t uphase+⋅( )cos=

eiϕ ϕ

u uamp ϕ uphase+( )cos=

ϕ
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The eigenmodes and eigenfrequencies have many interesting mathematical properties, 
but also direct physical significance because they identify the resonance frequencies of 
the structure. When approaching a resonance frequency in a harmonically-driven 
problem, you need a weaker and weaker source to maintain a given response level. At 
the actual eigenfrequency, the time-harmonic problem breaks down and lacks solution 
for a nonzero excitation.

Select the eigenfrequency analysis type when you are interested in the resonance 
frequencies of the structure, whether you want to exploit them, as in a musical 
instrument, or avoid them, as in a reactive muffler or inside a hi-fi speaker system. To 
the trained engineer, the distribution of eigenfrequencies and the shape of eigenmodes 
can also give a good first impression about the behavior of a system.

An eigenfrequency analysis solves for the eigenfrequencies and the shape of the 
eigenmodes. When performing an eigenfrequency analysis, you can specify whether to 
look at the mathematically more fundamental eigenvalue, λ, or the eigenfrequency, f, 
which is more commonly used in an acoustics context.

You control the way to specify eigenvalues from the Application Mode Properties dialog 
box from the Physics menu.

D A M P E D  E I G E N F R E Q U E N C Y  A N A L Y S I S

A damped eigenfrequency analysis solves for the damped eigenfrequencies and the 
shape of the eigenmodes in structural and piezoelectric models. When performing a 
damped eigenfrequency analysis, you can specify whether to look at the mathematically 
more fundamental eigenvalue, λ, or the eigenfrequency, f, which is more commonly 
used in a structural-mechanics context.

M O D A L  A N A L Y S I S

Acoustic waves can propagate over large distances in ducts and pipes, with a generic 
name referred to as waveguides. After some distance of propagation in a waveguide of 
uniform cross section, such guided waves can be described as a sum of just a few 
discrete propagating modes, each with its own shape and phase speed. The equation 
governing these modes can be obtained as a spatial Fourier transform of the 
time-harmonic equation in the waveguide axial direction, or more easily by inserting 
the assumption that the mode is harmonic in space,  and eliminating all 
z dependence. The axial wave number, kz, is a parameter in the 2D acoustics 
application modes.

f λ–
2πi
---------=

u ue ikzz–=
A P P L I C A T I O N  M O D E  G U I D E  |  57



58 |  C H A P T E R
Similarly to the full time-harmonic equation, the transformed equation can be solved 
at a given frequency with a nonzero excitation for most axial wave numbers kz. But at 
certain discrete values, the equation breaks down. These values are the propagation 
constants of propagating or evanescent waveguide modes. The eigenvalue solver can 
solve for these propagation constants together with the corresponding mode shapes. 
Note that the propagation constant is a function of the frequency. The relation 
between the two is commonly referred to as a dispersion curve.

Modal analysis is available as an analysis type in plane 2D and axially symmetric 1D 
acoustics application modes. There are also special boundary modal application modes 
available on boundaries in 3D and 2D axisymmetry.

The most common use for the modal analysis is in defining sources for a subsequent 
time-harmonic simulation. If you have a component with one or more waveguide 
connections, you can describe its behavior by simulating its response to the discrete set 
of propagating modes on the waveguide port cross sections. The frequency-dependent 
transfer matrix thus obtained can be used in an external simulation, using COMSOL 
Script for instance, of a complete waveguide system. See, for example, “Flow Duct” on 
page 101 in the Acoustics Module Model Library.

TR A N S I E N T  A N A L Y S I S

The complete equations behind the theory of acoustic wave propagation are time 
dependent, as noted above. Solving time-domain equations is more complicated from 
a numerical point of view, and should therefore be avoided when possible. Short-term 
transient processes like step and impulse responses can benefit from modeling in the 
time domain, however, if not for efficiency so for convenience.

Note that some central modeling techniques, such as the use of PMLs, are not available 
for the transient analysis type. Further, you have to be careful when defining your 
sources to avoid, as far as possible, to excite waves at frequencies that the mesh cannot 
resolve. For an example, see “Transient Gaussian Explosion” on page 55 in the 
Acoustics Module Model Library.

Application Mode Documentation Notes

The following chapters contain the details necessary to get full insight into the 
different application modes, that is, the physical assumptions and mathematical 
considerations upon which we base them and the functionality they offer.

In the Application Mode Variables sections you find all the variables available for 
formulating equations and for postprocessing (when you define a function of these 
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variables for plots and graphs). In a multiphysics setting, it is also possible to use these 
variables in expressions for physical properties in the other application modes.

We have organized the tables that detail the application mode variables as follows:

• The Name column gives the names of variables you can use in equations or for 
postprocessing. The indices i and j (using an italic font) in the variable names can 
mean any of the spatial coordinates. For example, vi means vx, vy, or vz in 3D 
when the spatial coordinates are x, y, and z. In 2D axisymmetry, pi stands for vr or 
vz.

In a COMSOL Multiphysics model, the name of each application mode variable 
gets an underscore plus the application mode name appended as a suffix. For 
example, the default name of the Pressure Acoustics application mode is acpr, so the 
variable for the x-component of the local velocity is called vx_acpr.

• The Domain column indicates whether the variable is defined on subdomains (S), 
boundaries (B), edges (E), or points (P). The column indicates the top level where 
the variable is defined. Many variables that are available on subdomains are also 
available on boundaries, edges, and points, but they then take the average value of 
the values in the subdomains around the boundary, edge, or point. In other words, 
to get a value on an interior boundary between two subdomains, you take the 
average of the value in the left subdomain and the value in the right subdomain.

• The Analysis column specifies for which type of analysis a variable is defined. The 
available analysis types might be, for example, transient (T), time-harmonic (H), 
eigenfrequency (E), or modal (M). The available analysis types are application-mode 
dependent; some variables are defined differently depending on the analysis type or 
are available only for some analysis types.

• The Description column gives a textual description of the variables.

• The Expression column gives the expression of the variables in terms of other 
physical quantities. In these expressions, the subscripts i and j of vector and tensor 
components stand for one of the spatial coordinates, usually referring to a 
corresponding index in the Name column.
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 5
P r e s s u r e  A c o u s t i c s
This chapter describes the two application modes in the Acoustics Module in 
which the acoustic pressure, p, is the basic dependent variable:

• Pressure Acoustics (acpr)

• Pressure Acoustics, Boundary modal analysis (acbm)

Because the Modal analysis type of the Pressure Acoustics application mode is 
intimately related to the Pressure Acoustics, Boundary modal analysis application 
mode, these are described in a separate section following the discussion of the other 
analysis types of the Pressure Acoustics application mode. The chapter begins, 
however, with a brief review of the underlying mathematics.
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Th eo r y  Ba c k g r ound

Mathematical Model

Sound waves in a lossless medium are governed by the following equation for the 
acoustic pressure, p (with SI unit Pa):

.

Here ρ0 (kg/m3) refers to the density, and cs (m/s) denotes the speed of sound. The 
dipole source q (N/m3) and the monopole source Q (1/s2) are both optional. The 
combination ρ0   cs

2 is called the adiabatic bulk modulus, commonly denoted K (Pa).

An important special case is a time-harmonic wave, for which the pressure varies with 
time as

where ω = 2π   f (rad/s)  is the angular frequency, with  f (Hz) denoting the frequency. 
Assuming the same harmonic time dependence for the source terms, the wave 
equation for acoustic waves reduces to an inhomogeneous Helmholtz equation:

.

You can alternatively treat this equation as an eigenvalue PDE to solve for eigenmodes 
and eigenfrequencies.

Typical boundary conditions are:

• Sound-hard boundaries (walls)

• Sound-soft boundaries (zero acoustic pressure)

• Specified acoustic pressure

• Specified normal acceleration

• Impedance boundary conditions

• Radiation boundary conditions

1

ρ0 cs
2

--------------
t2

2

∂
∂ p ∇ 1

ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅+ Q=

p x t,( ) p x( ) eiωt
=

∇ 1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ ω2p

ρ0 cs
2

--------------– Q=
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Their respective purposes in pressure acoustics modeling and their implementations in 
the Pressure Acoustics application mode are described in more detail in the next 
section, “Boundary Conditions” on page 76.

In lossy media, it is necessary to introduce an additional term of first order in the time 
derivative to account for attenuation of the sound waves:

.  (5-1)

For transient analysis, the damping term in Equation 5-1 is absent from the standard 
PDE formulations in the Pressure Acoustics application modes. However, in line with 
COMSOL Multiphysics’ general modeling philosophy, you can access the da 
coefficient from the user interface through the Subdomain Settings - Equation System 
dialog box.

In the frequency domain, the 1st-order damping term gives a purely imaginary 
contribution to the Helmholtz equation that can be interpreted as a complex speed of 
sound. A selection of more general models for damping by means of complex material 
parameters is available for time-harmonic and eigenfrequency analysis; the details are 
described in the next section, “Subdomain Settings” on page 70.

Finally, note that even when sound waves propagate in a lossless medium, attenuation 
can occur by interaction with the surroundings at the system boundaries. In particular, 
this applies to the impedance boundary conditions.

1

ρ0 cs
2

-------------
t2

2

∂
∂ p da t∂

∂p
– ∇ 1

ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅+ Q=
T H E O R Y  B A C K G R O U N D  |  63



64 |  C H A P T E R
App l i c a t i o n  Mode De s c r i p t i o n

Variables and Space Dimensions

The Pressure Acoustics application modes solve for the acoustic pressure, p. It is 
suitable for modeling acoustics phenomena that do not involve fluid flow.

The Pressure Acoustics application mode is available for 3D, 2D, and 1D Cartesian 
geometries as well as for 2D and 1D axisymmetric geometries.

PDE Formulation

The Pressure Acoustics application mode provides four distinct PDE formulations—or 
analysis types:

• Transient analysis

• Time-harmonic analysis

• Eigenfrequency analysis

• Modal analysis

This section discusses the former three options, while the Modal analysis type is 
described a separate section “Pressure Acoustics, Modal Analysis” on page 99.

TR A N S I E N T  A N A L Y S I S

Use the Transient analysis type to model transient acoustic phenomena in a stationary 
fluid. With this choice the software solves the wave equation

 (5-2)

for the acoustic pressure, p = p(r, t). Here cs is the speed of sound and ρ0 denotes the 
equilibrium density, while q and Q are dipole and monopole sources, respectively. The 
density and speed of sound can both be nonconstant in space. In contrast, they are 
assumed to vary with time  on scales much larger than the period for the acoustic waves, 
and they are therefore considered time independent in the previous equation. For 
information about how to specify these properties, see “Subdomain Settings” on page 
70.

1
ρ0cs

2
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In the Model Navigator or in the Application Mode Properties dialog box (see 
“Application Mode Properties” on page 68) you can select between solving for the 
total wave or for the scattered wave. The default is to solve for the total wave.

In the scattered-field formulation, the total acoustic pressure, pt, is written as the sum 
of a known incident field, pi, and an unknown scattered field, ps. Inserting this sum in 
the standard acoustic wave equation and assuming that the incident field by itself is a 
solution to the source-free equation, it follows that ps—which is what p refers to in 
this formulation—satisfies the source-free version of Equation 5-2. You can set the 
expression for the incident wave, pi, in the Application Scalar Variables dialog box. The 
default expression is a Gaussian pulse of width ∆t = 0.01 s traveling in the x direction:

.

T I M E - H A R M O N I C  A N A L Y S I S

In the frequency domain, Equation 5-2 corresponds to the inhomogeneous 
Helmholtz equation

 (5-3)

where p = p(x, ω) (the dependence on ω is henceforth not explicitly indicated). With 
this formulation you can compute the frequency response by using the parametric 
solver to sweep over a frequency range using a harmonic load. You specify ω through 
the frequency, f, which is an application scalar variable; see page 69.

When there is damping, ρ0 and cs are complex quantities. The available damping 
models and how to apply them is described in the section “Subdomain Settings” on 
page 70.

In the Model Navigator or in the Application Mode Properties dialog box you can choose 
between solving for the total wave or for the scattered wave. The default setting is to 
solve for the total wave.

In the scattered-field formulation the default expression for the incident wave is a plane 
wave traveling in the x direction:
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The wave number is k = ω/cs, where there angular frequency, ω = 2π f, is defined in 
terms of the frequency, f.

Equation 5-3 is the equation that the software solves for 3D geometries. In 
lower-dimensional and axisymmetric cases, restrictions on the coordinate dependence 
mean that the equations differ from case to case. Here is a brief summary of the 
situation.

2D
In 2D, the pressure is of the form , which inserted in 
Equation 5-3 gives

 (5-4)

The out-of-plane wave number, kz, is an application scalar variable that you can supply 
as a parameter. By default its value is zero. In the Modal analysis type, −ikz is used as 
the eigenvalue; see the section “Pressure Acoustics, Modal Analysis” on page 99.

2D Axisymmetry
For 2D axisymmetric geometries the independent variables are the radial coordinate, 
r, and the axial coordinate, z. The only dependence allowed on the azimuthal 
coordinate, , is through a phase factor,

 (5-5)

where m denotes the circumferential wave number. Because the azimuthal 
coordinate is periodic, m must be an integer. Just like kz in the 2D case, it is an 
application scalar variable.

As a result of Equation 5-5, the equation to solve for the acoustic pressure in 2D 
axisymmetric geometries becomes

.

1D Axisymmetry
In 1D axisymmetric geometries, , leading to the radial 
equation

p r( ) p x y,( )e i– kzz=

∇ 1
ρ0
------ p q–∇( )–⎝ ⎠

⎛ ⎞⋅ 1
ρ0
------ ω2

cs
2

------- kz
2

–⎝ ⎠
⎛ ⎞ p– Q=

ϕ

p r φ z, ,( ) p r z,( )e imϕ–
=

r∂
∂ r

ρ0
------–

r∂
∂p qr–⎝ ⎠
⎛ ⎞ r

z∂
∂ 1

ρ0
------–

z∂
∂p qz–⎝ ⎠
⎛ ⎞ ω

cs
------⎝ ⎠
⎛ ⎞ 2 m

r
-----⎝ ⎠
⎛ ⎞ 2

–
rp
ρ0
------–+ rQ=

p r φ z, ,( ) p r( )e i kzz mϕ+( )–
=

r∂
∂ r

ρ0
------–

r∂
∂p qr–⎝ ⎠
⎛ ⎞ ω

cs
------⎝ ⎠
⎛ ⎞ 2 m

r
-----⎝ ⎠
⎛ ⎞ 2

– kz
2

–
rp
ρ0
------– rQ=
 5 :  P R E S S U R E  A C O U S T I C S



where both the circumferential wave number, m, and the axial wave number, kz 
appear as parameters.

1D
The equation for the 1D case is obtained by taking the pressure to depend on a single 
Cartesian coordinate, x:

.

E I G E N F R E Q U E N C Y  A N A L Y S I S

You can treat Equation 5-3 as an eigenvalue problem. In the eigenvalue formulation 
you solve for the eigenmodes and the eigenvalues or eigenfrequencies:

.  (5-6)

The eigenvalue λ introduced in this equation is related to the eigenfrequency, f, and 
the angular frequency, ω, through λ = i 2π f = i ω. Because they are independent of the 
pressure, the dipole and monopole source terms are ignored by the solver unless you 
are solving a coupled eigenvalue problem.

Equation 5-6 applies to the 3D case. The equations solved in eigenfrequency analyses 
in lower dimensions and for axisymmetric geometries are obtained from their 
time-harmonic counterparts, given in the previous subsection, by the substitution 
ω2→−λ2.

You can switch between specifying the eigenvalues, the eigenfrequencies, or the 
angular frequencies by choosing Properties from the Physics menu and changing the 
value of the property Specify eigenvalues using in the Application Mode Properties dialog 
box. There you can also change the analysis type.
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Application Mode Properties

Table 5-1 lists the properties you can set in the Application Mode Properties dialog box, 
which you reach from the Model Navigator when selecting or adding application modes 
or by choosing Physics>Properties during a modeling session.

TABLE 5-1:  PRESSURE ACOUSTICS APPLICATION MODE PROPERTIES

PROPERTY VALUES DESCRIPTION

Default element type Lagrange elements of order 
1–5 (the default value is 2). 
If Ultraweak variational 
formulation is On, 
Ultraweak Helmholtz 
elements.

Specifies which type of finite 
elements to use.

Analysis type Time-harmonic | 
Eigenfrequency | Transient

Specifies which type of analysis 
to perform.

Specify eigenvalues 
using

Eigenfrequency | Eigenvalue | 
Angular frequency

Specifies the quantity in which 
solver parameters and output 
should be given; applies only to 
eigenfrequency analysis.

Solve for Total wave | Scattered wave Specifies if the dependent 
variable, p, describes the total 
wave or the scattered wave; 
applies only to time-harmonic 
and transient analysis.

Ultraweak variational 
formulation

On | Off Specifies if the Ultraweak 
variational formulation should 
be used.

Weak constraints On | Off Specifies if weak constraints 
should be used.

Constraint type Ideal | Non-ideal Specifies the type of constraint.
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For 2D Cartesian and 1D axisymmetric geometries, the Modal analysis type is also 
available from the Application Mode Properties dialog box; for a corresponding list of it 
application mode properties see Table 5-7 on page 101.

Some of these entries have already been brought up in this discussion. For a review of 
element types and weak constraints refer to the sections “Understanding the Finite 
Element Method” on page 452 of the COMSOL Multiphysics Reference Guide and 
“Using Weak Constraints” on page 300 in the COMSOL Multiphysics Modeling 
Guide.

Application Scalar Variables

Table 5-2 lists the predefined scalar variables in the Pressure Acoustics application 
mode. The following abbreviations are used to label the analysis types discussed in this 
section:

T Transient

H Time-harmonic

E Eigenfrequency

TABLE 5-2:  PRESSURE ACOUSTICS APPLICATION SCALAR VARIABLES

QUANTITY VARIABLE ANALYSIS GEOMETRIES DESCRIPTION

 f freq H All Frequency

 iω iomega E All Imaginary angular frequency

 ikz ikz 2D Imaginary out-of-plane wave number

 ikz ikz 1D axi Imaginary axial wave number

 m m 2D axi, 1D axi Circumferential wave number

 pi p_i H T Incident pressure wave

 pref p_ref All Pressure reference for the sound 
pressure level
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To inspect a list of all the application scalar variables defined in the model you are 
working with, open the Application Scalar Variables dialog box by choosing 
Physics>Scalar Variables.

Note that each variable name is appended by a tag that identifies the application mode 
to which it belongs. For the Pressure Acoustics application mode the default 
application mode name is acpr. If there are two or more application modes of the same 
type in a model, they are by default distinguished by a number after the application 
mode name.

You can modify the value of any variables in the corresponding Expression edit field. By 
first selecting the Synchronize equivalent variables check box you ensure that a change 
in, for instance, the value of the frequency for one application mode automatically 
propagates to the frequencies for all other application modes.

Subdomain Settings

The Subdomain Settings dialog box contains the following pages, each accessible by 
clicking the corresponding tab:

• Physics: This is where you specify acoustic properties and sources defined at the 
subdomain level.

• PML: In time-harmonic and eigenfrequency analyses you can include auxiliary 
subdomains in the geometry that serve as perfectly matched layers; use this page to 
designate the selected subdomains as PMLs and to specify their properties in the 
manner described in the subsection “Perfectly Matched Layers (PMLs)” on page 
73.

• Init: On this page you can set the initial value, p(t0), for the acoustic pressure in 
transient analyses.
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• Elements: Here you can change the specifications for the finite elements to be used 
in the subdomain; for further details refer to the subsection “Specifying the Finite 
Element Type” on page 211 of the COMSOL Multiphysics User’s Guide.

• Color: This page is active only when the Groups page is open. Use it to visually 
distinguish among groups of subdomains with common settings by giving them 
different colors in the user interface.

P H Y S I C S

On the Physics page you can specify the equilibrium density, ρ0, and the speed of 
sound, cs. The default values are appropriate for air at atmospheric pressure and room 
temperature. This is also where you specify dipole and monopole sources, if present.

Damping
In all analysis types except transient analysis you have the option of including damping 
in a model. The fluid density and the speed of sound in Equation 5-3 are then complex 
quantities, denoted by ρc and cc, respectively:

.

These variables are frequency dependent, defined by the equations
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where the expressions for the complex wave number, kc, and the complex impedance, 
Zc, depend on the selected type of damping. To turn on the damping select the type 
of damping you want in the Type of damping list in the Subdomain Settings dialog box. 
The following options for damping are available:

• None: No damping, that is, ρc = ρ0 and cc = cs. This is the default option.

• General damping: This type of damping is specified by means of the real-valued 
attenuation coefficient, α (1/m):

.

The attenuation coefficient is not directly related to the fluid’s physical properties. 
Instead it represents a guessed or measured relative attenuation per unit distance for 
a propagating wave without making any assumptions as to which physical process is 
responsible for the attenuation.

• Complex material: This is the type of damping to choose if you want to enter your 
own expressions for the complex impedance and the complex wave number in a 
porous medium. Given a sample of the material, you can measure these quantities 
as functions of frequency using an impedance tube. For details on how to use such 
data to define interpolation functions, see the section “Interpolation of Measured 
Data and Nonlinear Materials” on page 229 of the COMSOL Multiphysics User’s 
Guide.

kc
ω
cs
----- iα–= Zc ρ0cs=
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• Delany-Bazley: This option specifies damping for porous media according to the 
model of Delany and Bazley:

The advantage of this scheme is that the flow resistivity Rf is easy to measure and is 
independent of frequency. Other authors have refined the Delany-Bazley model for 
particular materials by changing the Ci coefficients. You can modify these values to 
suit individual needs using the Subdomain Settings - Equation System dialog box. For 
an example model involving Delany-Bazley damping see “Absorptive Muffler” on 
page 74 of the Acoustics Module Model Library.

• Bulk viscosity: Here you specify damping using a bulk viscosity, µB, with SI unit 
Pa·s/m, according to the equations:

.

This choice is most appropriate for situations where the damping takes place in free 
space and is not related to interaction between the fluid and a solid skeleton.

PE R F E C T L Y  M A T C H E D  L A Y E R S  ( P M L S )

As described in more detail in the subsection “Boundary Conditions” on page 76, the 
Pressure Acoustics application mode offers two closely related types of absorbing 
boundary conditions: the radiation boundary conditions and the matched boundary 
condition. The former are perfectly absorbing for plane, cylindrical, and spherical 
waves, whereas the latter is perfectly absorbing only for guided modes provided that 
the correct value of the propagation constants are supplied.

However, in situations where you cannot describe the outgoing radiation as a simple 
waveform with a well-known wave number and direction of propagation, perfectly 
matched layers (PMLs) provide a powerful alternative. While a PML serves the same 
purpose, it is not a boundary condition but an additional domain that absorbs incident 
radiation without producing reflections. PMLs provide good performance for a wide 
range of incidence angles and are not very sensitive to the shape of the wave fronts. 
PMLs are thus capable of emulating nonreflecting boundaries.
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The following types of PMLs are available:

To implement a PML, begin by adding a subdomain on the outside of the boundary 
where the waves radiate out into the surroundings. Then specify the PML properties 
on the PML page of the Subdomain Settings dialog box, starting by selecting the Type of 

PML. For the PML type Cartesian you have the option of selecting which coordinate 
system to use. Unless you have defined an alternative coordinate system in the 
Coordinate System Settings dialog box (that you open from the Options menu), the only 
available option is the default Global coordinate system.

In the example of the previous figure, you specify a PML of type Cartesian in a 3D 
Cartesian geometry with the following properties:

• The PML subdomain, which you select from the Subdomain selection list or by 
clicking directly in the drawing area of the user interface.

TYPE DESCRIPTION

None Not absorbing

Cartesian Absorbing in the specified Cartesian coordinate directions

Cylindrical Absorbing in the radial or axial direction from a specified axis (the 
z-axis for axisymmetric geometries)

Spherical Absorbing in the radial direction from a specified point

User defined User-defined PML coordinates
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• The coordinate directions in which waves should be absorbed. In this example, the 
PML absorbs waves traveling in the y direction.

• The PML width, di, in each absorbing coordinate direction, xi. COMSOL 
Multiphysics attempts to extract a value for the PML width and assigns it to a 
variable referred to as a “guess variable.” You can inspect this value on the Variables 
page in the Subdomain Settings - Equation System dialog box or at the corresponding 
node of the Model Tree. The default PML width in a given direction is the actual 
width of the PML subdomain in the direction in question. You can replace this 
variable by explicitly entering the actual value, but the predefined variable works 
well in most cases.

• The scaled PML width, Li, in each absorbing coordinate direction; choose this 
parameter so that any unwanted reflections are suppressed to below the general 
numerical noise level in the model. Provided that the mesh resolution is sufficient, 
the attenuation of reflections measured in dB is proportional to the scaled PML 
width. By default the scaled width is set to one wavelength, which is cs_acpr/
freq_acpr using the default application mode name. In theory, the attenuation of 
a plane wave entering a rectilinear PML in the normal direction is then 
approximately 109 dB. In practice this level of attenuation is neither necessary nor 
obtained.

For obliquely incident waves, you need to adjust the scaled PML widths to preserve 
the attenuation level. If the angle between the absorbing coordinate direction ξi and 
the incident wave’s direction of propagation is ϑi, multiply the default value of Li 
by the factor | cos ϑi |

−1.  Conversely, if you keep the default Li value, the attenuation 
level decreases by the factor | cos ϑi | .

If you increase the scaled PML width, you must increase the mesh resolution in the 
PML domain accordingly because the mesh must resolve the number of 
wavelengths that fit inside the scaled width. Conversely, if you do not need the high 
level of attenuation provided by the default setting, you can save mesh elements by 
reducing the scaled PML width. To estimate the efficiency of a given PML, look at 
the difference between the sound pressure level of the incident wave and the level 
at the outside boundary of the PML. The attenuation of the reflected wave is 
roughly twice this difference.

• The coordinates of the inner PML boundary, xi0, which COMSOL Multiphysics 
also provides as predefined variables, X0_guess_acpr, Y0_guess_acpr, and 
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Z0_guess_acpr. You can replace these variables with your own coordinate values, 
but the predefined values should work well in most cases.

• The PML scaling exponent defines the type of scaling to use for the coordinates in 
the PML. The default value is 1, which gives a linear scaling that works well in most 
cases. For scattering problems and models where different wavelengths should be 
absorbed (outside waveguides, for example) you can increase the exponent 
somewhat, the useful range for n roughly being between 1 and 2. Increasing the 
exponent allows you to use fewer mesh elements to resolve wavelengths much 
smaller than the scaled PML width.

Cylindrical and spherical PMLs have the following properties:

• In 3D, a cylindrical PML can be absorbing in the r direction and the z direction, 
and there are predefined variables for the PML width in both directions. Spherical 
PMLs and cylindrical PMLs in 2D always absorb in the radial direction from the 
center point, and that is the only PML width.

• The scaled PML width (see the previous type).

• The coordinates of the inner PML boundary (see the previous type).

• The PML scaling exponent (see the previous type).

• The center point location, (x0, y0, z0) (in 3D) or (x0, y0) (in 2D). For cylindrical 
PMLs this refers to an arbitrary point on the center axis. The default location is the 
origin. For axisymmetric geometries the only parameter that you can specify is z0 for 
spherical PMLs because the center point always lies on the z-axis.

• The center axis direction, raxis (for cylindrical PMLs in 3D only).

For user-defined PMLs, you supply the full expressions for the PML coordinates for 
each coordinate direction of your model geometry. This option gives you full control 
over the scaling to use in the PML subdomain. The default is no scaling.

The PML page is available for time-harmonic and eigenfrequency analysis.

Example models in the Acoustics Module Model Library using PMLs include “Flow 
Duct” on page 101, “Loudspeaker” on page 131, “Open Pipe” on page 200, and 
“Scattering from a Plate with Ribs” on page 214 of this accompanying volume.

Boundary Conditions

This section describes the boundary conditions available for the Pressure Acoustics 
application mode. You specify them in the Boundary Settings dialog box.
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S O U N D - H A R D  B O U N D A R Y  ( WA L L )

A sound-hard boundary is one where the normal component of the particle velocity 
vanishes. Because there is no acoustic drift velocity, this condition is equivalent to the 
normal acceleration being equal to zero:

.

For a zero dipole source, this means that the normal derivative of the pressure at the 
boundary vanishes:

.

Use the sound-hard boundary condition to model rigid surfaces. Because this 
boundary condition is of a homogeneous Neumann type, it is also the neutral 
boundary condition needed on boundaries where the pressure is controlled by a 
periodic boundary condition (see “Using Periodic Boundary Conditions” on page 245 
of the COMSOL Multiphysics User’s Guide) or is coupled to another application 
mode.

S O U N D - S O F T  B O U N D A R Y

At a sound-soft boundary the acoustic pressure vanishes:

.

This boundary condition is an appropriate approximation for a liquid-gas interface and 
in some cases for external waveguide ports.

P R E S S U R E  S O U R C E

This condition means that you specify the acoustic pressure at a boundary:

.

For time-harmonic analysis, p0 is the amplitude of a harmonic pressure source. For 
transient analysis you must explicitly specify the time dependence of the pressure 
source. In both cases p0 can be a function of the position at the boundary.

I M P E D A N C E  B O U N D A R Y  C O N D I T I O N

The impedance boundary condition is a generalization of the sound-hard and 
sound-soft boundary conditions:

n 1
ρ0
------ p q–∇( )⎝ ⎠
⎛ ⎞⋅ 0=

n∂
∂p 0=

p 0=

p p0=
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.

In the frequency domain the corresponding equation reads

.

Here Z (SI unit Pa·s/m ) is the acoustic input impedance of the external domain. From 
a physical point of view the acoustic input impedance is the ratio between pressure and 
normal particle velocity. It can be expressed in terms of the characteristic impedance 
inside the domain, Z0 = ρ  c, as  Z = ζ  Z0, where the dimensionless quantity ζ is called 
the specific acoustic impedance. The default setting corresponds to ζ = 1, that is, 
Z = Z0.

The impedance boundary condition is a good approximation for a locally reacting 
surface, that is, a surface for which the normal velocity at any point depends only on 
the pressure at that exact point.

Note that in the two opposite limits  and  the sound-hard and 
sound-soft boundary conditions are obtained.

S P E C I F I E D  N O R M A L  A C C E L E R A T I O N

With this condition you specify the inward normal acceleration, an, at the boundary:

.

In this equation, an represents an external source term.

You can use this boundary condition to couple an acoustics model to a structural 
analysis. Examples of this usage in the Acoustics Module Model Library include 
“Hollow Cylinder” on page 19 and “Loudspeaker” on page 131.

A X I A L  S Y M M E T R Y

This condition is available only for axisymmetric geometries where it is the correct 
choice for the symmetry boundary at  r = 0.

n 1
ρ0
------ p q–∇( )⎝ ⎠
⎛ ⎞⋅ 1

Z
----

t∂
∂p

+ 0=

n 1
ρ0
------ ∇p q–( )⎝ ⎠
⎛ ⎞⋅ iωp

Z
----------+ 0=

Z ∞→ Z 0→

n–
1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ an=
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R A D I A T I O N  B O U N D A R Y  C O N D I T I O N S

The radiation conditions allow an outgoing wave to leave the modeling domain with 
no or minimal reflections. In specifying a boundary condition of this kind you have the 
choice between three wave types:

• Plane 

• Cylindrical

• Spherical

You can thus adapt the condition to the geometry of the modeling domain. In 
addition, you have the option of including an incoming wave. How to specify a 
radiation boundary condition is described in more detail in a following section.

Radiation boundary conditions are available for all analysis types. For the case of 
time-harmonic analysis, Givoli and Neta’s reformulation of the Higdon conditions 
(Ref. 1) for plane waves has been implemented to the second order. For cylindrical and 
spherical waves the software uses the corresponding 2nd-order expressions from 
Bayliss, Gunzburger, and Turkel (Ref. 2). The Transient and Eigenfrequency analysis 
types implement the same expansions to the first order. Because the precise expressions 
for the boundary conditions thus differ between the analysis types this discussion 
covers them under separate headings in a following section. The procedure for 
specifying a radiation boundary condition is, however, essentially the same in the three 
cases.
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Time-Harmonic Analysis
The next figure shows the layout of the Boundary Settings dialog box when you have 
selected the option Radiation condition from the Boundary condition list and chosen 
Plane wave as the Wave type.

To include an incoming plane wave, p0 e−i k·r, select the p0 option button and then 
supply the amplitude, p0, in the Pressure source edit field. Also supply the components 
of the wave-direction vector, nk, in the three Wave direction edit fields. Only the 
direction of the vector you enter matters because the software normalizes the 
components to make nk a unit vector. The wave vector is then defined as k = k nk, 
where k = ω/cs is the wave number.

By default p0 = 0. The default value of  nk is the inward normal vector, −n, which is 
the natural direction for waveguides and similar structures. For wave propagation in 
open space k can point in any direction.

Alternatively, you can set an incident wave equal to the application scalar variable pi by 
instead clicking the p0 = pi option button. By modifying the expression for this variable 
in the Application Scalar Variables dialog box—the default setting is the plane wave 
e−ikx—you can choose a form of the incident wave that suits your particular model.
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In more detail, the options for the outgoing wave are:

• Plane wave: You can use this boundary condition for both far-field boundaries and 
ports. Because many waveguide structures are only interesting in the plane-wave 
region, it is particularly relevant for ports.

In the time-harmonic case, the plane-wave boundary condition reads

or

depending on how the optional incoming wave is specified. In these equations, ∆T 
at a given point on the boundary denotes the Laplace operator in the tangent plane 
at that particular point.

In the notation of Givoli and Neta (Ref. 1), the above expressions correspond to the 
parameter choices C0 = C1 = C2 = ω/k. For normally incident waves this gives a 
vanishing reflection coefficient.

• Cylindrical wave: This boundary condition is based on a series expansion of the 
outgoing wave in cylindrical coordinates (Ref. 2), and it assumes the field is 
independent of the axial coordinate. You specify the axis of this coordinate system 
by giving an orientation (nx,  ny, nz) and a point (x0, y0, z0) on the axis. In 
axisymmetric geometries the symmetry axis is the natural and only choice.

With an incoming plane wave p0 e−i k·r included, the boundary condition reads

If you specify an incoming wave using the application scalar variable pi, the 
corresponding expression becomes
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In both equations, for a given point on the boundary, the value of  r denotes the 
shortest distance from the source to the point in question.

• Spherical wave: Use this option to allow a radiated or scattered wave—emanating 
from an object centered at the point (x0, y0, z0) that you specify—to leave the 
modeling domain without reflections. The boundary condition is based on an 
expansion in spherical coordinates from Bayliss, Gunzburger, and Turkel (Ref. 2), 
implemented to the second order.

The expression for the boundary condition reads

with an incoming plane wave included, or

if you use the application scalar variable pi to specify the incoming wave.

Eigenfrequency Analysis
For eigenfrequency analysis, the different 1st-order radiation boundary conditions can 
be summarized in the expression

where, again, k = ω/cs is the wave number while κ ( r ) is a function whose form 
depends on the wave type:

• Plane wave: κ(r) = 0

• Cylindrical wave: κ(r) = 1/(2r)

• Spherical wave: κ(r) = 1/r
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In the latter two cases, r is the shortest distance from the point r = (x, y, z) on the 
boundary to the source. The right-hand side of the equation represents the optional 
incoming plane pressure wave with amplitude p0 and wave vector k = k nk, where nk 
denotes the unit vector in the direction of propagation.

In eigenfrequency analysis you specify a radiation boundary condition in much the 
same way as for time-harmonic analysis (see page 80) with the exception that the 
option of using an application mode variable to specify the incident wave is absent. In 
addition to the wave type you can thus specify

• p0—the pressure source amplitude

• nk—the wave-direction vector

• r0 = (x0, y0, z0)—a point on the source axis (for a cylindrical wave) or the source 
location (for a spherical wave)

• raxis—the source axis direction (only for cylindrical waves)

Transient Analysis
The radiation boundary condition for transient analysis is the 1st-order expression

where κ ( r ) is the same wave-type dependent function as for the eigenfrequency case 
discussed on page 82. The right-hand side describes an incident wave, p0(r,  t), that you 
specify by selecting the p0 option button in the Boundary Settings dialog box and then 
supplying the expression in the associated edit field. Note that you can use different 
expressions for different boundaries.

If a single expression for the incident wave suffices for the model setup, you can instead 
select the p0 = pi option button. With this choice the right-hand side in the above 
equation describes an incident wave determined by the application scalar variable pi. 
Its default expression is a Gaussian pulse of width ∆t = 0.01 s traveling in the 
x direction:

To change the shape of the incoming wave, choose Scalar Variables from the Physics 
menu and edit the expression for the variable p_i_acpr.
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M A T C H E D  B O U N D A R Y

Just as does the radiation boundary conditions, the matched boundary condition 
belongs to the class of nonreflecting boundary conditions (NRBCs). In fact, it is based 
on the same 2nd-order approximation of Givoli and Neta’s NRBC scheme (Ref. 1) as 
the time-harmonic, plane-wave radiation condition discussed earlier.

Properly set up, the matched boundary condition allows two modes—characterized by 
their wave numbers, k1 and k2—to leave the modeling domain with minimal 
reflections. It is given by the equation

Here ∆T, for a given point on the boundary, refers to the Laplace operator in the 
tangential plane at that point, while p0 is the amplitude of an optional incoming plane 
wave with wave vector k. As described in more detail on page 79 in the context of 
radiation boundary conditions, in addition to p0 you specify the propagation direction, 
nk, whereas the wave number is not specified in this dialog box; instead, it is defined 
by k = ω/cs.

The matched boundary condition is particularly useful for modeling acoustic waves in 
ducts and waveguides at frequencies below the cutoff frequency for the second excited 
transverse mode. In such situations set k1 = ω/cs and k2 = ω1/cs, where ω1 = 2π f1, 
and f1 is the cutoff frequency for the first excited mode. With the default settings, 
k1 = k2 = ω/cs, the matched boundary condition reduces to the plane-wave option of 
the time-harmonic radiation boundary condition.

The matched boundary condition is available in time-harmonic and eigenfrequency 
analysis.

N E U T R A L

To impose periodic boundary conditions you need a homogeneous Neumann 
condition. When solving for the total acoustic pressure the sound-hard boundary 
condition is the homogeneous Neumann boundary condition. In models where you 
solve for the scattered pressure field, the incident pressure, pi ≡ pt − p, shows up in the 
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sound-hard boundary condition as the effective dipole-source term . For this 
reason, a separate neutral boundary condition is needed in such situations:

Here p denotes the scattered pressure. This boundary condition is available in the 
Boundary condition list when the application-mode property Solve for is set to Scattered 

wave.

I N T E R F A C E  C O N D I T I O N S  O N  I N T E R I O R  B O U N D A R I E S

By default only exterior boundaries are active in the Boundary Settings dialog box. 
However, if you select the Interior boundaries check box you can specify the interface 
conditions for boundaries inside the modeling domain that serve as partitions between 
subdomains. 

The following options are available in the Pressure Acoustics application mode 
(subscripts 1 and 2 refer to the two sides of the boundary):

• Continuity:

This condition, which expresses the continuity of the normal acceleration, is the 
default setting. It corresponds to a situation where the interior boundary has no 
direct effect on the acoustic pressure field.

• Sound soft boundary: p = 0

• Pressure: p = p0

I N T E R F A C E  C O N D I T I O N S  O N  P A I R S

If you have pairs connecting different parts of an assembly, you can set boundary 
conditions on the pairs. To do so, click on the Pairs tab on the Boundary Settings dialog 
box to activate the Pairs selection list and the associated Boundary condition list.

Because pairs can form interior boundaries, the boundary conditions available for 
interior boundaries listed in the previous paragraph are available also for pairs. In 
addition, pairs can have slit boundary conditions, that is, boundary conditions for 
which the dependent variable need not be continuous across the boundary.

The following slit boundary conditions are available in the Pressure Acoustics 
application mode (subscripts 1 and 2 refer to the two sides of the boundary):

pi∇–
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• Sound hard boundary (wall):

• Impedance boundary condition:

This boundary condition allows you to specify the impedance, Z, of an interior 
boundary. For transient analysis, the relevant conditions read:

In the frequency domain, the corresponding equations are:

For time-harmonic analysis, you have the option of specifying, instead of Z directly, 
the characteristic properties for a perforated plate. The software then calculates the 
impedance using the following expression (Ref. 3):

Here µ is the dynamic viscosity, σ is the porosity of the perforated plate (that is, the 
holes’ fraction of the boundary surface area—a dimensionless number between 0 
and 1), tp is the thickness of the perforated plate, and dh is the diameter of the holes 
in the plate. Furthermore, δh is an end correction to the reactance with the default 
value 0.25 dh, and θf is a contribution to the resistive part of the impedance that you 
can use, for example, to include the effects of a mean flow; by default this term is set 
to zero.

The perforated plate model is not available for transient analysis.

For an application of the perforated-plate impedance boundary condition, see the 
model “Muffler with Perforates” on page 154 of the Acoustics Module Model 
Library.

Point and Edge Conditions

Point and edge conditions are available in time-harmonic and transient analysis. Use 
them to include point and line sources for the acoustic pressure field.
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In 3D, you specify point sources in the Point Settings dialog box and line sources in the 
Edge Settings dialog box. In 2D, the Point Settings dialog box is used to specify line 
sources. The 2D axisymmetric case is somewhat special in that you specify both point 
sources and line sources in the Point Settings dialog box as displayed in the next figure. 
For points on the symmetry axis select the Point at r=0 option button to specify a point 
source. For points off the symmetry axis instead select the Edge in phi direction option 
button to specify a circular line source.

TR A N S I E N T  A N A L Y S I S

Point sources are monopoles, so Equation 5-2 gives

where r0 is the source location and S is the source strength with SI unit m3/s. For 
physical line sources—that is, those defined on edges in 3D, on edges in the 

direction in 2D axisymmetry, and at points in 2D—the same equation applies with 
the modification that the Dirac δ function is defined in the 2D planes perpendicular to 
the source. In this case the unit for S is m2/s.
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When specifying a transient point source you have two options for the Type of source:

•  Flow: The general option that allows you to specify the source strength, S, as an 
arbitrary function of time, t, by typing the relevant expression in the S edit field.

• Gaussian pulse: This option provides a convenient way to specify a Gaussian pulse; 
instead of typing in the expression for S(t), you supply three characteristic 
properties:

- The amplitude, A

- The frequency bandwidth, f0
- The pulse peak time, tp

These properties define a pulse of the form

where τ = 1/f0 is the pulse half width.

T I M E - H A R M O N I C  A N A L Y S I S

When a point source is located at r = r0, Equation 5-3 is modified to read

where S is the source amplitude.

In time-harmonic analysis there are three ways to specify the source strength 
depending on which characteristic property you have quantitative information of: flow, 
intensity, or power. Below follows a detailed description of each option.

Flow
If you choose the Flow option (the default) from the Type of source list in the Point 

Settings or the Edge Settings dialog box, the iS edit field is activated, allowing you to 
specify the source-strength amplitude. Note that the expression to enter in the edit 
field is  i times S, not S itself. The software includes this default phase shift of the 
source to produce a nonzero result when you visualize the resulting pressure field 
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using the default value (0) in the Solution at angle edit field in postprocessing dialog 
boxes.

The flow option is the only one that allows you to specify not only the source’s 
amplitude but also its complex phase. This can be useful if you have two or more 
sources that are mutually out of phase. For an interesting application involving an array 
of phase-shifted sources see the model “Bessel Panel” on page 8 of the Acoustics 
Module Model Library.

Intensity
Using this condition you can set a desired intensity, I, at a specified distance, dist, from 
the source. In a homogeneous medium you get the specified intensity, but with other 
objects and boundaries present the actual intensity is different.

This condition differs slightly between edges in 3D and 2D axisymmetric geometries 
and 2D points on the one hand and 3D and 2D axisymmetric points on the other. In 
the latter case the following equation holds:

For an edge in a 3D or 2D axisymmetric geometry or a point in 2D the corresponding 
equation reads

In both cases I has the default SI unit W/m2.
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Power
You can specify the source’s strength by stating the total power it would radiate into a 
homogeneous medium. Again, this condition differs slightly between edges in 3D and 
2D points on the one hand and 3D points on the other. For a point in 3D the 
following condition applies:

Here P is the radiated power with the default SI unit W.

For an edge in 3D or a point in 2D the relevant condition reads

where P now denotes the radiated power per unit length measured in W/m.

Far-Field Modeling

The Pressure Acoustics application mode supports far-field postprocessing for the 
Time-harmonic analysis type. This section describes how to use this functionality; for 
some background information about far-field modeling and its implementation in the 
Acoustics Module, see “Evaluating the Acoustic Field in the Far-Field Region” on 
page 30.

S P E C I F Y I N G  V A R I A B L E S  F O R  F A R - F I E L D  P O S T P R O C E S S I N G

To create a variable representing the acoustic pressure field in the far-field region, 
follow these steps:

1 In the Boundary Settings dialog box, click the Far-Field tab. Select the boundaries 
over which you want the software to integrate the near field, typically a closed 
surface where the pressure field and its normal derivative are available.

2 Type the name of the variable in the Name column.

3 Press Enter or click Apply to update the values in the Field and Normal derivative 
columns. The default settings are the dependent variable for the pressure, p, and its 
normal derivative, . 

In most cases, there is no reason to change these settings, but if you have set the 
pressure on any of the boundaries you can type the same value for the pressure on 
that boundary in the Field edit field. Similarly, if you use a Neumann boundary 
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condition at the far-field boundaries, typing the corresponding expression for 
 into the Normal derivative column provides the best accuracy. For example, 

if you set the normal acceleration you can set the field derivative to ρ an where ρ is 
the density and an is the normal acceleration.

4 Click the Integral approximation at r →   button to compute the value in the 
far-field limit (see “The Far-Field Limit” on page 32) or click the Full integral button 
to compute the full Helmholtz-Kirchhoff integral (see “The Helmholtz-Kirchhoff 
Integral Representation” on page 31).

The far-field variables you define become available as predefined quantities for 
postprocessing on surfaces (boundaries) and edges in 3D and on boundaries in 2D. 
For each far-field variable the software also generates a function that represents the 
acoustic far field. The input to the function is the coordinates. If the far field at 
infinite distance is calculated, the coordinates you specify determine the direction 
from the source. If the full integral is calculated, the function gives the acoustic field 
at the point with those coordinates. For example, you can type p_far(100,0,0), 
in the Expression field in the Global Data Display dialog box to evaluate the far-field 
variable p_far at x = 100 along the x-axis. 

Note: The function only gives the correct answer at points farther from the field 
source than the boundaries where the near field is calculated.

For the sound pressure level (SPL), Lp, of a far-field variable, an additional variable 
is available as a predefined quantity. Its name is the same as the name for the far-field 
variable with the capital letter L as a prefix and the application mode name as a suffix. 
For example, the name of the variable for the sound pressure level of the far-field 
variable p_far (with the default application mode name, acpr) is Lp_far_acpr.

5 When applicable, make use of symmetries to reduce the computational effort. The 
symmetry planes must coincide with one of the Cartesian coordinate planes. You 
specify the symmetry planes by selecting those of the check boxes x=0, y=0, and z=0 
that apply. For each plane, select the type of symmetry to use—either Symmetric 

pressure or Antisymmetric pressure. The choice should match the boundary 
condition you set for the symmetry boundary. With these settings you can include 
regions excluded from the model for symmetry reasons in the far-field analysis.

6 Click OK.

n p∇⋅

∞
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The Far-Field page in the Boundary Settings dialog box for the Pressure Acoustics 
application mode.

M O D E L S  U S I N G  F A R - F I E L D  P O S T P R O C E S S I N G

Models applying the far-field postprocessing features include “Cylindrical Subwoofer” 
on page 14 of this book as well as “Bessel Panel” on page 8, “Hollow Cylinder” on 
page 19, and “Scattering from a Plate with Ribs” on page 214 of the Acoustics Module 
Model Library.

The Ultraweak Variational Formulation

By default, the Pressure Acoustics application mode uses 2nd-order Lagrange 
elements. For time-harmonic analysis, you can alternatively set the application mode 
property Ultraweak variational formulation to On to use the ultraweak variational 
formulation (UWVF). The software then switches to using Ultraweak Helmholtz 
elements. The basis functions for these elements are plane waves, which are solutions 
to the Helmholtz equation in free space. Thus, in the UWVF the finite elements 
contain information about the solution to the wave equation Equation 5-3. Therefore, 
for a given wavelength, this formulation requires a much coarser mesh, making it 
suitable for ultrasound modeling.
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For guidelines on how to determine the mesh size when modeling with the UWVF, 
see the section “Using the Ultraweak Variational Formulation” on page 27. A tutorial 
example model, “Ultrasound Scattering Off a Cylinder,” is available on page 64 in the 
Acoustics Module Model Library.

The UWVF is available in 1D, 2D, and 3D (not for axisymmetric geometries) for 
time-harmonic analysis only.

For detailed theoretical information on the ultraweak variational formulation, see, for 
example, Ref. 4 and Ref. 5.

A P P L I C A T I O N  M O D E  V A R I A B L E

If the application mode property Ultraweak variational formulation is set to On, there is 
an extra application mode variable in addition to those listed in Table 5-2 on page 69:

The software uses this variable to determine the number of plane-wave basis directions 
per element, N, using the formula

where ε = 0.01 is the tolerance for the relative error. You can modify the value of nwave 
in the Application Scalar Variables dialog box; the default value is 1.

TABLE 5-3:  UWVF-SPECIFIC APPLICATION MODE VARIABLE

QUANTITY VARIABLE ANALYSIS GEOMETRIES DESCRIPTION

 n nwave H 3D, 2D, 1D Number of wavelengths per mesh 
element

Nε 2πn 1.8( ε( ) )2 3/ 2πn( )1 3/log–+=
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The value of N used for the elements is the number from a dimension-dependent set 
of integers that is closest to ; see Table 5-4.

Application Mode Variables

Table 5-5 lists the variables available for postprocessing and for use in equations and 
boundary conditions. The following abbreviations are used for the analysis and domain 
types:

TABLE 5-4:  AVAILABLE NUMBERS OF PLANE-WAVE BASIS DIRECTIONS FOR THE UWVF FINITE ELEMENTS

SPACE DIMENSION AVAILABLE N VALUES N VALUE FOR NWAVE = 1

1D 2 2

2D 15, 20, 25, 30, 35, 40 20

3D 12, 24, 30, 32, 50, 72 24

T Transient

H Time-harmonic

E Eigenfrequency

M Modal

S Subdomain

B Boundary

Nε

TABLE 5-5:  PRESSURE ACOUSTICS APPLICATION MODE VARIABLES

NAME SYMBOL DOM. ANALYSIS DESCRIPTION EXPRESSION

p_t  pt S H T tot. Total pressure  p

p_t  pt S H T sc. Total pressure  p + pi

p_s  ps S H T tot. Scattered pressure  p − pi

p_s  ps S H T sc. Scattered pressure  p

omega  ω S H M Angular frequency  2π f

omega  ω S E Angular frequency   − iλ

ai  ai S E M Acceleration,  
xi component

ai  ai S H T Acceleration,  
xi component

vi  vi S E Velocity,  
xi component

1
ρ0
------

xi∂
∂p

– qxi
+

1
ρ0
------

xi∂
∂p

– qxi
+

1
ρ0
------

xi∂
∂p

– qxi
+⎝ ⎠

⎛ ⎞ 1
iω
------
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axis

axis

axis

)/drn 

i0 eps+
n

i
n

vi  vi S H Velocity,  
xi component

Lp  Lp S E M Sound pressure level 10log10(p p*/(2pref
2))

Lp  Lp S H T Sound pressure level 10log10(pt  pt
*/(2pref

2))

Lp_s  Lp,s S H T Sound pressure level, 
scattered pressure

10log10(ps  ps
*/(2pref

2))

k  k S H Wave number  ω  / c

normv  |v| S H M E Local velocity, norm

norma   |a| S all Local acceleration, norm

delta  δ S H Scaling factor  1/ω2

Ii  Ii S H M E Intensity, xi component   vi
*p

normI  |I| S H M E Intensity, norm

PMLxi  PMLxi S H M E PML coordinate xi, 
Cartesian PML

 

  n ≡ PML scaling exponent

rx  rx S H M E  r vector in PML cylinder, 
x-coord., 
cylindrical PML (3D)

(yaxis
2 + zaxis

2)(x − x0) − 
(yaxis(y − y0) + zaxis(z − z0))x

ry  ry S H M E  r vector in PML cylinder, 
y-coord., 
cylindrical PML (3D)

(zaxis
2 + xaxis

2)(y − y0) − 
(zaxis(z − z0) + xaxis(x − x0))y

rz  rz S H M E  r vector in PML cylinder, 
z-coord., 
cylindrical PML (3D)

(xaxis
2 + yaxis

2)(z − z0) − 
(xaxis(x − x0) + yaxis(y − y0))z

normr S H M E  r vector in PML cylinder, 
norm, 
cylindrical PML (3D)

 [rx2 + ry2 + rz2]1/2

R  R S H M E Scaled radial coordinate, 
cylindrical PML (3D)

 R0  + (normr −R0)nLr(1 −  i

  n ≡ PML scaling exponent

TABLE 5-5:  PRESSURE ACOUSTICS APPLICATION MODE VARIABLES

NAME SYMBOL DOM. ANALYSIS DESCRIPTION EXPRESSION

1
ρ0
------

xi∂
∂p

– qxi
+⎝ ⎠

⎛ ⎞ 1
iω
------

v v⋅

a a⋅

I I⋅

sign xi Xi0 eps+–( ) xi X–

L× xi
1 i–( ) dx⁄
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Lz(1− i)/

axis |2

 

n 

z0)2]1/2 
You can find the complete list of application mode variables defined at each domain 
level in the corresponding equation-system dialog box. So, for example, to see which 
variables you can use for postprocessing at the boundary level, open the Physics menu 
and select Equation System>Boundary Settings. This action launches the Boundary 

Settings - Equation System dialog box in which you find a tab labeled Variables. Clicking 

PMLxi  PMLxi S H M E PML coordinate xi, 
cylindrical PML (3D)

 xi + (−1+ R/ normr )rxi + 

(raxis·(x − x0))/| raxis | − Z0)n

 dzn − raxis·(x − x0)xiaxis / | r

R  R S H M E Scaled radial coordinate, 
cylindrical PML (2D)

 R0  + (δ0 −R0)nLr(1 −  i)/drn

  n ≡ PML scaling exponent

PMLxi  PMLxi S H M E PML coordinate xi, 
cylindrical PML (2D)

 R (xi  − x0i)  /δ0 , 

δ0  ≡ [(x − x0)2 +(y −y0)2]1/2

R  R S H M E Scaled radial coordinate, 
spherical PML

R0   + (∆0  − R0)n (1 −  i) Lr  /dr

 ∆0  ≡ [(x − x0)2 +(y −y0)2+(z −

  n ≡ PML scaling exponent

PMLxi  PMLxi S H M E PML coordinate xi, 
spherical PML

 R (xi  − x0i)  /∆0

Jxixj S H M E PML transformation 
matrix, element xixj

invJxixj S H M E PML inverse transforma- 
tion matrix, element xixj

detJ  | J | S H M E Determinant of PML 
transformation matrix

 det (J)

pPMLxi S H M E Pressure derivative in 
PMLxi direction

nk B All Normal component 
of wave vector

n · k

na B All Normal acceleration n · a

nv B H E Normal velocity n · v

TABLE 5-5:  PRESSURE ACOUSTICS APPLICATION MODE VARIABLES

NAME SYMBOL DOM. ANALYSIS DESCRIPTION EXPRESSION

Jxixj

xj∂
∂ PMLxi

J 1–( )xixj

xj∂
∂p J 1–( )xjxi⋅
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this tab you find a list containing the application mode variables defined on boundaries 
for all application modes included in your model.

Note: In some cases the variables page is absent. There is, for example, no variables 
page at the edge level in 3D. However, you can still plot variables on edges as long as 
they are defined on the adjacent boundaries. In such situations, for each point on the 
edge the software calculates the average value of the quantity you want to plot at the 
nearest elements on each side of the edge.
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P r e s s u r e  A c ou s t i c s ,  Moda l  Ana l y s i s

When you feed an acoustic wave of a given angular frequency, ω, into a waveguide or 
a duct, only a finite set of shapes, or modes, for the transverse pressure field can 
propagate over long distances inside the structure. The higher the frequency, the 
higher the number of sustainable modes.

Take, as an example, a uniform straight duct whose axis is in the z direction. The 
acoustic field in such a duct can be written as a sum of the form

.

The constant kzj is the axial wave number of the jth propagating transverse mode, 
pj(x, y). These transverse modes and their associated axial wave numbers are solutions 
to an eigenvalue problem defined on the duct’s cross section. The modal analysis 
capabilities in the Pressure Acoustics application mode allow you to solve such 
eigenvalue problems.

For an example model involving modal analysis, see “Absorptive Muffler” on page 74 
in the Acoustics Module User’s Library.

Variables and Dimensions

The modal analysis types of the Pressure Acoustics application modes solve for the 
transverse eigenmodes for the acoustic pressure, p, and the associated propagation 
constants, kz.

The Pressure Acoustics, Boundary modal analysis application mode (acbm) is available 
for 3D Cartesian and 2D axisymmetric geometries, while the Pressure Acoustics 
application mode (acpr) supports modal analysis on 2D Cartesian and 1D 
axisymmetric geometries.

PDE Formulation

In 3D boundary modal analysis and in 2D modal analysis, the eigenvalue solver 
computes a specified number of solutions {  pj, λj } to the equation

p r( ) pj x y,( )e ikzjz–

j 0=

N

∑=
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r

 (5-7)

defined on a 2D boundary of the modeling domain (in 3D) or on the 2D domain 
itself, with λ = −ikz as the eigenvalue. In this equation p is the pressure, ρ is the density, 
c is the speed of sound, ω is the angular frequency, and kz is the propagation constant, 
in this context also referred to as the out-of-plane wave number.

Note: Although the out-of-plane wave number is denoted kz, the two-dimensional 
surface on which Equation 5-7 is defined does not necessarily have to be normal to 
the  z-axis for 3D geometries.

The dipole source, q, and the monopole source, Q, are normally ignored by the solver 
because they are independent of the dependent variable, p; thus they are not 
considered further in this section. When solving a coupled eigenvalue problem, 
however, these terms can be of interest.

Note that the above equation is identical to the 2D time-harmonic Equation 5-4, 
except that kz is interpreted as an eigenvalue and not as a parameter.

For axisymmetric geometries, both 2D and 1D, the relevant eigenvalue equation to 
solve for the radial pressure modes and the eigenvalues, λ, is

Here m, the circumferential wave number, is an integer-valued parameter. The 
equation is defined on the interval r1 < r < r2. The eigenvalue, λ, is defined in terms of 
the axial wave number, kz through the equation λ = −ikz.

Application Scalar Variables

The application scalar variables defined in modal analysis are given in Table 5-6.

∇ 1
ρ
--- p q–∇( )–⎝ ⎠

⎛ ⎞⋅ ω2

ρ0c2
------------

kz
2

ρ0
------–

⎝ ⎠
⎜ ⎟
⎛ ⎞

p– Q=

rd
d r

ρ0
------

rd
dp

⎝ ⎠
⎛ ⎞ ω

cs
------⎝ ⎠
⎛ ⎞ 2

λ2 m
r
-----⎝ ⎠
⎛ ⎞ 2

–+
rp
ρ0
------+ 0=

TABLE 5-6:  APPLICATION SCALAR VARIABLES FOR PRESSURE ACOUSTICS MODAL ANALYSIS

QUANTITY VARIABLE DEFAULT UNIT GEOMETRIES DESCRIPTION

 f freq 100 Hz All Frequency

 ikz ikz -lambda 1/m 3D, 2D Imaginary out-of-plane wave numbe
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To inspect or modify the current settings, choose Physics>Scalar Variables to open the 
Application Scalar Variables dialog box.

Application Mode Properties

Table 5-7 lists the application mode properties defined for modal analysis.

Where damping is available, the same damping models as for time-harmonic and 
eigenfrequency analysis apply; see page 71.

 ikz ikz -lambda 1/m 2D axi, 1D axi Imaginary axial wave number

 m m 0 2D axi, 1D axi Circumferential wave number

 pref p_ref 20e-6 Pa SPL pressure reference

TABLE 5-6:  APPLICATION SCALAR VARIABLES FOR PRESSURE ACOUSTICS MODAL ANALYSIS

QUANTITY VARIABLE DEFAULT UNIT GEOMETRIES DESCRIPTION

TABLE 5-7:  APPLICATION MODE PROPERTIES FOR PRESSURE ACOUSTICS MODAL ANALYSIS

PROPERTY VALUES DESCRIPTION

Default element type Lagrange elements of 
order 1–5 (the default 
value is 2)

Specifies which type of finite 
elements to use.

Specify eigenvalues using Propagation constant | 
Eigenvalue | Phase 
velocity

Specifies the quantity in which 
the solver parameters should be 
given.

Weak constraints On | Off Specifies if weak constraints 
should be used.

Constraint type Ideal | Non-ideal Specifies the type of constraint.
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Subdomain Settings

The topic of this subsection is how to set the properties on the domain where the 
relevant eigenvalue equation is defined. For 3D and 2D axisymmetric geometries this 
domain is part of the boundary of the geometry in the drawing area. In the 2D and 
1D axisymmetric cases, on the other hand, the eigenvalue equation is defined at the 
subdomain level. For this reason you specify the coefficients appearing in the 
eigenvalue equation in the Boundary Settings dialog box for the former two geometry 
types and in the Subdomain Settings dialog box for the latter two. Once you have found 
the appropriate dialog box, the procedure for specifying equation parameters and 
damping models (when applicable) are identical. Thus see the section “Subdomain 
Settings” on page 70 for further information and instructions.

There is another consequence of the fact that the boundary modal analysis types in 3D 
and 2D axisymmetric geometries are defined in one dimension lower than that of the 
geometry in the drawing area: you must explicitly deactivate the acbm application 
mode on the boundaries where you do not want to solve the eigenvalue problem. 
Typically these boundaries correspond to the duct or waveguide walls.

Consider, as an example, the cube in the next figure and assume that a Pressure 
Acoustics, Boundary modal analysis application mode is defined on this 3D geometry. 
Further assume that you want to find the boundary modes on the bottom surface.
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The following image shows the Boundary Settings dialog box for this application mode.

At the bottom left of the dialog box, inside the Boundary Selection area, is the Active in 

this domain check box. To deactivate the application mode on all boundaries except 
the bottom face, select the remaining five boundaries in the Boundary selection list (or 
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by Ctrl-clicking in the drawing area), then clear the Active in this domain check box. 
Once this is done the edges of the bottom face turn from interior to exterior 
boundaries. Consequently, the full set of boundary conditions becomes available, 
allowing you to specify conditions on these edges that reflect the boundary conditions 
on the cube’s inner walls.

Boundary Conditions

Table 5-8 lists the availability of different boundary conditions for modal analysis.

Here the term “boundary condition” refers to conditions that you can impose on the 
boundary of the domain where the eigenvalue equation is defined. The letters in the 
table indicate which dialog box you should open to set or inspect such boundary 
conditions:

The expressions for the boundary conditions agree almost fully with those presented 
for the nonmodal analysis types in the subsection “Boundary Conditions” on page 76. 
The last two conditions in Table 5-8 deserve some further comments, though.

R A D I A T I O N  C O N D I T I O N

The radiation conditions for 2D and 1D axisymmetric geometries are the same 
1st-order expressions as those used for eigenfrequency analysis:

TABLE 5-8:  BOUNDARY CONDITIONS, PRESSURE ACOUSTICS MODAL ANALYSIS

BOUNDARY CONDITION 3D 2D AXI 2D 1D AXI

Sound-hard E P B B

Sound-soft E P B B

Pressure E P B B

Normal acceleration E P B B

Impedance E P B B

Axial - P - B

Radiation - - B B

Matched boundary - - B -

B  Boundary Settings

E  Edge Settings

P  Point Settings
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Here k = ω/cs is the wave number, and κ ( r ) = 0 for an outgoing plane wave (only in 
2D) and κ ( r ) = 1/(2r) for a cylindrical wave (the spherical-wave option does not 
apply). For further details, see page 82.

M A T C H E D  B O U N D A R Y

The matched boundary condition for modal analysis in 2D is identical to the one for 
time-harmonic analysis. Therefore see the discussion in the subsection “Matched 
Boundary” on page 84.

Application Mode Variables

The application mode variables for the modal analysis types are included in Table 5-5 
on page 94, which lists the variables for all Pressure Acoustics analysis types.

n 1
ρ0
------ ∇p q–( )⎝ ⎠
⎛ ⎞⋅ ik κ r( )+( ) p

ρ0
------+ ik κ r( ) i k n⋅( )–+( )

p0
ρ0
------e

i k r⋅( )–
=
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 6
A e r o a c o u s t i c s  
This chapter describes the two Aeroacoustics application modes in the Acoustics 
Module:

• Aeroacoustics (acae)

• Aeroacoustics, Boundary modal analysis (acab)

As in the previous chapter on pressure acoustics, the latter mode is discussed in a 
separate section together with the modal analysis type of the Aeroacoustics 
application mode.

In addition, the chapter contains a presentation of the application mode 
Compressible Potential Flow (acpf), which is included in the Acoustics Module to 
allow fully dynamic simulations of the fluid in which the acoustic waves propagate.

The chapter begins with a brief theory review.
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Th eo r y  Ba c k g r ound

For a mathematical description of the noise generated in fluids in turbulent motion or 
by the aerodynamic forces acting in the interface between a moving fluid and a 
structural boundary, the acoustic pressure is not the most suitable dependent variable 
to use. Instead, to couple acoustics and fluid dynamics, a formulation based on the 
potential field for the particle velocity, has been developed. This is the scientific field 
of aeroacoustics.

This section presents the basic mathematical framework for aeroacoustics, starting with 
the equations for the acoustic waves in a given mean-flow velocity field. Then follows 
a presentation of the equations describing the dynamics of this background flow, which 
is assumed to be compressible, inviscid, barotropic, and irrotational.

Descriptions of the associated application modes appear in the subsequent sections.

Aeroacoustics

In aeroacoustics, the basic dependent variable is the velocity potential, , 
conventionally defined by the relationship

where v = v(r, t) is the particle velocity associated with the acoustic wave motion. The 
total  particle velocity is given by

 (6-1)

where V denotes the local mean velocity for the fluid motion. The dynamic equations 
for this mean-flow field are described in the next subsection. For now, just assume V 
to be a given irrotational background velocity field; hence, also the mean-flow 
velocity can be defined in terms of a potential field, Φ, by . 

The equation for the velocity potential, , governing acoustic waves in a background 
flow with mean velocity, V, mean density, ρ, and mean speed of sound, cs is

 (6-2)

φ

v φ∇=

vtot r t,( ) V x( ) v r t,( )+=

V ∇Φ=

φ

ρ

cs
2

-----–
t∂

∂
t∂

∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞ ∇ ρ φ∇ ρ

cs
2

-----
t∂

∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞V–⋅+ 0=
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In deriving this equation, all variables appearing in the full nonlinear fluid-dynamics 
equations were first split in time-independent and acoustic parts, in the manner of 
Equation 6-1. Then, linearizing the resulting equations in the acoustic perturbation 
and eliminating all acoustic variables except the velocity potential gives Equation 6-2. 
Thus, the density, ρ, in this equation is the time-independent part. The corresponding 
acoustic part is ρa(r, t) = p(r, t)/cs

2 where p is the acoustic pressure, given by

Hence, once Equation 6-2 has been solved for the velocity potential the acoustic 
pressure can easily be calculated.

When transformed to the frequency domain, the wave equation 6-2 reads

while the acoustic pressure is

Typical boundary conditions include:

• Sound-hard boundaries or walls

• Sound-soft boundaries

• Impedance boundary conditions

• Radiation boundary conditions

These, and a few additional options available in the Aeroacoustics application mode, 
are described in more detail in the next section, on page 117.

Compressible Potential Flow

The previous section presented the equations for aeroacoustic waves in a background 
mean-flow field characterized by its velocity, density, and sound speed. This section 
discusses the equations of motion and state for the fluid in some detail.

Consider a compressible and inviscid fluid in some domain Ω. The motion and state of 
the fluid is described by its velocity, V, density, ρ, pressure, p, and total energy per unit 
volume, e. Its dynamics is governed by the Euler equations, expressing the 
conservation of mass, momentum, and energy: 

p r t,( ) ρ
t∂

∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞–=

ρ
cs

2
-----– iω iωφ V φ∇⋅+( ) ∇ ρ φ∇ ρ

cs
2

----- iωφ V φ∇⋅+( )V–⋅+ 0=

p r( ) ρ iωφ V φ∇⋅+( )–=
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 (6-3)

Here a volume force, f, has been included on the right-hand side of the momentum 
equation, whereas a possible heat-source term on the right-hand side of the energy 
equation (the last one) has been set to zero.

To close this system of five equations with six unknowns, an equation of state is 
required. Here this is taken to be the equation for an ideal barotropic fluid,

where γ = cp /cV is the ratio between the specific heats at constant pressure and 
constant volume, while p0 and ρ0 are reference quantities for the pressure and the 
density, respectively, valid at some point in space. An alternative form of the ideal-fluid 
state equation is

The assumption that the fluid is barotropic means that p = p(ρ). Taking the total time 
derivative and using the chain rule, leads to the relation

where, using the equation of state,

defines the speed of sound in the ideal fluid.

Assuming the flow to be irrotational, there exists a velocity potential  field, Φ, such that 
. If, in addition, the volume force is assumed to be given by , 

where Ψ is referred to as the force potential, the second of Equations 6-3 can be 
integrated to yield the Bernoulli equation

t∂
∂ρ ∇ ρV( )⋅+ 0=

ρ
t∂

∂V V ∇⋅( )V+⎝ ⎠
⎛ ⎞ p∇+ f=

∂e
∂t
----- ∇ e p+( )V( )⋅+ 0=

p p0
ρ
ρ0
------⎝ ⎠
⎛ ⎞ γ

=

p ρ γ 1–( )e=

td
dp

ρd
dp

td
dρ cs

2

td
dρ≡=

cs γ p
ρ
---=

V Φ∇= f ρ Ψ∇–=
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In this equation, two additional reference quantities have entered: the velocity, v0, and 
the force potential, Ψ0, both valid at the same reference point as p0 and ρ0. Note, in 
particular, that neither the pressure, p, nor the energy per unit volume, e, appears in 
this equation.

Collecting the results, the equations governing the compressible, inviscid, irrotational 
flow of an ideal fluid are

t∂
∂Φ 1

2
--- Φ∇ 2 p0

γργ 1–

γ 1–( )ρ0
γ

----------------------- Ψ+ +
⎝ ⎠
⎜ ⎟
⎛ ⎞

+
1
2
---v0

2 p0γ
γ 1–( )ρ0

----------------------- Ψ0+ +=

t∂
∂Φ 1

2
--- Φ∇ 2 p0

γργ 1–

γ 1–( )ρ0
γ

----------------------- Ψ+ ++
1
2
---v0

2 p0γ
γ 1–( )ρ0

----------------------- Ψ0+ +=

t∂
∂ρ ∇ ρ Φ∇( )⋅+ 0= cs γ p

ρ
---= γ cp cV⁄≡
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App l i c a t i o n  Mode De s c r i p t i o n

Variables and Space Dimensions

The Aeroacoustics application mode (acae) solves for the velocity potential, . It is 
available for 3D, 2D, and 1D Cartesian geometries as well as for 2D and 1D 
axisymmetric geometries.

Note that Aeroacoustics, Boundary modal analysis (acab) counts as a separate 
application mode, available for 2D axisymmetric and 3D geometries. This application 
mode is described in the next section together with the modal analysis type for the 
Pressure Acoustics application mode in 2D.

The general discussion uses equations and settings that apply to the 3D case. Where 
the lower-dimensional geometries differ, this is explicitly noted.

PDE Formulation

The Aeroacoustics application mode provides three different analysis types:

• Transient analysis

• Time-harmonic analysis

• Modal analysis (for 2D and 1D axisymmetric geometries)

This section treats the former two cases, while modal analysis is discussed in the section 
“Aeroacoustics—Modal Analysis” on page 124.

TR A N S I E N T  A N A L Y S I S

The following equation governs acoustic waves in a mean flow:

 (6-4)

Here ρ (kg/m3) is the density, V (m/s) denotes the mean velocity, and cs (m/s) refers 
to the speed of sound. The software solves the equation for the velocity potential, , 
with SI unit m2/s. The validity of this equation relies on the assumption that ρ, V, and 
cs are approximately constant in time, while they may be functions of the spatial 
coordinates.

φ

ρ
cs

2
-----–

t∂
∂

t∂
∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞ ∇ ρ φ∇ ρ

cs
2

-----
t∂

∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞V–⋅+ 0=

φ
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T I M E - H A R M O N I C  A N A L Y S I S

For harmonic waves of the form , each time-derivative in 
Equation 6-4 can be replaced by a factor iω, leading to the frequency-domain equation

In 2D, where , the out-of-plane wave number, kz, enters 
the equations when the  operators are expanded:

The out-of-plane wave number is an application scalar variable (see Table 6-1) whose 
value you can specify; the default value is 0, that is, no wave propagation perpendicular 
to the 2D plane. Alternatively, by using the eigenvalue solver you can solve for kz in a 
modal analysis; see the next section.

For 2D axisymmetric models, , the circumferential wave 
number, m, similarly  appears in the equation as a parameter:

Note that the background velocity field, V, cannot have a circumferential component 
because the flow is irrotational.

Application Scalar Variables

The application scalar variables are given in the following table.

TABLE 6-1:  AEROACOUSTICS APPLICATION MODE SCALAR VARIABLES

NAME SYMBOL ANALYSIS TYPES/GEOMETRIES DEFAULT UNIT DESCRIPTION

freq  f Time-harmonic, Modal 100 Hz Excitation frequency

pref  pref All 20e-6 Pa Pressure reference

ikz Time-harmonic /2D 0 1/m Imaginary out-of-plane 
wave number

φ r t,( ) φ r( )eiωt
=

ρ
cs

2
-----– iω iωφ V φ∇⋅+( ) ∇ ρ φ∇ ρ

cs
2

----- iωφ V φ∇⋅+( )V–⋅+ 0=

φ r t,( ) φ x y,( )ei ωt kzz–( )
=

∇

i– ω ρ
cs

2
------- iωφ V φ∇⋅ ikzVzφ–+( ) ∇ ρ φ∇ V ρ

cs
2

------- iωφ V φ∇⋅ ikzVzφ–+( )–
⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅+

ρ+ kz
2φ ikzVz

ρ

cs
2

------- iωφ V φ∇⋅ ikzVzφ–+( )+ 0=

φ r t,( ) φ r z,( ) ei ωt mϕ–( )
=

i– ω ρ

cs
2

------- iωφ V φ∇⋅+( ) ∇ ρ φ∇ V ρ

cs
2

------- iωφ V φ∇⋅+( )–
⎝ ⎠
⎜ ⎟
⎛ ⎞

ρ m
r2
-----

2
φ+⋅+ 0=
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You can change the settings from their default values in the Application Scalar Variables 
dialog box, which you open by selecting the menu item Scalar Variables from the 
Physics menu.

Application Mode Properties

Table 6-2 lists the properties that can be set in the Application Mode Properties dialog 
box that you can reach from the Model Navigator when selecting or adding application 
modes or by choosing Physics>Properties during a modeling session.

For details on the Modal analysis type, see the section “Aeroacoustics—Modal 
Analysis” on page 124. For a review of element types and weak constraints refer to the 
sections “Understanding the Finite Element Method” on page 452 of the COMSOL 
Multiphysics Reference Guide and “Using Weak Constraints” on page 300 in the 
COMSOL Multiphysics Modeling Guide.

ikz Time-harmonic / 
1D Axi

0 1/m Imaginary axial wave 
number

m Time-harmonic, Modal / 
2D Axi, 1D Axi

0 1 Circumferential wave 
number

ikz Modal / 3D -lambda 1/m Imaginary out-of-plane 
wave number

ikz Modal / 2D axi -lambda 1/m Imaginary axial 
wave number

TABLE 6-2:  AEROACOUSTICS APPLICATION MODE PROPERTIES

PROPERTY VALUES DESCRIPTION

Default element type Lagrange elements of 
order 1–5 (the default 
value is 2)

Specifies which type of finite 
elements to use

Analysis type Time-harmonic | Modal 
analysis | Transient

Specifies which type of analysis 
to perform

Specify eigenvalues using Eigenvalue | Propagation 
constant | Phase velocity

Specifies the quantity in which 
the solver 
parameters should be given; 
applies only to modal analysis

Weak constraints On | Off Specifies if weak constraints 
should be used

Constraint type Ideal | Non-ideal Specifies the type of constraint

TABLE 6-1:  AEROACOUSTICS APPLICATION MODE SCALAR VARIABLES

NAME SYMBOL ANALYSIS TYPES/GEOMETRIES DEFAULT UNIT DESCRIPTION
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Subdomain Settings

The Subdomain Settings dialog box contains the following pages, each accessible by 
clicking the corresponding tab:

• Coefficients—This is where you specify acoustic properties pertaining to 
subdomains.

• PML—In time-harmonic and modal analysis you can include auxiliary subdomains in 
the geometry that serve as perfectly matched layers; use this page to specify their 
properties.

• Init—For transient analysis, use this page to supply initial values for the velocity 
potential and its first-order time derivative. For the other analysis types, you can 
specify a nontrivial starting solution for the nonlinear solver, a feature that can be 
relevant when solving coupled multiphysics models.

• Elements—Here you can change the specifications for the finite elements to be used 
in the subdomain; for further details, refer to the subsection “Specifying the Finite 
Element Type” on page 211 of the COMSOL Multiphysics User’s Guide.

• Color—This page is only active when the Groups page is open. Use it to visually 
distinguish between groups of subdomains with common settings by giving them 
different colors in the user interface. For 1D axisymmetric and 1D geometries, the 
tab is labeled Color/Style because there you can also set the line style.

C O E F F I C I E N T S

On the Coefficients page you can specify the mean-flow velocity, V, the mean-flow 
speed of sound, cs, and the fluid density, ρ. The default values for the latter two 
quantities apply to air at atmospheric pressure and room temperature. If these default 
settings do not apply in your model, you can search the materials libraries for the 
relevant medium. To do so, select any subdomain, click the Load button to activate the 
Library material list, and then browse the available libraries. For detailed information 
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on how to use the materials libraries, consult “Using the Materials/Coefficients 
Library” on page 223 of the COMSOL Multiphysics User’s Guide.

The default mean-flow velocity is zero unless you are using the application mode 
Aeroacoustics with Flow—a combination of the Aeroacoustics (acae) and 
Compressible Potential Flow (acpf) application modes; in such a case the default 
setting is V = vacpf, as exemplified in the previous figure.

P E R F E C T L Y  M A T C H E D  L A Y E R S  ( P M L S )

The Aeroacoustics application mode offers an absorbing boundary condition, the 
radiation boundary condition, which is perfectly absorbing for a plane wave. For 
models where you cannot describe the incident radiation as a plane wave with a 
well-known direction of propagation, you can use perfectly matched layers (PMLs) to 
emulate nonreflecting boundaries. For further details, see the discussion under the 
heading “Perfectly Matched Layers (PMLs)” on page 37.

The PML page is available for time-harmonic and modal analysis. The following types 
of PMLs are available:

TYPE GEOMETRY DESCRIPTION

None All Not absorbing

Cartesian 3D, 2D, 1D Absorbing in the specified coordinate directions

Cylindrical 3D, 2D axi, 1D, 1D axi Absorbing in the radial or axial direction
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Boundary Conditions

To complete the mathematical formulation of your model you must supply a set of 
boundary conditions that properly reflects the physics at the interface between the 
modeling domain and its surroundings. This subsection describes the options at your 
disposal in the Aeroacoustics application mode.

S O U N D - H A R D  B O U N D A R I E S  ( WA L L S )

For modeling rigid boundary surfaces, or walls, use the sound-hard condition. It 
prescribes a vanishing normal component of the particle velocity at the boundary. 
Multiplied by the density, it can equivalently be expressed as a no-flow condition:

The sound-hard boundary condition is available for all analysis types. The equation 
above applies to the transient case; to obtain the corresponding condition for 
time-harmonic acoustic waves, simply replace ∂/∂t by iω.

S O U N D - S O F T  B O U N D A R I E S

At a sound-soft boundary, the acoustic pressure vanishes:

Use this condition to model the interface between a liquid and a gas.

N O R M A L  M A S S  F L O W

The natural boundary condition for the total wave has the meaning of a mass flow 
through the boundary surface:

To specify a normal mass flow boundary condition, type the value of the inward mass 
flow, mn, in the mn edit field.

Spherical 3D, 2D axi, Absorbing in the radial direction

User defined All User-defined PML coordinates

TYPE GEOMETRY DESCRIPTION

n– ρ φ V ρ
cs

2
-----

t∂
∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞–∇

⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅ 0=

p 0=

n– ρ φ∇ V ρ

cs
2

-------
t∂

∂φ V φ∇⋅+⎝ ⎠
⎛ ⎞–

⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅ mn=
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VE L O C I T Y  P O T E N T I A L

When coupling two Aeroacoustics application modes together it can sometimes be 
necessary to set the velocity potential:

For an example model using the velocity potential boundary condition, see the model 
“Flow Duct” on page 101 of the Acoustics Module Model Library.

I M P E D A N C E

In time-harmonic analysis you can define the input impedance of the external domain 
as the ratio of pressure to normal velocity, Zi = p/(n · v) at the boundary. The 
associated impedance boundary condition reads

R A D I A T I O N  C O N D I T I O N

This is a class of non-reflecting boundary conditions which assumes that there is an 
outgoing plane wave, and optionally also an incoming exciting wave.

For transient analysis the boundary condition is

while the corresponding time-harmonic equation reads

φ φ0=

n ρ φ∇ V ρ

cs
2

------- iω φ V φ∇⋅+( )–
⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅ ρ p
Z
---- 1

iω
------ V ∇⋅( ) p

Z
----+⎝ ⎠

⎛ ⎞=

n– ρ φ∇ V ρ
cs

2
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t∂
∂φ φ∇ V⋅( )+⎝ ⎠
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⎝ ⎠
⎜ ⎟
⎛ ⎞

ρkn t∂
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– n V ρ
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2
-----

t∂
∂φ kn t∂
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You specify an incoming plane wave, 0 e−i (k · r), by supplying its amplitude, 0, and 
propagation vector, nk.

This boundary condition is most relevant for ports, because many wave-guide 
structures are only interesting in the plane-wave region.

N O R M A L  VE L O C I T Y

In time-harmonic analysis you can specify the velocity component normal to the 
boundary:

Here vn denotes the outward normal velocity at the boundary surface, which you 
specify in the vn edit field.

I N T E R F A C E  C O N D I T I O N S  O N  I N T E R I O R  B O U N D A R I E S

By default only exterior boundaries are active in the Boundary Settings dialog box. 
However, if you select the Interior boundaries check box you can specify the interface 
conditions for boundaries inside the modeling domain that serve as partitions between 
subdomains. 

The following options are available in the Aeroacoustics application mode (subscripts 
1 and 2 refer to the two sides of the boundary):

• Continuity:

This condition, which expresses the continuity of the mass flow, is the default 
setting. It corresponds to a situation where the interior boundary has no direct 
effect on the acoustic velocity potential field.
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cs

2
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• Sound soft boundary: p = 0

• Pressure: p = p0

I N T E R F A C E  C O N D I T I O N S  O N  P A I R S

If you have pairs connecting different parts of an assembly, you can set boundary 
conditions on the pairs. To do so, click on the Pairs tab on the Boundary Settings dialog 
box to activate the Pairs selection list and the associated Boundary condition list.

Because pairs can form interior boundaries, the boundary conditions available for 
interior boundaries listed in the previous paragraph are available also for pairs. In 
addition, pairs can have slit boundary conditions, that is, boundary conditions for 
which the dependent variable need not be continuous across the boundary.

The following slit boundary conditions are available in the Aeroacoustics application 
mode (subscripts 1 and 2 refer to the two sides of the boundary):

•  Sound hard boundary (wall): For transient analysis, this boundary condition reads:

As usual, replace time-derivatives by the factor iω to obtain the corresponding 
time-harmonic equations.

•  Impedance boundary condition: This boundary condition, available for 
time-harmonic analysis, allows you to specify the impedance, Z, of an interior 
boundary. The equations defining this boundary conditions are:

.

•  Vortex sheet: To model a shear layer that separates a stream from the free velocity 
field use a vortex sheet boundary condition. Because the velocity potential is 
discontinuous over this boundary you must use an assembly and set the boundary 
condition on a pair.

The equations defining the vortex sheet boundary conditions are
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cs
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where w denotes the outward normal displacement of the boundary surface.

This boundary condition is available for models using time-harmonic analysis.

The model “Jet Pipe” on page 34 of the Acoustics Module Model Library provides 
an example for how to apply the vortex-sheet boundary condition.

Point and Edge Conditions

Point and edge conditions are available to specify a mass flow rate.

Application Mode Variables

Table 6-3 lists the application mode variables available for postprocessing purposes at 
the subdomain level for 3D geometries in the Aeroacoustics application mode.

TABLE 6-3:  AEROACOUSTICS APPLICATION MODE 3D SUBDOMAIN VARIABLES

VARIABLE SYMBOL DESCRIPTION EXPRESSION

omega  ω Angular frequency  2π f

vi  vi Velocity in xi direction  ∂ /∂xi

normv  |v| velocity, norm

p  p Pressure

Lp  Lp Sound pressure level  10log10(p p*/(2pref
2))

Ii  Ii Intensity, xi component

normI  |I| Intensity, norm

R  R Scaled radial coordinate, 
cylindrical PML

R0   + (δ0 −R0) (1 −  i) Lr/dr 

δ0  = [(x − x0)2 +(y −y0)2]1/2

n ρ φ∇ V ρ
cs

2
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For each domain type in the current geometry, you can inspect the complete list of 
application mode variables defined at that level in the corresponding equation system 
dialog box. So, for example, to see what variables you can use for postprocessing at the 
boundary level, open the Physics menu and select Equation System>Boundary Settings. 
This action launches the Boundary Settings - Equation System dialog box, on which you 
find a tab labeled Variables. Clicking this tab, you find a list containing the application 

R  R Scaled radial coordinate, 
spherical PML

R0   + (∆0  − R0) (1 −  i) Lr  /dr 

∆0  = [(x − x0)2 +(y −y0)2+(z −z0)2]1/2

PMLxi  PMLxi PML coordinate xi (xi − x0i)(1−i) Li/di 

PMLxi  PMLxi PML coordinate xi, 
cylindrical PML

R (xi  − x0i)  /δ0 

δ0  = [(x − x0)2 +(y −y0)2]1/2

PMLxi  PMLxi PML coordinate xi, 
spherical PML

R (xi  − x0i)  /∆0

PMLz  PMLz PML coordinate z (z   − z0) (1 −  i) Lz   / dz 

Jxy  Jxy PML transformation 
matrix, element xy

invJxy PML inverse 
transformation matrix, 
element xy

detJ  |J| Determinant of 
transform matrix

det(J)

phiPMLxi Pressure derivative in 
PMLxi direction

TABLE 6-3:  AEROACOUSTICS APPLICATION MODE 3D SUBDOMAIN VARIABLES

VARIABLE SYMBOL DESCRIPTION EXPRESSION

x∂
∂ PMLy

J 1–( )xy

φ∇ J 1–( )xxi J 1–( )yxi J 1–( )zxi, ,( )⋅
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mode variables defined on boundaries for all application modes included in your 
model.

Note: In some cases, the variables page is absent. There is, for example, no variables 
page at the edge level in 3D. However, you can still plot variables on edges as long as 
they are defined on the adjacent boundaries. In such situations, for each point on the 
edge, the software calculates the average value of the quantity you want to plot at the 
nearest elements on each side of the edge.
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A e r o a c ou s t i c s—Moda l  Ana l y s i s

The Acoustics Module provides the following types of analysis for calculating the 
aeroacoustical eigenmodes of ducts and waveguides:

• The Aeroacoustics, Boundary modal analysis application mode (acbm) for 3D and 
2D axisymmetric geometries

• The modal analysis type of the Aeroacoustics application mode (acae) for 2D 
geometries

The presentation below first focuses on the case of 3D geometries, before remarking 
on the 2D axisymmetric and 2D cases.

For an example model involving an Aeroacoustics, Boundary modal analysis 
application mode, see “Flow Duct” on page 101.

Application Mode Properties

In addition to the standard properties Default element type and Weak constraints, you 
can specify the following property in the Application Mode Properties dialog box:

The default option is Propagation constant.

PDE Formulation

The boundary modal analysis type in 3D uses the eigenvalue solver to solve the 
equation

 (6-5)

PROPERTY VALUES DESCRIPTION

Specify eigenvalues using Eigenvalue | Propagation 
constant | Phase velocity

Specifies the quantity in 
which the solver 
parameters should be given

i– ω ρ
cs
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for eigenmodes, , and eigenvalues, λ = −ikz, on a bounded two-dimensional domain, 
Ω, given well-posed edge conditions on ∂Ω. In this equation,  is the velocity 
potential, ρ is the density, cs is the speed of sound, ω is the angular frequency, and kz 
is the out-of-plane wave number or propagation constant. Furthermore, Vt denotes 
the mean velocity in the tangential plane while Vn is the mean-velocity component in 
the normal direction. 

Note: Although the out-of-plane wave number is called kz, the two-dimensional 
surface on which Equation 6-5 is defined does not necessarily have to be normal to 
the  z-axis for 3D geometries.

In the Solver Parameters dialog box, you can specify the number of eigenmodes the 
solver should look for and the value around which it should start the search. Supply 
these values in the Desired number of propagation constants and Search for propagation 

constants around edit fields.

φ
φ
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Application Scalar Variables

The application scalar variables are given in the table below.

Boundary Conditions

You can specify values for the following properties appearing in Equation 6-5 on the 
Coefficients page of the Boundary Settings dialog box:

• Mean flow velocity: Supply the x-, y-, and z-components of the mean-flow velocity, 
V = (Vx, Vy, Vz), in the respective boxes of the V edit field. By default, the mean-flow 
velocity is set to zero.

• Normal: The normal edit field takes the components of the outward unit normal to 
the boundary.

• Mean flow speed of sound: In the cs edit field you can set the mean flow speed of 
sound. The default setting is 343 m/s, the speed of sound in air.

• Fluid density: In the ρ edit field you can set the fluid density to a value that matches 
the medium for the acoustic waves in your model. The default value, 1.25 kg/m3, 
applies to air.

NAME DEFAULT UNIT DESCRIPTION

freq 100 Hz Excitation frequency

pref 20e-6 Pa Pressure reference for SPL

ikz -lambda 1/m Imaginary out-of-plane wave number
R  6 :  A E R O A C O U S T I C S



Note: In the 3D case, you must—in addition to specifying values for the above 
properties on the boundary surface where you want to solve Equation 6-5—inactivate 
the application mode on the remaining boundaries of your model geometry. Do this 
by selecting these boundaries in the Boundary selection list and then clearing the Active 

in this domain check box.

Edge Conditions

These are the conditions available on the Coefficients page of the Edge Settings dialog 
box for the edges of the two-dimensional boundary on which Equation 6-5 is to be 
solved:

• Normal mass flow: The natural edge condition for the total wave has the meaning of 
normal mass flow.

• Sound hard boundary (wall): The no-flow or wall condition, known as sound hard, 
sets the normal acceleration—and thus also the normal velocity—to zero at the 
edge:

n– ρ φ∇ V ρ
cs

2
------- iωφ φ∇ V⋅( ) λ φVn+ +( )–

⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅ mn=
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• Sound soft boundary: When the pressure is zero, the edge condition is called sound 
soft.

• Velocity potential: When coupling application modes together it can be necessary to 
set the velocity potential:

Application Mode Variables

2D Axisymmetric Geometries

B O U N D A R Y  S E T T I N G S

In the Boundary Settings dialog box you specify the same properties as in the 3D case. 
In addition to the options available for that case, the boundary condition Axial 

symmetry applies to the symmetry axis r = 0. Note that the eigenvalue equation in the 
2D axisymmetric case also involves the circumferential wave number, m, an integer 
entering the axisymmetric expression for the velocity potential:

You can specify the value of m in the Application Scalar Variables dialog box.

n– ρ φ∇ V ρ
cs

2
------- iωφ φ∇ V⋅( )+( )–

⎝ ⎠
⎜ ⎟
⎛ ⎞

⋅ 0=

φ φ0=

VARIABLE SYMBOL DOMAIN DESCRIPTION EXPRESSION

omega  ω Angular frequency  2π f

vi  vi B Velocity, xi component  ∂ /∂Txi

vnorm  |v| B Velocity norm

p  p B Pressure  −ρ(iω  + ( T  ·VT− ikz Vn ))

Lp B Sound pressure level  10 log10(p·p*/(2pref
2))

nV  Vn B Normal mean velocity  V · n

tVi  (VT)i B Tangential mean velocity,  
xi component

 Vi − Vn ni

φ

v v⋅

φ ∇ φ φ

φ r z ϕ, ,( ) φ r( ) e
i kzz mϕ+( )–

=
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PO I N T  S E T T I N G S

All options listed under “Edge Conditions” on page 127 apply as boundary conditions 
also for 2D axisymmetric geometries. In addition, you can select the option Axial 

symmetry. This is the correct setting for points on the symmetry axis r = 0.

2D Geometries

S U B D O M A I N  S E T T I N G S

In the Subdomain Settings dialog box you can specify the same properties as in the 
Boundary Settings dialog box of the 3D case, except for the normal vector, n, which in 
this case, by definition, is oriented out of the 2D geometry plane.

B O U N D A R Y  S E T T I N G S

All options listed under “Edge Conditions” on page 127 apply. In addition, the option 
Radiation condition is available for 2D geometries.

Point Settings

In the Point Settings dialog box you can specify a mass flow rate m' (measured in kg/
(m·s)). For time-harmonic analysis you supply the amplitude of the flow in the m' edit 
field. For transient analysis you can specify a time-dependent flow.
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Comp r e s s i b l e  Po t e n t i a l  F l ow

This application mode calculates the mean flow assuming an ideal barotropic, 
irrotational fluid and constant entropy.

PDE Formulation

As previously noted, the equations to solve for the velocity potential, Φ, and the fluid 
density, ρ, are:

Here γ is the specific-heat ratio cp/cV and Ψ denotes the force potential, that is, the 
potential energy per unit mass measured in J/kg. In this equation, subscript 0 signifies 
reference quantities that apply at a specific point or surface. Thus, p0 is a reference 
pressure, ρ0 is a reference density, v0 is a reference velocity, and Ψ0 is a reference force 
potential.

Application Mode Properties

In addition to the standard properties for finite-element type and weak constraints, you 
can specify the analysis type in the Application Mode Properties dialog box.

Application Scalar Variables

The application scalar variables are given in the following table.

PROPERTY VALUE DESCRIPTION

Analysis type Static

Transient 

Static analysis 

Transient analysis

NAME SYMBOL DEFAULT UNIT DESCRIPTION

p0  P0 1e5 Pa Reference pressure

rho0  ρ0 1.2 kg/m3 Reference density

t∂
∂Φ Φ∇ 2

2
-------------- γ

γ 1–
-----------

ργ 1– p0

ρ0
γ

------------------- Ψ+ +
⎝ ⎠
⎜ ⎟
⎛ ⎞

+
v0

2

2
-----

γp0
γ 1–( )ρ0

----------------------- Ψ0+ +=

t∂
∂ρ ∇ ρ∇Φ( )⋅+ 0=
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Subdomain Settings

On the Coefficients page of the Subdomain Settings dialog box you can supply values for 
the specific heat ratio, γ, and the force potential, Ψ. By default, γ = 1.4—the value 
appropriate for a diatomic gas—and Ψ = 0.

For transient analysis, the solver needs initial values at t = t0 for the velocity potential, 
Φ, and the fluid density, ρ. These can be constants or functions of the spatial 
coordinates. The default settings are Φ(t0) = 0 and ρ(t0) = ρ0,acpf. You can specify 
different initial conditions on the Init page.

The Init page is available also for static analysis. In this case, you can supply values of 
Φ and ρ to serve as starting values for the solvers.

v0  v0 0 m/s Reference velocity

psi0  Ψ0 0 N Reference energy level

NAME SYMBOL DEFAULT UNIT DESCRIPTION
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Boundary Settings

In the Compressible Potential Flow application mode, you have three boundary 
conditions to choose from in the Boundary Settings dialog box:

• Slip/Symmetry: The natural condition at a boundary impervious to the flow is that 
the velocity normal to the boundary is zero. By multiplying with the density, this 
condition can be alternatively be expressed as a vanishing mass flow through the 
boundary:

Thus, you can also use this condition on boundaries where symmetry implies that 
the flow is tangential to the boundary.

• Normal flow: If the flow is normal to the boundary, the tangential velocity is zero. 
This corresponds to a constant velocity potential along the boundary. Because the 
velocity potential is determined only up to a constant, imposing this condition fixes 
the arbitrary constant to zero:

n ρ∇Φ⋅ 0=

φ 0=
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Note: Setting the Normal flow condition on two or more disjoint boundaries can give 
the wrong physics unless symmetry implies that the velocity potential is equal on the 
boundaries in question.

• Mass flow: The mass flow through a boundary is given by the product of two 
variables: the normal velocity, vn, and the density at the boundary, ρbnd:

You specify a boundary condition of this kind by supplying the values of vn and ρbnd 
in their respective edit fields on the Conditions page. By default, they are set to the 
application scalar variables v0_acpf and rho0_acpf, respectively.

Application Mode Variables

The following variables are available for postprocessing and for use in equations and 
boundary conditions at the subdomain level:

NAME SYMBOL DESCRIPTION EXPRESSION

vxi  vi Velocity in xi direction  ∂ /∂xi

fxi  fi External force, xi component  ρ ∂Ψ/∂xi

c0  c0 Reference speed of sound

n ρ∇Φ⋅ vnρbnd=

φ

γp0 ρ0⁄
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cs  cs Speed of sound

p  p Pressure
 

normv  |v| velocity norm

normf  |f| External force, norm

NAME SYMBOL DESCRIPTION EXPRESSION

γp ρ⁄

p0 ρ ρ0⁄( )γ

v v⋅

f f⋅
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Ae r o a c ou s t i c s  w i t h  F l ow

The application mode Aeroacoustics with Flow is simply a combination of the two 
application modes Aeroacoustics and Compressible Potential Flow with certain 
predefined couplings. Specifically, the background field velocity variables of the 
Aeroacoustics application mode are by default set equal to the flow velocity of the 
Compressible Potential Flow application mode.
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An Examp l e  Mode l—Dopp l e r  S h i f t

Introduction

You can notice the Doppler effect when an ambulance or a fire engine passes by with 
its sirens blaring. The siren’s pitch suddenly drops the moment the ambulance starts 
to move away from you. Another effect you can notice, is how the siren’s sound 
suddenly becomes markedly quieter as soon as the ambulance passes.

In this example, the observer and air are at rest while the sound source, the ambulance, 
moves with the speed V. This gives the same effect as if the sound source were at rest 
and the observer and air were moving at the same speed but in the opposite direction.

Model Definition

This is an axisymmetric problem with a point source at rest at the origin, (r, z) = (0, 0), 
emitting spherical sound waves with the frequency f = 100 Hz. The surrounding air 
moves at V = 33 m/s (roughly 120 km/h or 75 miles/hour) in the negative 
z direction. With this setup, the rz-plane is the horizontal plane at the level of the 
source and the observer, and the effects of reflection in the ground are neglected.

Assume, furthermore, that the observer stands 1 m from where the ambulance passes 
by. In the model geometry, this situation amounts to the observer moving with the 
flow along the line r = 1.

The boundary conditions are absorbing because there is no physical boundary around 
the source. Model this using perfectly matched layers.

Results and Discussion

The acoustic wavelength decreases for a wavefront moving in the opposite direction of 
the airflow. This situation corresponds to the approach stage of the ambulance, which, 
for the stationary observer on the ground, implies a perceived frequency that is higher 
than the nominal source frequency, f. Conversely, the wavelength increases and the 
perceived frequency decreases when the acoustic wave moves with the flow during the 
departing stage. These two stages correspond, respectively, to the left and right halves 
of Figure 6-1, in which the horizontal-axis coordinate is chosen to correspond to time.
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Figure 6-1: The pressure distribution along the observer’s path.

A careful inspection of Figure 6-1 also shows that the amplitude drops off at a faster 
rate to the right of the center than to the left. This effect is more clearly visible in 
Figure 6-2 and Figure 6-3, which both show the sound pressure level.

Figure 6-2: Sound pressure level around the point source.
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Figure 6-3: Sound pressure level at the observer’s position during the ambulance’s 
approach (solid, blue line) and departing (dashed, red line) vs. distance from the position 
( r, z ) = ( 1 m, 0 )(where the observer-ambulance distance is the smallest).

Model Library path: Acoustics Module/Tutorial Models/doppler_shift

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Start COMSOL Multiphysics.

2 In the Model Navigator, select Axial symmetry (2D) from the Space dimension list.

3 From the list of application modes select 
Acoustics Module>Aeroacoustics>Time-harmonic analysis.

4 Click OK.

O P T I O N S

Constants
1 From the Options menu, select Constants.

2 Define a constant according to the following table (the description is optional):

NAME EXPRESSION DESCRIPTION

V 33[m/s] Ambulance speed
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3 Click OK.

G E O M E T R Y  M O D E L I N G

1 Select Draw>Specify Objects>Circle. In the resulting dialog box, set the Radius to 10. 
When done, click OK.

2 Draw a new circle with a Radius of 12. When done, click OK

3 Select Draw>Specify Objects>Rectangle. In the dialog box that appears, specify the 
following values. When done, click OK

4 Copy the rectangle by pressing Ctrl+C.

5 Select the rectangle and one of the circles. Click the Intersection button on the Draw 
toolbar.

6 Paste the copy of the rectangle with no displacement.

7 Select the rectangle and the other circle. Click the Intersection button.

8 Click the Line button on the Draw toolbar. Draw a line from r = 0, z = 0 to r = 12, 
z = 0.

9 Select Draw>Specify Objects>Circle. Set the Radius to 10, then click OK.

10 Draw a rectangle with the following properties:

PROPERTY VALUE

Width 12

Height 24

Position, z -12

PROPERTY VALUE

Width 9

Height 20

Position, r 1

Position, z -10
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11 Select the circle and the rectangle. Click the Intersection button on the Draw menu.

P H Y S I C S  S E T T I N G S

Subdomain Settings
1 From the Physics menu, open the Subdomain Settings dialog box. 

2 Select all the subdomains, then set V to -V.

3 Select Subdomains 1 and 4 only.

4 On the PML page, set the PML type to Spherical.

5 Select the Absorbing in radial dir. check box.

6 Click OK to accept the default PML parameter values and close the dialog box.

Boundary Conditions
1 From the Physics menu, open the Boundary Settings dialog box.

2 Select Boundaries 1–3 and 5. Set the Boundary condition to Axial symmetry.

For the boundaries at r = 12 m, you can leave the default (sound-hard wall) 
boundary condition because the resulting reflected waves are effectively completely 
attenuated before reaching the physical modeling domain.

3 Click OK.

Point Settings
1 From the Physics menu, open the Point Settings dialog box.

2 Click the Point at r=0 option button.

3 Select Point 3 and set the Mass flow rate to 1e-4. Click OK.
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G E N E R A T I N G  T H E  M E S H

To resolve the waves you need at least 10 measurement points per wavelength. Because 
this model uses 2nd-order elements, you need roughly 5 elements per wavelength. A 
wavelength of approximately 3.4 m requires mesh elements that are smaller than 
0.6 m. Further, in the part of the geometry where the acoustic waves move against the 
flow, the mesh elements must be even smaller.

1 Open the Free Mesh Parameters dialog box from the Mesh menu.

2 Click the Subdomain tab.

3 Select Subdomains 1, 2, and 5, then set the Maximum element size to 0.6.

4 Select Subdomains 3, 4, and 6, then set the Maximum element size to 0.3.

5 Click the Remesh button, then click OK.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G

The solution in the PML domain is not of interest, so before plotting the results 
suppress these subdomains.

1 From the Options menu, select Supress>Supress Subdomain.

2 Select Subdomains 1 and 4, then click OK.

3 Click the Zoom Extents button on the Main toolbar.

First generate Figure 6-2 with the following steps.

1 Click the Plot Parameters button on the Main toolbar.

2 On the Surface page, from the Predefined quantities list on the Surface Data page, 
select Sound pressure level.

3 On the Contour page, select the Contour plot check box.

4 From the Predefined quantities list, select Sound pressure level.

5 Clear the Color scale check box.

6 Click OK to generate the plot and close the Plot Parameters dialog box.

Note how the contours preserve their shape when reaching the PML subdomain, 
showing that the PMLs provide an efficient nonreflecting boundary condition.

To generate Figure 6-1 and Figure 6-3 perform the following steps.

1 From the Postprocessing menu, open the Domain Plot Parameters dialog box.
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2 On the Line/Extrusion page, select Pressure from the Predefined quantities list in the 
y-axis data area.

3 From the Boundary selection list, select Boundaries 6 and 7.

4 In the x-axis data area, click the lower option button, then click the Expression 
button.

5 In the dialog box that appears type 10-z in the Expression edit field. Click OK.

6 Click Apply to generate the plot in Figure 6-1.

7 Change the Expression in the y-axis data area to Sound pressure level.

8 From the Boundary selection list, select Boundary 7 only.

9 Click the Expression button in the x-axis data area. In the Expression edit field, type 
abs(z), then click OK to close the X-Axis Data dialog box.

10 Click Apply to generate the solid line in Figure 6-3.

11 On the General page, select the Keep current plot check box, then return to the Line/

Extrusion page.

12 From the Boundary selection list, select Boundary 6.

13 Click the Line Settings button. From the Line color list, select Color, and from the 
Line style list, select Dashed line. Click OK to close the Line Settings dialog box.

14 Click OK to complete Figure 6-3 and close the Domain Plot Parameters dialog box.

To create the figure that shows when you open the model, perform these steps:

1 Click the Plot Parameters button on the Main toolbar.

2 Click the Surface tab.

3 On the Surface Data page, select Pressure from the Predefined quantities list.

4 Click the Range button. Clear the Auto check box, then set Min to -0.03 and Max to 
0.03. Click OK. These settings gives a better use of the color scale in the main part 
of the model domain.

5 On the Height Data page, select the Height data check box and select Pressure from 
the Predefined quantities list.

6 On the General page, clear the Contour check box in the Plot type area.

7 Click OK to generate the plot and close the Plot Parameters dialog box.

8 Click the Scene Light button on the Camera toolbar and rotate the figure to any 
desired position.
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S t r u c t u r a l  M e c h a n i c s  A p p l i c a t i o n  M o d e s  
This chapter describes the three structural-mechanics application modes that are 
included in the Acoustics Module in order to simplify modeling of 
acoustics-structure interaction:

• Solid, Stress-Strain (3D)

• Plane Strain

• Axial Symmetry, Stress-Strain

The analysis types available for these application modes are Static, Eigenfrequency, 
Damped eigenfrequency, Transient, and Frequency response.

The chapter begins with a brief theory review introducing the underlying concepts 
and equations.
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Th eo r y  Ba c k g r ound

Strain-Displacement Relationship

Under the assumption of small displacements, the normal strain components and the 
shear strain components are related to the deformation as follows:

To express the shear strain, use either the tensor form, εxy, εyz, εxz, or the engineering 
form, γxy, γyz, γxz. 

The symmetric strain tensor ε consists of both normal and shear strain components:

Stress-Strain Relationship

The symmetric stress tensor σ describes stress in a material:

This tensor consists of three normal stresses (σx, σy, σz) and six shear stresses—or, if 
symmetry is used, three: (τxy, τyz, τxz).

L I N E A R  E L A S T I C  M A T E R I A L

The stress-strain relationship—or the constitutive equation—for linear conditions 
reads:

εx x∂
∂u

=

εy y∂
∂v

=

εz z∂
∂w

=

εxy
γxy
2

-------=
1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞=

εyz
γyz

2
-------=

1
2
---

z∂
∂v

y∂
∂w

+⎝ ⎠
⎛ ⎞=

εxz
γxz

2
-------=

1
2
---

z∂
∂u

x∂
∂w

+⎝ ⎠
⎛ ⎞ .=

ε
εx εxy εxz

εxy εy εyz

εxz εyz εz

=

σ
σx τxy τxz

τyx σy τyz

τzx τzy σz

= τxy τyx= τxz τzx= τyz τzy=
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where D is the 6-by-6 elasticity matrix, and the stress and the strain are both given in 
column vector form:

Note: In the following descriptions, σ and ε denote either the stress and strain vectors 
or the corresponding tensors depending on the circumstances.

The elasticity matrix D—or its more basic inverse, the flexibility (compliance) matrix is 
defined by

where E is the modulus of elasticity or Young’s modulus, and ν is Poisson’s ratio, 
which defines the contraction in the perpendicular direction. Inverting D−1 results in 
the elasticity matrix

σ Dε=

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

=

D 1– 1
E
----

1 ν– ν– 0 0 0
ν– 1 ν– 0 0 0
ν– ν– 1 0 0 0

0 0 0 2 1 ν+( ) 0 0
0 0 0 0 2 1 ν+( ) 0
0 0 0 0 0 2 1 ν+( )

=
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Implementation

COMSOL Multiphysics’ implementation of the equations in the application modes for 
structural analysis is based on the principle of virtual work expressed in stress and strain 
components.

The total stored energy, W, for a linear material from external and internal strains and 
loads equals

The principle of virtual works states that, for any virtual displacement, the total work 
from internal strains is the negative of the work from external loads, so that their sum 
equals zero:

To derive the expression for the variation of W, differentiate symbolically to obtain the 
expression

D E
1 ν+( ) 1 2ν–( )

---------------------------------------

1 ν– ν ν 0 0 0
ν 1 ν– ν 0 0 0
ν ν 1 ν– 0 0 0

0 0 0 1 2ν–
2

---------------- 0 0

0 0 0 0 1 2ν–
2

---------------- 0

0 0 0 0 0 1 2ν–
2

----------------

=

W 1
2
--- ε– xσx εy– σy εz– σz 2εxy– τxy 2εyzτyz– 2εxz– τxz( ) utFV+⎝ ⎠
⎛ ⎞ vd

V
∫=

utFS s utFL l U
p
∑

t
FP+d

L
∫+d

S
∫+

δW 0=

δW ε–( xtestσx εytest– σy εztest– σz 2εxytest– τxy 2εyztestτyz– 2εxztest– τxz

V
∫=

u+ test
t FV ) dv utest

t FS sd
S
∫ utest

t FL ld
L
∫ Utest

t FP+ + +
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S E T T I N G  U P  E Q U A T I O N S  F O R  D I F F E R E N T  A N A L Y S E S

All structural application modes in the Acoustics Module support static, 
eigenfrequency, damped eigenfrequency, transient, and frequency-response parametric 
analyses. Each type solves a different equation or employs a different solver. You 
control this choice with the Analysis type list that appear in the Application Mode 

Properties dialog box for the corresponding application mode.

Static Analysis
COMSOL Multiphysics’ implementation is based on the stress and strain variables. 
The normal and shear strain variables depend on the displacement derivatives 
(described in general 3D terms in the section “Strain-Displacement Relationship” on 
page 144); the normal and shear stress variables depend on the strains (described in 
general 3D terms in the section“Stress-Strain Relationship” on page 144). 

Using the shear and stress variables you can express the principle of virtual work as

Transient Analysis
For transient problems, Newton’s second law

defines the equation of motion with no damping. To include viscous damping, 
COMSOL Multiphysics uses Rayleigh’s model; see page 149 for further details.

Frequency Response Analysis
You specify harmonic loads with three components:

• the amplitude value, Fx

• the amplitude factor, FxAmp (a dimensionless factor; the default value is 1)

• the phase, FxPh

To derive the equations for the steady-state response from harmonic excitation loads

δW ε– xtestσx εytest– σy εztest– σz

2εxytest– τxy 2εyztestτyz– 2εxztest– τxz utest
t FV+

(

) v

utest
t FS sd

S
∫ utest

t FL ld
L
∫ Utest

t

p
∑ FP+ + +

d

V
∫

0

=

=

ρ∂2u

∂t2
---------- ∇– c u∇⋅ F=
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assume a harmonic response with the same angular frequency as the excitation load:

You can also describe this relationship using complex notation

where

In addition to Rayleigh damping, COMSOL Multiphysics supports loss factor 
damping for frequency response analysis; see page 150 for further details.

Fxfreq FxFxAmp f( ) ωt FxPh f( ) π
180
----------+⎝ ⎠

⎛ ⎞

Ffreq

Fxfreq

Fyfreq

Fzfreq

,=

cos⋅=

u uamp ωt φu+( )

u
u
v
w

=

cos=

u Re uampe
jφuejωt( ) Re ũe

jωt
( )  where ũ uampe

jφu= = =

u Re ũe
jωt

( )=

Fxfreq Re FxFxAmp ω( )e
jFxPh f( ) π

180
----------

ejωt

⎝ ⎠
⎜ ⎟
⎛ ⎞

Re Fx
˜ ejωt( )= =

Fx
˜ FxFxAmp f( )e

jFxPh f( ) π
180
----------

=

F
˜

Fx
˜

Fy
˜

Fz
˜

=
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Eigenfrequency Analysis
The eigenfrequency equations are derived by assuming a harmonic displacement field, 
similar as for the frequency-response formulation. The difference is that you introduce 
a new variable jω explicitly expressed in the eigenvalue.

The eigenfrequency, f is then derived from jω as

.

In the eigenfrequency analysis no damping is added to the equations.

Damped Eigenfrequency Analysis
This analysis is similar to the eigenfrequency analysis except that viscous damping 
terms are added to the equation using the Rayleigh damping model. In addition to the 
eigenfrequency you can study the quality factor, Q, and the decay factor, δ, of a model:

 

D A M P I N G  M O D E L S

The structural mechanics application modes that come with the Acoustics Module 
offer two predefined damping models: Rayleigh damping and loss factor damping.

Rayleigh Damping
To model viscous damping, COMSOL Multiphysics uses Rayleigh damping, where 
you specify two damping coefficients. As an example, consider a system with a single 
degree of freedom. The equation of motion for such a system with viscous damping is

.

In the Rayleigh damping model you express the damping parameter ξ in terms of the 
mass m and the stiffness k as

.

The Rayleigh damping proportional to mass and stiffness is added to the static weak 
term.

jω λ–=

f Im jω( )
2π

-------------------=

Q Im λ( )
2Re λ( )
-------------------= δ Re λ( )=

md2u

dt2
---------- ξdu

dt
------- ku+ + f t( )=

ξ αdMm βdKk+=
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A complication with the Rayleigh damping model is to obtain good values for the 
damping parameters. A more physical damping measure is the damping ratio, the ratio 
between actual and critical damping, often expressed as a damping factor in percentage 
of the critical damping. You can find commonly used values of damping factors in the 
literature.

It is possible to transform damping factors to Rayleigh damping parameters. The 
damping factor, ξ, for a specified pairs of Rayleigh parameters, αdM and βdK, at a 
frequency, f, is

.

Using this relationship at two frequencies, f1 and f2, with different damping factors, ξ1 
and ξ2, results in an equation system that can be solved for αdM and βdK:

.

Using the same damping factors, ξ1 = ξ2, does not result in a constant damping factor 
inside the interval f1 < f < f2. It can be shown that the damping factor is lower inside 
the interval, as the following figure shows.

Loss Factor Damping
Loss factor damping (sometimes referred to as material or structural damping) applies 
to viscoelastic materials modeled in the frequency domain. The complex modulus 

ξ 1
2
---

αdM

2πf
----------- βdK2πf+⎝ ⎠
⎛ ⎞=

1
4πf1
------------ πf1

1
4πf2
------------ πf2

αdM

βdK

ξ1

ξ2

=

D
am

pi
ng

 fa
ct

or

f

Rayleigh damping

Specified damping

f2f1
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G*(ω) is the frequency-domain representation of the stress relaxation function of a 
viscoelastic material. It is defined as

where G' is the storage modulus, G'' is the loss modulus, and their ratio η = G' / G'' is 
the loss factor. The term G' defines the amount of stored energy for the applied strain, 
whereas G'' defines the amount of energy dissipated as heat. Both G' and G'' (and thus 
also η) can be frequency dependent.

In COMSOL Multiphysics, the loss information appears as a multiplier of the total 
strain in the stress-strain relationship:

.

For hyperelastic materials, the loss information appears as a multiplier in the first 
Piola-Kirchhoff stress, P:

G∗ G′ jG″+ 1 jη+( )G′= =

σ D 1 jη+( )ε εth– ε0–( ) σ0+=

P 1 jη+( )
Whyp∂
∇u∂

-----------------=
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App l i c a t i o n  Mode Ov e r v i ew

The following table lists the structural-mechanics application modes available in the 
Acoustics Module. For a detailed description of any of them, refer to the 
corresponding section on the page listed in the table.

The column for the dependent variables shows the field variables that formulate the 
PDEs or weak-form equations. Depending on the engineering assumptions, these 
variables might be a subset of the displacements u, v, and w. For axisymmetric 
simulations, COMSOL Multiphysics uses a variable transformation to avoid a 
singularity at the axis.

For each application mode the table indicates the availability of various analysis 
capabilities.

Finally the table lists the domains where you can specify application mode data such as 
material properties, loads, and constraints. Note that edges exist only in 3D 
geometries.

APPLICATION MODE PAGE ANALYSIS 
CAPABILITIES

DOMAINS

D
E

F
A

U
L

T
 N

A
M

E

D
E

S
C

R
IP

T
IO

N

D
E

P
E

N
D

E
N

T
 V

A
R

IA
B

L
E

S

S
T

A
T

IC

E
IG

E
N

F
R

E
Q

U
E

N
C

Y

T
R

A
N

S
IE

N
T

F
R

E
Q

U
E

N
C

Y
 R

E
S

P
O

N
S

E

P
O

IN
T

E
D

G
E

B
O

U
N

D
A

RY

S
U

B
D

O
M

A
IN

Solid, Stress-Strain acsld 174  u, v, w √ √ √ √ √ √ √ √

Plane Strain acpn 177  u, v √ √ √ √ √ √ √

Axial Symmetry,  
Stress-Strain

acaxi 181  uor, v √ √ √ √ √ √ √
R  7 :  S T R U C T U R A L  M E C H A N I C S  A P P L I C A T I O N  M O D E S



Common App l i c a t i o n  Mode Fe a t u r e s

This section describes the most important modeling steps and functionality common 
to all structural-mechanics application modes in the Acoustics Module.

It contains the following subsections:

• Coordinate Systems

• Application mode properties

• Scalar variables

• Material

• Constraints

• Loads

• Damping

• Perfectly matched layers (PMLs)

Coordinate Systems

Using different coordinate systems can be convenient when specifying loads, 
constraints, and anisotropic materials, and when postprocessing the results. The 
Acoustics Module provides the following coordinate systems:

• A global Cartesian coordinate system, where the geometry is created in 3D (x, y, z).

• A local geometrical coordinate system on 2D boundaries (t, n) and on 3D faces 
(t1, t2, n).

• User-defined coordinate systems.

To specify which coordinate system to use in a particular context, select it from the 
Coordinate system list on the Constraint or Load page.

T H E  G L O B A L  C O O R D I N A T E  S Y S T E M

You can use the global coordinate system in all application modes to specify loads and 
constraints on all domain levels: points, edges, faces, and subdomains. It is the default 
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setting for loads and constraints in all application modes on all domain levels. The 
default names for the space coordinates are the following for the different geometries:

It is possible to change the names of the space coordinates when creating a geometry 
from the Model navigator, see “Creating Cartesian and Cylindrical Coordinate 
Systems” on page 27 in COMSOL Multiphysics User’s Guide for details.

L O C A L  G E O M E T R I C A L  C O O R D I N A T E  S Y S T E M S

Boundaries in 2D and 3D have geometric variables describing the parametrization of 
the geometry defined on them. These variables contain directions that define a local 
coordinate system that you can use when specifying loads and constraints.

In 2D, the local geometrical coordinate system (t, n) represents the directions 
tangential and normal to the boundary. For interior boundaries and free edges this 
coordinate system is right-oriented. For exterior boundaries the normal is always 
directed out from the domain.

In 3D, the local geometrical coordinate system (t1, t2, n) represents two tangential 
directions and one normal direction. t1 and t2 depend on the parametrization of the 
geometry. For interior boundaries and free faces this coordinate system is 
right-oriented but not always orthogonal. For exterior boundaries the normal is always 
directed out from the domain. Common applications for this coordinate system 
include specifying pressure or normal displacement on a surface.

Note: t1 and t2 depend on how the geometry was created and are usually 
perpendicular to each other.

Read more about this topic in “Geometric Variables” on page 165 in the COMSOL 
Multiphysics User’s Guide.

U S E R - D E F I N E D  C O O R D I N A T E  S Y S T E M S

User-defined coordinate systems can be applied at all domain levels in all application 
modes. For the continuum application modes, they can define orthotropic and 

GEOMETRY DEFAULT NAME OF SPACE COORDINATES

2D  x y z

3D  x y z

Axial symmetry (2D)  r zϕ
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anisotropic material properties in a coordinate system other than the global Cartesian 
system.

Create a user-defined coordinate system by choosing Options>Coordinate Systems, 
thereby opening the Coordinate Systems Settings dialog box. Depending on the active 
geometry, the software creates a 2D or 3D coordinate system.

2D Geometry

The New button opens the New Coordinate System dialog box.

In the Copy from list you select from which existing coordinate system you want to copy 
the coordinate-system settings.

In the Name edit field you enter the name of the coordinate system, and it is the name 
that appears in all coordinate-system lists.

The software creates a coordinate system in one of three ways, which you control with 
option buttons:

• Rotate x-axis: The local xl-axis direction is specified by an angle (α) between the 
global and local x-axes.

xl

xg

ygyl

α

C O M M O N  A P P L I C A T I O N  M O D E  F E A T U R E S  |  155



156 |  C H A P T E
• x-axis direction vector: The local xl-axis direction is specified by a direction vector v.

• Cylindrical coordinate system: A local cylindrical coordinate system (xl, yl) with 
origin at (x0, y0) is specified.

3D Geometry

The New button works in the same way as for the 2D geometry case.

xl

xg

ygyl

v

xg

yg

(x0, y0)

xl

yl
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The software defines the coordinate system in one of two ways, which you control with 
the Define using work plane and Define using global coordinates option buttons.

Define using work plane is enabled when a least one work plane/2D geometry exists. 
Select the work plane on which to base the local coordinate system from the Work plane 
list.

Four options are available, which you control with option buttons:

•  Use work plane coordinate system: The local coordinate system is the same as the 
work plane. You control the definition of the work plane by going to the Draw menu 
and opening the Work-Plane Settings dialog box. Get details about the creation of 
work planes in “Creating and Using 2D Work Planes” on page 59 in the COMSOL 
Multiphysics User’s Guide.

•  Rotate x-axis The local xl-axis direction is specified by an angle (α) between the work 
planes xwp-axis and the local xl-axis.

xl

xwp

ywpyl

α
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•  x-axis direction vector: The local xl-axis direction is specified by a direction vector v.

•  Cylindrical coordinate system: A local cylindrical coordinate system (xl, yl) with 
origin at (x0, y0) in the work plane coordinates is specified.

xl

xwp

ywpyl

v

xwp

ywp

(x0, y0)

xl

yl
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When you select Define using global coordinates, there are two different options 
available, which you control with option buttons:

•  Direction method: The local xl-axis direction is specified by a direction vector vaxi. 
The local xlyl-plane is specified by a direction vector vplane, which is a vector in the 
local xlyl-plane.

•  Rotation angle method: The local coordinate system (xl, yl, zl) is specified by three 
consecutive rotation angles θx, θy', and θz''.

xl

xg

yg yl

vaxi

zg

vplane
zl
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x'xg

yg

zg

y'

θx

θx

z'

x'

y'

θy'

z'
z''

θy'

x''

y''

θz''

zl z''

θz''

x''

rotate around xg then around rotated y'

then around doubly rotated z''

yl

y''

xl
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Properties

To set or examine application mode properties go to the Physics>Properties menu to 
open the Application Mode Properties dialog box. Here you control various global 
settings for the model:

Application Mode Properties dialog box for the structural mechanics application modes.

• Default element type: The selected finite element type that makes up the discretized 
finite element model is the default on all new subdomains, and the choice does not 
affect subdomains already created. Available elements are:

-  Lagrange - Linear

-  Lagrange - Quadratic

-  Lagrange - Cubic

-  Lagrange - Quartic

-  Lagrange - Quintic

• Analysis type: This list shows the various analyses you can perform; the default is 
Frequency response. Your choice affects both the equations and which solver 
COMSOL Multiphysics uses when you set the Auto select solver option in the Solver 

Parameters dialog box.

• Specify eigenvalues using: This list controls how to work with eigenmode analyses. 
Here you should specify Eigenvalue or Eigenfrequency; this property is enabled only 
for eigenfrequency analyses.

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenvalue

Damped eigenfrequency Eigenvalue

Time dependent (Transient) Time dependent

Frequency response Parametric
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• Eigenfrequency; this property is enabled only for eigenfrequency and damped 
eigenfrequency analyses.

• Weak constraints: This list controls how to handle weak constraints; available options 
are On and Off. Select weak constraints for accurate computation of reaction forces. 
When you enable weak constraints, all constraints are of that type by default, but 
you can change this setting for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are two scalar variables:

• The excitation frequency, freq—applicable only to frequency-response analysis.

• The complex angular frequency, jomega—applicable only to eigenfrequency 
analysis.You normally do not need to edit the complex angular frequency.

The Application Scalar Variables dialog box in a frequency-response analysis.

When you select Frequency response analysis, the parametric solver becomes the default 
solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case select the menu item Solve>Solver Parameters, 
and in the dialog box that appears go to the General page. In the Parameter area enter 
freq_acsld as the Parameter name. Any values you enter in the Parameter values field 
overrides the excitation frequency you might have entered in the Application Scalar 

Variables dialog box.

To access the excitation frequency, f, use the variable freq; to access the angular 
excitation frequency ω use omega.
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Material

You define material properties on the Material page in the Subdomain Settings dialog 
box.

Material properties.

Now examine the various material properties in Table 7-1.

Young’s modulus It defines a material’s modulus of elasticity, E. For an isotropic 
material it is the spring stiffness in Hooke’s law, which in 1D form is

where σ is the stress and ε is the strain. An orthotropic material uses one value of 
Young’s modulus for each direction, Ei as defined on page 144.

Poisson’s ratio   Denoted by ν, it defines the normal strain in the perpendicular 
direction, generated from a normal strain in the other direction and following the 
equation

.

TABLE 7-1:  MATERIAL PROPERTIES

PARAMETER VARIABLE DESCRIPTION

 E E Young's modulus 

 ν nu Poisson's ratio 

 ρ rho Density

σ Eε=

ε⊥ υεl l–=
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Density   This entry specifies ρ, the material’s density. 

Constraints

A constraint specifies the displacement of certain parts of a structure. You can define 
constraints on all domain levels: points, edges, faces/boundaries, and subdomains in 
3D; as well as points, boundaries, and subdomains in 2D. To control a constraint, go 
to the Constraint page of the Subdomain Settings, Boundary Settings, Edge Settings, and 
Point Settings dialog boxes that you open from the Physics menu. The following figure 
shows the Boundary Settings dialog box for the Solid, Stress-Strain application mode, 
but the Constraints settings area has the same appearance in all structural mechanics 
application modes.

An example of a Constraint page, taken here from the Solid, Stress-Strain application 
mode Boundary Settings dialog box.

Within the dialog box, the Constraint condition list lets you control which type of 
constraint you want to define. You can choose between the following options:

CONSTRAINT CONDITION BOUNDARY SUBDOMAIN USE WHEN

Free √ √ The domain has no constraint

Fixed √ √ The displacement in the domain is fixed
in all directions

Roller √ The normal displacement is constrained

Prescribed displacement √ √ The displacement in any direction need
to be prescribed
R  7 :  S T R U C T U R A L  M E C H A N I C S  A P P L I C A T I O N  M O D E S



 

The symmetry or antisymmetry condition has the following interpretation.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system (available only on boundaries)

• User-defined coordinate systems if any local coordinate systems are defined.

Symmetry plane √ The boundary is a symmetry plane

xy symmetry plane √ The selected coordinate system’s 
xy-plane is a symmetry plane

yz symmetry plane √ The selected coordinate system’s 
yz-plane is a symmetry plane

xz symmetry plane √ The selected coordinate system’s 
xz-plane is a symmetry plane

Antisymmetry plane √ The boundary is an antisymmetry plane

xy antisymmetry plane √ The selected coordinate system’s 
xy-plane is an antisymmetry plane

yz antisymmetry plane √ The selected coordinate system’s 
yz-plane is an antisymmetry plane

xz antisymmetry plane √ The selected coordinate system’s 
xz-plane is an antisymmetry plane

Prescribed velocity √ √ The velocity in any direction need to be
prescribed, available only for 
frequency-response analysis

Prescribed acceleration √ √ The acceleration in any direction need 
to be prescribed, available only for 
frequency-response analysis

CONSTRAINT CONDITION BOUNDARY SUBDOMAIN USE WHEN

CONDITION X-DISPLACEMENT Y-DISPLACEMENT Z-DISPLACEMENT

xy symmetry plane √

yz symmetry plane √

xz symmetry plane √

xy antisymmetry plane √ √

yz antisymmetry plane √ √

xz antisymmetry plane √ √
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When you select Prescribed displacement, a number of new options appear in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation (select this option by clicking the Standard notation button) 
you constrain each displacement direction independently. The check boxes adjacent 
to the Rx, Ry, and Rz edit fields activate the constraint, whereupon you enter the 
value/expression of the displacement (the default value is 0).

• General notation (select this option by clicking the General notation, Hu=R button) 
lets you specify constraints as any linear combination of displacements components. 
For instance, in the 2D case, use the relationship

.

Enter values for the H matrix and R vector in corresponding dialog boxes by 
clicking the respective Edit buttons. For example, to enforce the condition u = v, use 
the settings

H u
v

R=
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,

which force the domain to move only diagonally in the xy-plane.

The H Matrix dialog box for the example in the text.

In a frequency-response analysis you can specify not only a harmonic displacement but 
also a harmonic velocity or acceleration. You specify a prescribed velocity or 
acceleration in the same way as Prescribed displacement using Standard notation by first 
selecting Prescribed velocity or Prescribed acceleration in the Constraint condition list.

Constraint page showing the Prescribed acceleration settings.

Loads

“Load” is a general term for a force applied to a structure. In the structural application 
modes in the Acoustics Module you can specify loads on all domain types using the 

H 1 1–

0 0
,= R 0

0
=
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N

me (N/m3) 
rea (N/m2)

me (N/m3)

me (N/m3)
Load page that appears in the Subdomain Settings, Boundary Settings, Edge Settings, and 
Point Settings dialog boxes under the Physics menu.

The Boundary Settings dialog box for the Plane Strain application mode shown here is 
representative of load pages for all domain levels in all structural mechanics application 
modes.

For plane strain, two option buttons allow you to choose how to specify the load using 
the thickness. The following table shows how to define the loads on different domains 
in different application modes; the entries give the SI unit in parenthesis.

Within the dialog box, the Coordinate system list lets you control in which coordinate 
system you want to define the load. Available options are:

• Global coordinate system

• Tangent and normal coordinate system (available only on boundaries)

• User-defined coordinate systems, if any local coordinate systems are defined

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMAI

Plane Strain force (N) force/area (N/m2) or 
force/length (N/m)

force/volu
or force/a

Axisymmetry, 
Stress-Strain

total force along the 
circumferential (N)

force/area (N/m2) force/volu

Solid, 
Stress-Strain

force (N) force/length 
(N/m)

force/area (N/m2) force/volu
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For a frequency-response analysis you have additional input data. To control the 
analysis type use the Application Mode Properties dialog box. When frequency response 
is the analysis type, the Load page takes on this appearance:

The Load page that appears for frequency-response analysis.

For frequency-response analysis the application mode splits the harmonic load into 
three parameters:

• the amplitude value, F 

• the amplitude factor, FAmp (a dimensionless factor; the default value is 1)

• the phase, FPh

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency, f

.

Damping

In transient, eigenfrequency, and frequency-response analyses you can model 
undamped or damped problems. In the structural-mechanics application modes in the 
Acoustics Module you specify damping at the subdomain level using the Damping page 
that appears in the Subdomain Settings dialog box. From the Damping model list you can 

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
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select No damping, Rayleigh, or Loss factor, and the contents of the dialog box changes 
for each of these damping models.

The Damping page when Rayleigh damping is selected.

If you select Rayleigh as your damping model, you can specify the mass damping 
parameter, αdM, and the stiffness damping parameter, βdK. When selecting Loss factor, 
you supply the loss factor, η. For details about the underlying equations, see “Damping 
Models” on page 149.

The two available damping models apply to the following analysis types:

• Rayleigh damping: Damped eigenfrequency, Time dependent, and Frequency response 

• Loss factor damping: Frequency response 

Note: This means that if you choose, for example, time dependent analysis and loss 
factor damping, the software solves the model with no damping.

Table 7-2 and the following text describe the parameters that define damping:

TABLE 7-2:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 η eta Loss factor Loss factor
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Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

Perfectly Matched Layers (PMLs)

In frequency-response analysis of elastic waves, you can use perfectly matched layers to 
simulate absorbing boundary conditions. This section describes how to create 
Cartesian, cylindrical, and spherical PMLs for elastic waves. For an account of elastic 
waves in solids, see Chapters 4 and 5 of Ref. 1. For background information about 
PMLs in elastodynamics, see Ref. 2. The section “Perfectly Matched Layers (PMLs)” 
on page 37 describes PMLs for acoustic pressure waves.

P M L  I M P L E M E N T A T I O N

For a PML that absorbs waves in the coordinate direction ξ, the Structural Mechanics 
Module uses the following coordinate transformation inside the PML:

 (7-1)

The scaled PML width, L; the coordinate of the inner PML boundary, ξ0; and the 
(actual) width of the PML, δξ, are input parameters for each orthogonal absorbing 
coordinate direction.

The scaling exponent, n is an input parameter for each PML subdomain. The default 
value of n is 1, giving a linear scaling that works well in most cases, and the useful range 
is roughly between 1 and 2; increasing the exponent allows you to use fewer mesh 
elements to resolve wavelengths much smaller than the scaled PML width.

Usually, set L equal to one wavelength. The wavelength depends on the type of elastic 
wave you are considering. For example, for longitudinal (acoustic) waves, the 
wavelength is given by (Ref. 1)

where f is the frequency, E is Young’s modulus, ν is Poisson’s ratio and ρ is the density. 
If your analysis includes several wave types of different wavelengths, set L to the 
longest one. For this case, you can also try to set the scaling exponent, n, equal to 2.

ξ' sign ξ ξ0–( ) ξ ξ0–
n L

δξn
--------- 1 i–( )=

λ 1
f
--- 1 ν–( )

1 ν+( ) 1 2ν–( )
---------------------------------------E

ρ
----=
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The parameters ξ0 and δξ get default settings that the software deduces from the drawn 
geometry and stores in so-called guess variables. You can inspect the values of the guess 
variables on the Variables page of the Subdomain Settings - Equation System dialog box 
or at the corresponding node of the Model Tree.

The default settings defined by the guess variables work nicely in most cases, but they 
might fail for PML subdomains of nonstandard shape. 

S E T T I N G  U P  A  P M L

To model an absorbing boundary using PMLs, you need an auxiliary subdomain 
outside the boundary. On the PML page in the Subdomain Settings dialog box, you can 
select different types of PMLs depending on the kind of wave you have:

The PML type None is the default. To add a PML, select one of the other types.

C A R T E S I A N  P M L S

For Cartesian PMLs, you can choose whether use the default global coordinate system 
or a user-defined coordinate system to define the directions. If you want a curved 
coordinate system you must use the cylindrical or spherical PML type.

Select the check box for the directions in which you want the waves to be absorbed. 
For each of these directions, enter the scaled PML width, L in the associated edit field. 
Make sure all material properties are the same in the PML as in the adjacent 
subdomain.

C Y L I N D R I C A L  P M L S

In 2D, a cylindrical PML always absorbs waves in the radial direction. In the other 
dimensions, you can decide how the PML absorbs the wave: in the radial direction, the 
z direction, or both.

Select the directions in which you want the PML to absorb the waves and enter the 
scaled PML widths in those directions. To define a cylindrical PML you also need to 

PML TYPE APPLICATION MODE DESCRIPTION

None all No PML

Cartesian Solid, Stress-Strain; Plane 
Strain

Absorbs waves in the specified Cartesian 
coordinate directions

Cylindrical all Absorbs cylindrical waves

Spherical Solid, Stress-Strain; Axial 
Symmetry, Stress-Strain

Absorbs spherical waves

User defined all Define your own scaled space variables
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enter the center point of the cylindrical coordinates and, in 3D, the cylinder axis 
direction.

S P H E R I C A L  P M L S

A spherical PML always absorbs waves in the radial direction. Enter the scaled PML 
width, L. Define the spherical coordinates by entering the center point.

U S E R - D E F I N E D  P M L S

When using a PML, the algorithm scales the equation in this domain so that instead 
of the coordinates used in the rest of the model, the coordinates PMLx, PMLy, and 
PMLz appear in the equation. If you want to scale the equation in some other way than 
the automatic PML options provide, use a user-defined PML. In this case you enter 
your own User-defined PML coordinates.
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S o l i d ,  S t r e s s - S t r a i n

This section explains how to use the Solid, Stress-Strain application mode in the 
Acoustics Module to analyze 3D solids.

Loads and constraints applied to a 3D solid using the Solid, Stress-Strain application 
mode.

Variables and Space Dimensions

The degrees of freedom (dependent variables) in this application mode are the global 
displacements u, v, and w in the global x, y, and z directions, respectively. If you select 
the mixed formulation, the application mode also includes the pressure p as a 
dependent variable.

Application Mode Parameters

The section “Common Application Mode Features” on page 153 defines the 
parameters you need in modeling loads, materials, and constraints.
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TABLE 7-3:  SOLID

NAME

ui

uit

ui_amp

ui_ph

ui_t

ui_t_amp

ui_t_ph

ui_tt

ui_tt_amp
Application Mode Variables

A large number of variables are available for use in expressions and postprocessing. In 
addition to the variables in Table 7-3, almost all application-mode parameters are 
available as variables. Some variables change their availability with the type of analysis, 
as noted in the Analysis column. For frequency-response analysis a number of 
additional variables are available. Furthermore, the amplitudes and phases of variables 
such as strains and stresses are available; to access them, append _amp or _ph to the 
variable name. For example:

• sx_amp is the amplitude of the normal stress in the x direction.

• ex_ph is the phase of the normal strain in the x direction.

The exception to this scheme consists of variables defined using a nonlinear operator 
such as mises, disp, Tresca, or s1.

Table 7-3 uses a convention where indices i, j, … (or i, j, …) run over the geometry’s 
Cartesian coordinate axes, x, y, and z. In particular, ui (ui) refers to the global 
displacements (u, v, w). The Analysis column uses the following abbreviations:

ANALYSIS ABBREVIATION

Static S

Frequency response F

Time dependent T

 APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui All All xi displacement  ui

uit T All xi velocity  uit

uiamp F All xi displacement 
amplitude

 | ui |

uiph F All xi displacement 
phase

 (180°/ π) mod(angle(ui) , 2π)

uit F All xi velocity  j ω ui

uitamp F All xi velocity amplitude  ω uiamp

uitph F All xi velocity phase mod(uiph + 90°, 360°)

uitt F All xi acceleration  −ω2 ui

uittamp F All xi acceleration 
amplitude

 ω2 | ui |
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ui_tt_ph

disp

ei,eij

ei_t, eij_t

si, sij 

si_t, sij_t

si

ei

sixj

eixj

tresca 1 − σ3 |)

mises

Ws aterial 

Tai rge or 

Fig rce 

TABLE 7-3:  SOLI

NAME
uittph F All xi acceleration phase mod(uiph + 180°, 360°)

disp All All Total displacement

εi, εij All S Strain, global coord. 
system

εit, εijt FT S Velocity strain, global 
coord system

σi, τij All S Cauchy stress, global 
coord. system

σit, τijt FT S Time derivative of 
Cauchy stress, global 
coord. system

σi All S Principal stresses

εi All S Principal strains

σixj All S Principal stress 
directions

εixj All S Principal strain 
directions

σtresca All S Tresca stress  max(max(| σ1 − σ2 |, | σ2 − σ3 |), | σ

σmises All S von Mises stress 

Ws All S Strain energy density Defined differently depending on m
model and mixed or displacement 
formulation

 Tai All B Surface traction 
(force/area) in xi 
direction

Defined differently depending on la
small deformation

Fig All All Body load, face load, 
edge load, point 
load, in global xi 
direction

Defined differently depending on fo
definition

D APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui( )real( )2

i
∑
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P l a n e  S t r a i n

This section explains the Plane Strain application mode in the Acoustics Module; it 
solves for the global displacements (u, v) in the x and y directions and the pressure p 
(only if mixed formulation is used). The assumption that defines a state of plane strain 
is that the εz, εyz, and εxz components of the strain tensor are zero.

A geometry suitable for plane strain analysis.

Loads in the x and y directions are allowed. The loads are assumed to be constant 
throughout the thickness of the material, but the thickness can vary with x and y. The 
plane strain condition prevails in geometries whose extent is large in the z direction 
compared to the x and y directions, or when the z displacement is in some way 
restricted. One example is a long tunnel along the z-axis where it is sufficient to study 
a unit-depth slice in the xy-plane.

Material

An additional material parameter for plane strain is the thickness of the geometry.

PARAMETER VARIABLE DESCRIPTION MATERIAL MODEL

th thickness The thickness of the geometry All 
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TABLE 7-4:  

NAME

ui

uit

u_amp, 
v_amp

ui_ph

ui_t
Application Mode Parameters

The section “Common Application Mode Features” on page 153 defines the 
parameters you need in modeling including loads, the material and constraints.

Application Mode Variables

A large number of variables are available for use in expressions and for postprocessing. 
In addition to the variables in Table 7-4, almost all application mode parameters are 
available as variables. Some variables change their availability with the type of analysis, 
as noted in the Analysis column. For frequency-response analysis a number of 
additional variables are available. Furthermore, the amplitudes and phases of variables 
such as strains and stresses are available; to access them, append _amp or _ph to the 
variable name. For example:

• sx_amp is the amplitude of the normal stress in the x direction.

• ex_ph is the phase of the normal strain in the x direction.

The exception to this scheme consists of variables defined using a nonlinear operator 
such as mises, disp, Tresca, or s1.

Table 7-4 uses a convention where indices i, j, … (or i, j, …) run over the geometry’s 
Cartesian coordinate axes, x and y. In particular, ui (ui) refers to the global 
displacements (u, v). The Analysis column uses the following abbreviations:

ANALYSIS ABBREVIATION

Static S

Frequency response F

Time dependent T

PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui All All xi displacement  ui

uit T All xi velocity  uit

uiamp F All xi displacement 
amplitude

 | ui |

uiph F All xi displacement 
phase

 (180°/ π) mod(angle(ui) , 2π)

uit F All xi velocity  j ω ui
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ui_t_am

ui_t_ph

ui_tt

ui_tt_am

ui_tt_ph

disp

ei, exy

ei_t, exy

eil_t, 
exyl_t

si, sz, sx

sil, sxyl

si_t, sz_
sxy_t

si

ei

sixj

TABLE 7-4:  

NAME
p uitamp F All xi velocity 
amplitude

 ω uiamp

uitph F All xi velocity 
phase

 mod(uiph + 90°, 360°)

uitt F All xi acceleration  −ω2 ui

p uittamp F All xi acceleration 
amplitude

 ω2 | ui |

uittph F All xi acceleration 
phase

 mod(uiph + 180°, 360°)

disp All All Total 
displacement

εi, εxy All S Strain, global 
coord. system

_t εit, εxyt FT S Velocity strain, 
global coord. 
system

εilt, 
εxylt

FT S Velocity strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

y σi, σz, 
τxy

All S Cauchy stress, 
global coord. 
system

σil, τxyl All S Cauchy stress, 
user-defined 
coord. system

t, σit, σz, 
τxyt

FT S Time derivative 
of Cauchy 
stress, global 
coord. system

σi All S Principal 
stresses

εi All S Principal 
strains

σixj All S Principal stress 
directions

PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui( )real( )2

i
∑
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eixj

tresca )

mises

Ws model 

Tai  

Fig  

TABLE 7-4:  

NAME
εixj All S Principal strain 
directions

σtresca All S Tresca stress  max(max(| σ1 − σ2 |, | σ2 − σ3 |), | σ1 − σ3 |

σmises All S von Mises 
stress 

Ws All S Strain energy 
density

Defined differently depending on material 
and if mixed or displacement formulation

Tai All B Surface 
traction (force/
area) in 
xi direction

Defined differently depending on the force
definition

Fig All S Point, edge, 
body load in 
global 
xi direction

Defined differently depending on the force
definition

PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION
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Ax i a l  S ymme t r y ,  S t r e s s - S t r a i n

The Axial Symmetry, Stress-Strain application mode uses cylindrical coordinates r, 
(phi), and z. It solves equations for the global displacement (u, w) in the r and z 

directions and the pressure p (only used for mixed formulation). It assumes that the 
displacement v in the direction together with the , , , and  
components of the stresses and strains are zero. Loads are independent of , and this 
application mode allows loads only in the r and z directions.

You can view the domain where the application mode solves the equations as the 
intersection between the original axially symmetric 3D solid and the half plane , 
r ≥ 0. Therefore you draw the geometry only in the half plane r ≥ 0 and recover the 
original 3D solid by rotating the 2D geometry about the z-axis.

Rotating a 2D geometry to recover a 3D solid.

The equilibrium equations in axial symmetry read

 (7-2)

ϕ

ϕ τrϕ τϕz γrϕ γϕz
ϕ

ϕ 0=

r∂
∂σr

z∂
∂τrz σr σθ–

r
------------------ Fr+ + + 0

r∂
∂τrz

z∂
∂σz τrz

r
------- Fz+ + + 0=

=
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The strain-displacement relationships for the axial symmetry case for small 
displacements are

To avoid division by r in the equilibrium equations, which causes problems on the axis 
where r = 0, you must transform the equations: multiply the first equation by r2 and 
the second by r. This comes in naturally when the principle of virtual work is used, 
integrating over the volume by multiplying the integrand by 2π r. In addition to this 
the application mode also introduces and solves for a new dependent variable

,

which replaces the true radial displacement, u. The reason is to avoid division by r.

Note: r = 0 is the symmetry axis. In the Axisymmetry, Stress-Strain application mode 
 x → r and y →  z.

PDE Formulation

The principle of virtual work for the axial symmetry case reads

A P P L I C A T I O N  M O D E  P A R A M E T E R S

The section “Common Application Mode Features” on page 153 defines the 
parameters you need in modeling including loads, the material and constraints. 

εr r∂
∂u,= εϕ

u
r
---,= εz z∂

∂w, and= γrz z∂
∂u

r∂
∂w

+=

uor u
r
---=

dW r ε– rtestσr εϕtest– σϕ εztestσz 2– εrztest– τrz

r uor⋅ testFr wtestFz+ +

(

) A

r r uor⋅ testFr wtestFz+( ) sd
S
∫ r uor⋅ testFr wtestFz +( ) 2π⁄

+

+

d

A
∫=
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TABLE 7-5:  AXIA

NAME

uor

uaxi

w

uort

uaxi_t

w_t

uaxi_amp

w_amp

uaxi_ph
Application Mode Variables

A large number of variables are available for use in expressions and postprocessing. In 
addition to the variables in Table 7-5, almost all application mode parameters are 
available as variables. Some variables change their availability with the type of analysis, 
as noted in the Analysis column. For frequency-response analysis a number of 
additional variables are available. Furthermore, the amplitudes and phases of variables 
such as strains and stresses are available; to access them, append _amp or _ph to the 
variable name. For example:

• sx_amp is the amplitude of the normal stress in the x direction.

• ex_ph is the phase of the normal strain in the x direction.

The exception to this scheme consists of variables defined using a nonlinear operator 
such as mises, disp, Tresca, or s1.

The Analysis column uses the following abbreviations:

ANALYSIS ABBREVIATION

Static S

Frequency response F

Time dependent T

L SYMMETRY STRESS-STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

uor All All r displacement 
divided by r

uor

uaxi All All r displacement  uor · r

w All All z displacement w

uort T All r velocity 
divided by r

uort

uaxit T All r velocity  uort · r

wt T All z velocity wt

uaxiamp F All r displacement 
amplitude

 | uaxi |

wamp F All z displacement 
amplitude

 | w |

uaxiph F All r displacement 
phase

 (180°/ π) mod(angle(uaxi) , 2π)
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w_ph

uaxi_t

w_t

uaxi_t_amp

w_t_amp

uaxi_t_ph

w_t_ph

uaxi_tt

w_tt

uaxi_tt_amp

w_tt_amp

uaxi_tt_ph

w_tt_ph

disp

er, ez, ephi, e

epr, epz, epp
eprz

er_t, ez_t, 
ephi_t, erz_t

r large 

sr, sphi, sz, sr

TABLE 7-5:  AXIA

NAME
wph F All z displacement 
phase

 (180°/ π) mod(angle(w) , 2π)

uaxit F All r velocity  j ω uaxi

wt F All z velocity  j ω w

uaxitamp F All r velocity 
amplitude

 ω  uaxiamp

wtamp F All z velocity 
amplitude

 ω  wamp

uaxitph F All r velocity phase mod(uaxiph + 90°, 360°)

wtph F All z velocity phase mod(wph + 90°, 360°)

uaxitt F All r acceleration  −ω2  uaxi

wtt F All z acceleration  −ω2  w

uaxitamp F All r acceleration 
amplitude

ω2  uaxiamp

wtamp F All z acceleration 
amplitude

ω2  wamp

uaxitph F All r acceleration 
phase

mod(uaxiph + 180°, 360°)

wtph F All z acceleration 
phase

mod(wph + 180°, 360°)

disp All All Total 
displacement

rz εr, εz, , 
εrz

All S Strain, global 
coord. system

hi, εpr, εpz, 
, εprz

ST S Plastic strain, 
global coord. 
system

εrt, εzt, 
, εrzt

FT S Velocity strain, 
global coord. 
system

Defined differently depending on small o
displacement

z σr, , 
σz, τrz

All S Cauchy stress, 
global coord. 
system

L SYMMETRY STRESS-STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

uaxi2 w2
+

εϕ

εpϕ

εϕt

σϕ
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sr_t, sphi_t, 
sz_t, srz_t

si

ei

sixj

eixj

tresca  |)

mises

Ws l model 

Tar, Taz r large 

Frg, Fzg efinition

TABLE 7-5:  AXIA

NAME
σrt, , 
σzt, σrzt

FT S Time der. of 
Cauchy stress, 
global coord. 
system

σi All S Principal 
stresses

εi All S Principal strains

σixj All S Principal stress 
directions

εixj All S Principal strain 
directions

σtresca All S Tresca stress  max(max(| σ1 − σ2 |, | σ2 − σ3 |), | σ1 − σ3

σmises All S von Mises stress 

Ws All S Strain energy 
density

Defined differently depending on materia
and if mixed or displacement formulation

Tar, Taz All B Surface traction 
(force/area) in r 
and z directions

Defined differently depending on small o
deformation

Frg, Fzg All All Body, edge, 
point load in 
global r and 
z directions

Defined differently depending on force d

L SYMMETRY STRESS-STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

σϕt
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P i e z o e l e c t r i c  A p p l i c a t i o n  M o d e s  
This chapter describes the application modes for modeling piezoelectric effects in 
the Acoustics Module.
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Th eo r y  Ba c k g r ound

The Piezoelectric Effect

The piezoelectric effect manifests itself as a transfer of electric to mechanical energy 
and vice-versa. It is observable in many crystalline materials, while some materials such 
as quartz, Rochelle salt, and lead titanate zirconate ceramics display the phenomenon 
strongly enough for the phenomenon to be of practical use.

The direct  piezoelectric effect consists of an electric polarization in a fixed direction 
when the piezoelectric crystal is deformed. The polarization is proportional to the 
deformation and causes an electric potential difference over the crystal.

The inverse piezoelectric effect, on the other hand, constitutes the opposite of the 
direct effect. This means that an applied potential difference induces a deformation of 
the crystal.

P I E Z O E L E C T R I C  C O N V E N T I O N S

The documentation and the user interface use piezoelectric conventions as far as 
possible. These conventions differ from those used in other structural mechanics 
application modes. For instance, the numbering of the shear components in the 
stress-strain relation differs, as the following section describes. However, the names of 
the stress and strain components remain the same as in the other structural mechanics 
application modes.

Piezoelectric Constitutive Relations

It is possible to express the relation between the stress, strain, electric field, and electric 
displacement field in either a stress-charge or strain-charge form:

S T R E S S - C H A R G E

S T R A I N - C H A R G E

T cES eTE–=

D eS εSE+=

S sET dTE+=

D dT εTE+=
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The naming convention differs in piezoelectric theory compared to structural 
mechanics theory, but the piezoelectric application modes use the structural mechanics 
nomenclature. The strain is named ε instead of S, and the stress is named σ instead of 
T. This makes the names consistent with those used in the other structural mechanics 
application modes.

The numbering of the strain and stress components is also different in piezo and 
structural mechanics theory, and it is quite important to keep track of this aspect in 
order to give the correct material data. In structural mechanics the following is the 
most common numbering convention, and it is also the one used in the other 
structural mechanics application modes:

In contrast, textbooks on piezoelectric effects and the IEEE standard on piezoelectric 
effects use the following numbering convention:

The piezoelectric application modes employ the immediately preceding piezo 
numbering convention to make it easier to work with materials data and avoid 
mistakes.

The constitutive relation using COMSOL Multiphysics symbols for the different 
constitutive forms are thus:

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

εx

εy

εz

2εxy

2εyz

2εxz

= =

σ

σx

σy

σz

τyz

τxz

τxy

= ε

εx

εy

εz

γyz

γxz

γxy

εx

εy

εz

2εyz

2εxz

2εxy

= =
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S T R E S S - C H A R G E

S T R A I N - C H A R G E

Most material data appears in the strain-charge form, and you can easily transform into 
the stress-charge form. COMSOL Multiphysics allows you to use both constitutive 
forms; simply select one, and COMSOL Multiphysics makes any necessary 
transformations. The following equations transform strain-charge material data to 
stress-charge data

Material Models

In addition to modeling piezoelectric materials, the Piezoelectric application mode 
provides different material models for easier modeling of piezo components. This 
means, that in the subdomain settings of the application mode, you can define the 
material of each domain as: 

• Piezoelectric

• Decoupled, isotropic

• Decoupled, anisotropic

The Piezoelectric material operates as described in the chapter above, whereas using 
the two other material models, you can model structural and electrical problems or 
either of them independently.

The structural part of the Decoupled, isotropic and Decoupled, anisotropic material 
operates as the linear elastic material with small deformations as described in 
“Structural Mechanics Application Modes” on page 59“Structural Mechanics 

σ cEε eTE–=

D eε ε0εrSE+=

ε sEσ dTE+=

D dσ ε0εrTE+=

cE sE
1–

=

e d sE
1–

=

εS ε0εrT d sE
1– dT

–=
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Application Modes” on page 143. However, the initial stress and strain and thermal 
expansion are not supported within the Piezoelectric application mode. 

For the Decoupled, isotropic material you define the material using the Young’s 
modulus, E, and the Poisson ratio, ν. For the Decoupled, anisotropic material you 
define the full 6-by-6 elasticity matrix D. Note here, that you define D using the 
standard structural mechanics ordering. Thus the ordering of the D is different from 
the ordering of the piezoelectric cE matrix. 

Depending on the value of the Electrostatics formulation property (See “Electrical 
Formulations”  below), the electrical part of the Decoupled, isotropic and Decoupled, 
anisotropic material solves either the electrostatics equation:

where ε0 is the electrical permittivity of free space, εr is the relative electrical 
permittivity, and ρv is the volume charge density, or the quasi-static electric currents 
equation:

where σe is the electrical conductivity of the material (note that σ is used also for the 
structural stress vector).

In frequency response analysis the conductivity appears also into the electrostatics 
equation:

and thus you can define and use conductivity of the material independently of the 
Electrostatics formulation property.

For a Decoupled, isotropic material you define εr and σe as scalars, but for a Decoupled, 
anisotropic material you define them as 3-by-3 matrices.

Electrical Formulations

The default formulation of the equations in the Piezoelectric application modes is such 
that the resulting equation system with piezoelectric material is symmetric. This allows 
reduced memory requirements with solvers that utilize symmetry information. 

∇ ε0εr∇V( )⋅– ρv=

∇ σe jωε0+ εr( )∇V( )⋅– 0=

∇
σe

jω
------ ε+

0
εr⎝ ⎠

⎛ ⎞∇V⎝ ⎠
⎛ ⎞⋅– ρv=
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The drawback of this design is that by default the Piezoelectric application modes are 
not electrically compatible with the Electrostatics application mode found in the  
AC/DC Module and the MEMS Module, nor is it compatible with the Quasi-Statics 
-Electric, Electric currents application modes in the AC/DC Module.

The Piezoelectric application modes support an application mode property, 
Electrostatics formulation, which makes them compatible with the electrostatic or 
quasi-static application modes so that it is possible to couple them in a model. The 
Electrostatics formulation property has the following choices: 

• Symmetric, Electrostatics: The default implementation creates a symmetric equation 
system, but the application mode is not compatible with the other application 
modes.

• Unsymmetric, Electrostatics: This implementation creates an unsymmetric equation 
system which is compatible with the Electrostatics application modes.

• Unsymmetric, Electric currents: This implementation creates an unsymmetric 
equation system which is compatible with the Quasistatics - Electric, Electric 
currents application modes.

At the equation level the difference between these formulation is the following. The 
default formulation is that the variational electrical energy is written using a positive 
sign:

Here D is the electric displacement vector, and  is the test function for the Electric 
field. Ω is the integration domain.

On the other hand, the formulation compatible with the Electrostatics application 
mode uses variational electrical energy with the negative sign: 

Finally, the electric currents formulation uses the following variational electrical 
energy: 

where J is the electric current density vector, and  is the test function for the 
potential gradient.

δWe D E
ˆ

⋅( ) Ωd∫=

E
ˆ

δWe D E
ˆ

⋅( ) Ωd∫–=

δWe J ∇V̂⋅( ) Ωd∫=

∇V̂
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The use of the Unsymmetric, electric currents formulation sets certain limitations: you 
cannot model any charges, and any boundary conditions that use charges or electric 
displacement are written in terms of electric current. Also, this formulation only 
appears in the frequency response analysis.
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Th e  P i e z o e l e c t r i c  App l i c a t i o n  Mode s

This section describes the interface for defining a model using the piezoelectric 
application modes:

• Piezo Solid (in 3D)

• Piezo Plane Strain (in 2D)

• Piezo Axial Symmetry (in axisymmetric 2D)

It consists of the following sections:

• “Application Mode Properties” (the next section)

• “Scalar Variables” on page 195

• “Material Properties” on page 196

• “Electric Boundary Conditions” on page 206

• “Constraints” on page 210

• “Loads and Charges” on page 212

• “Structural Damping” on page 214

Application Mode Properties

To set or examine material properties, go to the Physics menu and open the Application 

Mode Properties dialog box.

Here you control various global settings for the model, which include:

• Default element type: A list of elements, where the selection becomes the default on 
all new subdomains. The default is to use second-order Lagrange elements.

• Analysis type: A list of analyses to perform. It affects both the equations and which 
solver to use with the Auto select solver option in the Solver Parameters dialog box. 
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The default is static analysis. You can also select transient, eigenfrequency, damped 
eigenfrequency, and frequency response analysis types.

• Specify eigenvalues using: A list controlling whether the application mode works with 
eigenvalues or eigenfrequencies.

• Electrostatics formulation: Select the electrical formulation to use:

- Symmetric, Electrostatic: the default setting.

- Unsymmetric, Electrostatic: for compatibility with the Electrostatics application 
mode.

- Unsymmetric, Electric currents: for compatibility with the application modes for 
electric currents in the AC/DC Module (Electric Currents in 3D, In-Plane 
Electric Currents in 2D, and Meridional Electric Currents in 2D axial symmetry). 
Available for frequency response analysis.

• Weak constraints: Controls whether or not weak constraints are active Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

The piezoelectric application modes have the following scalar variables:.

PROPERTY VARIABLE DEFAULT SI UNIT DESCRIPTION

ε0 epsilon0 8.854187817e-12 F/m Permittivity of vacuum

f freq 1e6 Hz Excitation frequency

jω jomega -lambda rad/s Complex angular frequency
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You control the scalar variables by going to the Physics menu and opening the 
Application Scalar Variables dialog box.

The excitation frequency (the frequency of the harmonic forces, potential, and 
displacement) is available only for frequency response analysis. The equations and 
documentation describing frequency response use the angular excitation frequency, 
ω = 2π f, which is available as the variable omega. The complex angular frequency is 
available for eigenfrequency analysis and damped eigenfrequency analysis.

When you select Frequency response as the analysis type, the default solver is the 
parametric solver. This default makes it easy to perform a frequency sweep over several 
excitation frequencies in one analysis. In this case enter freq as the Parameter name on 
the General page in the Solver Parameters dialog box. The values you enter in the 
Parameter values edit field override the excitation frequency you might have entered in 
the Application Scalar Variables dialog box.

Material Properties

The Subdomain Settings window has two pages where you define the material 
properties: the Structural page and the Electrical page. On top of both pages you find 
the Library material list and the Load button for importing and selecting data from the 
material libraries and the Material model list for selecting the material model for each 
domain. These settings are shared between the pages, and if you change the Structural 
page, the settings change also on the Electrical page. Note that loading a material from 
a material library does not change the material model, so you need to change it 
manually in the Material model list to match the type of material.

Everything else you see and define on the pages depends on the material model you 
select. Setting for different material model are described in the following chapters.
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S U B D O M A I N  S E T T I N G S  F O R  P I E Z O E L E C T R I C  M A T E R I A L

The piezoelectric material is a complete structural-electrical material, and thus you 
define all piezoelectric material properties on the Structural page. 

The Structural page has two lists in 3D, three lists in 2D, and three lists in axial 
symmetry:

• Constitutive form: Select the constitutive form from those in the following list. 
Depending on the selection, different material properties are shown in the dialog 
box.

- Stress-charge form: Define the constitutive relation of the material on the 
stress-charge form through the cE, e, and εrS matrices. The previous figure shows 
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the Material page for stress-charge, while the following figure shows the Elasticity 

matrix dialog box for entering the cE matrix.

The figure below shows the Relative permittivity dialog box for entering the εrS 
matrix components.

- Strain-charge form: You define the constitutive relation of the material on the 
strain-charge form through the sE, d, and εrT matrices (see page 190 for details). 
The following figure shows the Material page for strain-charge.

The next graphic shows the Coupling matrix, strain-charge form dialog box for 
entering the d matrix components.

• Material orientation (2D and axisymmetry only): Here you select how the 3D 
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material properties are oriented relative the 2D/axial symmetric analysis plane. 
There are six options: xy, yz, zx, yx, zy, and the default xz-plane. The plane 
represents how the 3D material is oriented relative the 2D/axial symmetric analysis 
plane: The first letter indicates which 3D direction coincides with the x direction in 
2D or the r direction for axisymmetry; the second letter indicates which 3D 
direction coincides with the y direction in 2D or the z direction for axisymmetry. 
The material coordinates names are fixed and do not depend of the names of the 
space coordinates (independent variables), which have different defaults in 2D and 
axial symmetry.

Figure 8-1:Orientation of 3D material xyz relative the 2D analysis coordinate system XYZ.
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Figure 8-2: Orientation of 3D material xyz relative the axisymmetric analysis coordinate 
system r Z.

• Coordinate system: Select the coordinate system where the material properties are 
defined. This choice is useful if you want to define the material in a coordinate 
system other than the global system, or if you need results in a local coordinate 
system for postprocessing. The Coordinate system list contains only the global 
coordinate system unless you have made available a user-defined coordinate system. 
You find the Coordinate System Settings dialog box on the Options menu.

The following table shows the material properties for the union of all constitutive 
forms and all piezoelectric application modes.

PARAMETER VARIABLE DESCRIPTION CONSTITUTIVE FORM

cE cElk Elasticity matrix Stress-charge

sE sElk Compliance matrix Strain-charge

e eik Coupling matrix, stress-charge form Stress-charge 

d Coupling matrix, strain-charge form Strain-charge

 εrS Relative permittivity matrix, 
stress-charge form

Stress-charge
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Elasticity matrix   defines the stress-strain relation matrix cE

 

where σ is the stress, and ε is the strain.

Coupling matrix   defines the piezo coupling matrix e used in the stress-charge form of 
the constitutive equation

 

where σ is the stress, ε is the strain, and E is the electric field.

Compliance matrix   defines the strain-stress relation matrix sE

 

where σ is the stress, and ε is the strain.

Coupling matrix   defines the piezo coupling matrix d used in the strain-charge form of 
the constitutive equation

 

where σ is the stress, ε is the strain, and E is the electric field.

Relative permittivity    the relative permittivity, εrS and εrT, appears in the constitutive 
relation on stress-charge and strain-charge forms, respectively.

Density   this material property, ρ, specifies the material’s density.

 εrT Relative permittivity matrix, 
strain-charge form

Strain-charge

 ρ rho Density All

 th thickness Thickness of the geometry (2D only) All

PARAMETER VARIABLE DESCRIPTION CONSTITUTIVE FORM

σ cEε=

σ cEε eTE–=

ε sEσ=

ε sEσ dTE+=

D eε ε0εrSE+=

D dσ ε0εrTE+=
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Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

S U B D O M A I N  S E T T I N G S  F O R  D E C O U P L E D ,  I S O T R O P I C  M A T E R I A L

With this material model you specify material properties on the Structural page and the 
Electrical page.

You define the structural material properties on the Structural page: 

On the first row after the Material Model list you find the Enable structural equation 
check box. Use this check box to activate the structural equation or inactivate it to 
model only electrical problems. By default the Enable structural equation check box is 
selected. If this setting is selected you can define the following structural material 
properties: 

Young’s modulus    This material property, E, is the modulus of elasticity of the material. 
It is used to form the elasticity matrix D for the stress strain relationship as described 
in the chapter “Material Models” on page 190.

Poisson’s ratio   This material property, ν, defines the contraction of the structure in the 
perpendicular direction. It is used to form the elasticity matrix D for the stress strain 
relationship as described in the chapter “Material Models” on page 190.

Density   this material property, ρ, specifies the material’s density.

Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only. 
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You define the electrical material properties on the Electrical page: 

On the first row after the Material Model list you find the Enable electrical equation check 
box. Use this check box to activate the electrical equation or inactivate it to model only 
structural problems. If you select it and clear the Enable structural equation check box, 
only the electrical equation is active. By default the Enable electrical equation check box 
is selected. If this setting is selected you can define the following electrical material 
properties: 

Relative permittivity   This material property, εr, defines the isotropic relative electrical 
permittivity of the material.

Electric conductivity   This material property, σ, defines the isotropic electrical 
conductivity of the material. This setting only appears for frequency response analysis.

Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only.

S U B D O M A I N  S E T T I N G S  F O R  D E C O U P L E D ,  A N I S O T R O P I C  M A T E R I A L

With this material model you specify material properties on the Structural page and the 
Electrical page.
T H E  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S  |  203



204 |  C H A P T E
You define the structural material properties on the Structural page: 

On the first row after the Material Model list you find the Enable structural equation 
check box. Use this check box to activate the structural equation or inactivate it to 
model only electrical problems. By default, Enable structural equation is selected. If this 
setting is selected you can define the following structural material properties: 

Material orientation    (2D and axisymmetry only): Here you select how the 3D material 
properties are oriented relative the 2D/axial symmetric analysis plane. There are six 
options: xy, yz, zx, yx, zy, and the default xz. This setting works the way same as for 
the piezoelectric material (See description on page 198).

Coordinate system    Select the coordinate system where the material properties are 
defined. This setting works the way same as for the piezoelectric material (See 
description on page 200).

Elasticity matrix   This material property, D, defines the elasticity matrix of the 
anisotropic material (See “Material Models” on page 190.). You define D as a 
symmetric 6-by-6 matrix: 

Density   this material property, ρ, specifies the material’s density.
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Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

You define the electrical material properties on the Electrical page: 

On the first row after the Material Model list you find the Enable electrical equation check 
box. Use this check box to activate the electrical equation or inactivate it to model only 
structural problems. By default Enable electrical equation is selected. If this setting is 
selected you can define the following electrical material properties:

Material orientation    (2D and axisymmetry only) This is the same setting as the 
Material orientation in the Structural page.

Coordinate system    This is the same setting as the Coordinate system on the Structural 
page.

Relative permittivity   This material property, εr, defines the anisotropic relative 
electrical permittivity of the material. You define εr using a symmetric 3-by-3 matrix: 
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Electric conductivity   This material property, σ, defines the anisotropic electrical 
conductivity of the material. This setting only appears for frequency response analysis. 
You define σ using a symmetric 3-by-3 matrix: 

Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only.

P I E Z O E L E C T R I C  M A T E R I A L S  P R O P E R T I E S  L I B R A R Y

A library of about 25 common piezoelectric materials is available through the Materials/

Coefficients Library dialog box.“Piezoelectric Material Properties Library” on page 47

Electric Boundary Conditions

The electric boundary conditions in the piezoelectric application modes depend on the 
setting of the Electrostatics formulation property in the Application Mode Properties 
dialog box. You specify the electric boundary conditions on the Electric BC page in the 
Boundary Settings dialog box.

The Electric BC page also has a Boundary condition list where you select the type of 
electric boundary condition; the software enables different edit fields depending on 
the selected type.
R  8 :  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S



B O U N D A R Y  C O N D I T I O N S  F O R  E L E C T R O S T A T I C S

For the Unsymmetric, Electrostatic and Symmetric, Electrostatic formulations, the 
boundary conditions include:

Electric Displacement

This boundary condition specifies the normal component of the electric displacement 
at a boundary. Enter the components of the electric displacement D0.

Surface Charge

 

This boundary condition specifies the surface charge density ρs at an exterior boundary 
(left equation) or at the interior boundary between two media with electric 
displacement D1 and D2, respectively.

Zero Charge/Symmetry

This boundary condition specifies that the normal component of the electric 
displacement is zero. The Zero charge/Symmetry boundary condition is also useful at 
symmetry boundaries where the potential is symmetric with respect to the boundary.

Electric Potential

This boundary condition specifies the voltage V0 at the boundary. Because the 
application mode computes the electric potential, you must define its value at some 
boundary in the geometry to be fully determined.

Ground

This boundary condition is a special case of the previous one specifying zero potential. 
The Ground boundary condition is also be useful at symmetry boundaries, where the 
potential is antisymmetric with respect to the boundary.

Continuity

n D⋅ n D0⋅=

n– D⋅ ρs,= n D1 D2–( )⋅ ρs=

n D⋅ 0=

V V0=

V 0=

n D1 D2–( )⋅ 0=
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This boundary condition specifies that the normal component of the electric 
displacement is continuous across an interior boundary or across a boundary between 
a piezoelectric and an electrostatic domain if you use the Unsymmetric, Electrostatic 
formulation. Using the Symmetric, Electrostatic formulation the Continuity condition 
is only available for interior boundaries, where it is the default.

Floating Potential
This condition the potential on the boundary to a spatially constant value such that the 
total charge on the boundary equals the user defined total charge Q0:

You also define the group index, which defines how the boundaries are grouped in to 
a set of electrodes.

Axial Symmetry

This boundary condition is the natural Neumann boundary condition, which you use 
on the z-axis (r = 0) to maintain the symmetry conditions. The Axial Symmetry 
boundary condition is available only in the Piezo Axial Symmetry application mode.

B O U N D A R Y  C O N D I T I O N S  F O R  E L E C T R I C  C U R R E N T S

For the Unsymmetric, Electric currents formulations, the boundary conditions 
include:

Ground

This boundary condition is a special case of the previous one specifying zero potential. 
The Ground boundary condition is also be useful at symmetry boundaries, where the 
potential is antisymmetric with respect to the boundary.

Electric Potential

ρs

∂Ω
∫ Q0=

Er 0

r∂
∂Ez 0=

=

V 0=

V V0=
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This boundary condition specifies the voltage V0 at the boundary. Because the 
application mode computes the electric potential, you must define its value at some 
boundary in the geometry to be fully determined.

Current Flow

This boundary condition specifies the current flow. Enter the components of the 
current density J0.

Inward Current Flow

 

This boundary condition specifies the normal current density Jn at an exterior 
boundary.

Electric Insulation

This boundary condition specifies that the normal component of the electric current 
is zero; that is, the boundary is electrically insulated.

Current Source
The current source boundary condition

 

is applicable to interior boundaries that represent either a source or a sink of current.

Continuity

This boundary condition specifies that the normal component of the electric current 
is continuous across the interior boundary (where it is the default setting) or across a 
boundary between a piezoelectric and an domain with electric currents.

Floating Potential
This condition the potential on the boundary to a spatially constant value such that the 
total current through the boundary equals the user defined total current I0:

n J⋅ n J0⋅=

n– J⋅ Jn=

n J⋅ 0=

n J1 J2–( )⋅ Jn=

n J1 J2–( )⋅ 0=

n J⋅–

∂Ω
∫ I0=
T H E  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S  |  209



210 |  C H A P T E
You also define the group index, which defines how the boundaries are grouped in to 
a set of electrodes.

Axial Symmetry
This boundary condition is the natural Neumann boundary condition, which you use 
on the z-axis (r = 0) to maintain the symmetry conditions. The Axial Symmetry 
boundary condition is available only in the Piezo Axial Symmetry application mode.

C O N V E R S I O N  O F  E L E C T R I C  B O U N D A R Y  C O N D I T I O N S

Some boundary conditions are applicable only for the formulations for electrostatics, 
whereas others apply only to the formulation for electric currents. Table 8-1 contains 
the boundary conditions that the software converts when changing from one 
formulation to the other:

Constraints

A constraint specifies the displacement or potential of certain parts of a structure. You 
can define constraints for the displacements on all domain levels including points, 
edges, faces/boundaries, and subdomains (in 3D), and points, boundaries, and 
subdomains (in 2D). In addition, you can define constraints for the potential on points 
and edges in 3D, and for points in 2D. To control them, go to the Constraint page in 
the Subdomain/Boundary/Edge/Point Settings dialog boxes, and set constraints on 
boundaries from the Electric BC page. The following figure shows the Boundary Settings 

TABLE 8-1:  BOUNDARY CONDITION CONVERSIONS

BOUNDARY CONDITION FOR ELECTROSTATICS BOUNDARY CONDITION FOR ELECTRIC CURRENTS

Electric displacement Current flow

Zero charge/Symmetry Electric insulation

Surface charge (exterior boundaries) Inward current flow

Surface charge (interior boundaries) Current source
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dialog box for the Piezo Solid application mode, but the page has the same appearance 
in all piezoelectric application modes.

Use the Constraint condition list in this dialog box to select the type of constraint that 
you want to define.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system, available only on boundaries

• User-defined coordinate systems, if any local coordinate systems are defined. 

When you select Prescribed displacement a number of new options appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the prescribed displacement options.
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The check boxes adjacent to the Rx, Ry, and Rz edit fields activate the constraint, 
whereupon you enter the value/expression of the displacement (the default value is 0).

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify the Prescribed 

velocity and Prescribed acceleration in the same way as Prescribed displacement.

Constraint page showing the prescribed velocity settings.

Loads and Charges

Load is a general name for forces applied to a structure. You can specify loads on all 
domain types. To do so, click the Load tab in the Boundary Settings dialog boxes or the 
Load/Charge tab in the Subdomain Settings, Edge Settings, and Point Settings dialog 
boxes, where you can also specify a charge density. The formulation for electric 
currents does not include charges, so in that case, the name of the tab is Load also in 
the Subdomain Settings, Edge Settings, and Point Settings dialog boxes. The following 
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 (N/m3) 
 (N/m2)

 (N/m3)
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image shows the Edge Settings dialog box for the Piezo Solid application mode, but the 
tab looks similar on all domain levels in all piezoelectric application modes.

S P E C I F Y I N G  L O A D S

For plane stress and plane strain, option buttons allow you to specify the load in 
different ways using the thickness. The following table summarizes the options for 
defining loads on different domains in different application modes; the SI unit appears 
in parenthesis. 

With the Coordinate system list you control in which coordinate system the load is 
defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system, only available on boundaries

• User-defined coordinate systems, if there are any local coordinate systems defined. 

S P E C I F Y I N G  C H A R G E S

You can specify a charge on the Edge/Point level when you use a formulation for 
electrostatics. For plane stress and plane strain, option buttons allow you to specify the 
charge in different ways using the thickness. The following table summarizes the 

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMAIN

Plane Stress,

Plane Strain

force (N) force/area (N/m2) or 
force/length (N/m)

force/volume
or force/area

Axial symmetry total force along the 
circumferential (N)

force/area (N/m2) force/volume

Solid force (N) force/length 
(N/m)

force/area (N/m2) force/volume
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options for defining charge on different domains in different application modes; the SI 
units appears in parenthesis.

To specify charge density on boundaries, click the Electric BC tab.

Structural Damping

For time-dependent analysis, you can specify viscous damping (structural damping) 
using Rayleigh damping, where the damping matrix is specified to be proportional to 
the mass and stiffness matrix:

For frequency response analysis you can specify viscous damping using either Rayleigh 
damping, loss factor damping, or equivalent viscous damping.

APPLICATION MODE POINT EDGE SUBDOMAIN

Plane Stress, 
Plane Strain

charge (C) charge/volume (C/m3) 
or charge/area (C/m2)

Axial symmetry total charge along 
the circumferential 
(C)

charge density (C/m3)

Solid force (C) charge/length 
(C/m)

charge density (C/m3)

C αdMM βdKK+=
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To specify structural damping parameters, go to the Damping page in the Subdomain 

Settings dialog box, and choose the type of damping model from the Damping model 
list. The layout of the dialog box changes for each damping model.

The Damping page when loss factor damping is selected.

Note: Loss factor damping and equivalent viscous damping are valid only for 
frequency response analysis. If you choose a transient analysis and either of these 
damping types, COMSOL Multiphysics solves the model with no damping.

Table 8-2 and the following text describe the parameters that define damping:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping and equivalent viscous 
damping models.

TABLE 8-2:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

αdM alphadM Mass-damping parameter Rayleigh

βdK betadK Stiffness-damping parameter Rayleigh

η eta Loss factor Loss factor, Equivalent viscous
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The Piezo Solid Application Mode

Use the Piezo Solid application mode for analysis of 3D structures that exhibit 
piezoelectric effects.

V A R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u, v, and 
w in the global x, y, and z directions, and the electric potential, V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 146.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see Table 8-3 on 
page 203.

The Piezo Plane Strain Application Mode

Use the Piezo Plane Strain application mode to compute the global displacements (u, 
v) in the x and y directions and the electric potential for a piezoelectric structure in a 
state of plane strain. The plane strain condition assumes that the εz, εyz, and εxz 
components of the strain tensor are zero.

V A R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 146.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see Table 8-4 on 
page 209.
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The Piezo Axial Symmetry Application Mode

Use the Piezo Axial Symmetry application mode to analyze axisymmetric models of 
materials showing piezoelectric effects.

This application mode uses cylindrical the coordinates r, (phi), and z. It solves the 
equations for the global displacement (u, w) in the r and z directions. It assumes that 
the displacement v in the direction together with the , , , and  
components of the stresses and strains are zero. Loads are independent of , and it 
allows loads only in the r and z directions.

You can consider the domain where the software solves the equations as the 
intersection between the original axially symmetric 3D solid and the half plane , 
r ≥ 0. Therefore it is necessary to draw the geometry only in the half plane r ≥ 0. The 
software recovers the original 3D solid by rotating the 2D geometry about the z-axis 
as seen in the following figure:

The strain-displacement relations for the axial symmetry case for small displacements 
are:

To avoid division by r (which causes problems on the axis, where r = 0), the program 
automatically transforms the equations by multiplying by r. When using the principle 
of virtual work, you normally do not think of this multiplication as a transformation 

ϕ

ϕ τrϕ τϕz γrϕ γϕz
ϕ

ϕ 0=

εr r∂
∂u

= εϕ
u
r
---= εz z∂

∂w
= γrz z∂

∂u
r∂

∂w
+=
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but merely as an integration around the circumference. Integrating over the volume, 
you must multiply the integrand by 2π r. The application mode introduces and solves 
for a new dependent variable

instead of the true radial displacement, u.

Note: r = 0 is the symmetry axis. x -> r and y -> z in the Piezo Axial Symmetry, 
application mode.

V A R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are uor the radial displacement divided 
by r and w the global displacement in the z direction and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 146.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see Table 8-5 on 
page 216.

Application Mode Variables

A large number of variables are available for use in expressions and for postprocessing 
purposes. In addition to the variables listed below, almost all application mode 
parameters are available as variables. Some variables change their availability with the 
type of analysis, as noted in the Analysis column. For frequency-response analysis a 
number of additional variables are available. Furthermore, the amplitudes and phases 

uor u
r
---=
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TABLE 8-3:

NAME

ui

V

uit

ui_amp

ui_ph

V_amp

V_ph

ui_t

ui_t_a
of variables such as strains and stresses are available; to access them, append _amp or 
_ph to the variable name. For example:

•  sx_amp represents the amplitude of the normal stress in the x direction

•  ex_ph represents the phase of the normal strain in the x direction

The exception to this scheme consists of variables defined using a nonlinear operator 
such as mises, disp, Tresca, or s1.

The tables use a convention where indices i, j, … (or i, j, …) run over the geometry’s 
Cartesian coordinate axes, x, y, and z. In particular, ui (ui) refers to the global 
displacements (u, v, w). The Analysis column uses the following abbreviations:

ANALYSIS ABBREVIATION

Static S

Frequency response F

Time dependent T

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

 ui All All xi displacement  ui

 V All All Electric 
potential

 V

 uit T All xi velocity  uit

 uiamp F All xi displacement 
amplitude

 | ui |

 uiph F All xi displacement 
phase

 Vamp F All Electric 
potential 
amplitude

 | V  |

 Vph F All Electric 
potential phase

 uit F All xi velocity  jω ui

mp  uitamp F All xi velocity 
amplitude

 ω uiamp

180°
π

------------mod angle ui( ) 2π,( )

180°
π

------------mod angle V( ) 2π,( )
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ui_t_p

ui_tt

ui_tt_

ui_tt_

disp

ei

eij

Ei

normE

eil

eijl

Eil

Vil

TABLE 8-3:

NAME
h  uitph F All xi velocity 
phase

 mod (uiph + 90°, 360°)

 uitt F All xi acceleration  −ω2 ui

amp  uittamp F All xi acceleration 
amplitude

 ω2 uiamp

ph  uittph F All xi acceleration 
phase

 mod (uiph + 180°, 360°)

 disp All All Total 
displacement

 εi All S εi normal strain 
global coord. 
system

 εij All S εij shear strain 
global coord. 
system

 Ei All S Electric field

 Ei All S Electric field

 εil All S εil normal 
strain, 
user-defined 
coord. system

 Tcoord
T ε Tcoord

 εijl All S εijl shear strain, 
user-defined 
coord. system

 Tcoord
T ε Tcoord

 Eil All S Electric field, 
user-defined 
coord. system

 Tcoord
T E

 Vil All S Electric 
potential 
gradient, 
user-defined 
coord. system

 Tcoord
T 

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui( )real( )
i
∑

2

xi∂
∂ui

1
2
---

xj∂
∂ui

xi∂
∂uj+

⎝ ⎠
⎜ ⎟
⎛ ⎞

xi∂
∂V
⎝ ⎠
⎛ ⎞–

E E⋅

∇V
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ei_t

ei_t

eij_t

eij_t

eil_t

eijl_t

cE
harge 

e

epsilo

TABLE 8-3:

NAME
 εit T S εit normal 
velocity strain, 
global system

 εit F S εit normal 
velocity strain, 
global system

 εijt T S εijt shear 
velocity strain, 
global coord. 
system

 εijt F S εijt shear 
velocity strain, 
global coord. 
system

 εilt F T S εilt normal 
velocity strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

 εijlt F T S εijlt shear 
velocity strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

 cE All S Stiffness matrix 
components 

, if material is specified on strain-c

form, calculated by a special 
inverting-matrices element.

 e All S Piezoelectric 
coupling 
matrix, if 
material is 
specified on 
strain-charge 
form

nT  εT All S Electric 
permittivity 
with stress field 
constant

 ε0 εrT

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

xi∂
∂uit

xi∂
∂uijω

1
2
---

xj∂
∂uit

xi∂
∂ujt+

⎝ ⎠
⎜ ⎟
⎛ ⎞

1
2
---

xj∂
∂ui

xi∂
∂uj+

⎝ ⎠
⎜ ⎟
⎛ ⎞

jω

sE
1–

dsE
1–
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epsilo om

om

D l

epsilo aterial

sigma l 

si s.

y 

 sys.

Di s.

 sys.

Ji

 sys.

Jdi

Jdi

TABLE 8-3:

NAME
nS  εS All S Electric 
permittivity 
with strain field 
constant

If material defined on stress-charge fr

 ε0 εrS

If material defined on strain-charge fr

 D All S Stiffness matrix 
components

For isotropic and anisotropic materia

n εe All S Electric 
permittivity 
matrix 
components

ε0 εr, for isotropic and anisotropic m

σe freq S Electric 
conductivity 
matrix 
components

For isotropic and anisotropic materia

 σi All S σi normal 
stress, global 
coord. system

If material defined in global coord. sy

 cE ε − et E or Dε
With loss factor damping in frequenc
response analysis

(1 + jη)cE ε − et E or (1 + jη)Dε

If material defined in user-def. coord.

 Tcoord σl Tcoord
T

 Di All S Electric 
displacement, 
xi component

If material defined in global coord. sy

 e ε + εS E or εe E

If material defined in user-def. coord.

 Tcoord Dl

 Ji T F S Total current 
density, xi 
component

Jd,i + Jp,i or Jd,i

If material defined in user-def. coord.

 Tcoord Jl

 Jd,i T S Displacement 
current density, 
xi component

 Jd,i F S Displacement 
current density, 
xi component

 jω Di

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ε0εrT d sE
1– dt⋅ ⋅–

t∂
∂Di
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Jpi

 sys.

sij s.

y 

 sys.

sil

y 

Dil

Jil

Jdil

Jdil

Jpil

TABLE 8-3:

NAME
 Jp,i T F S Potential 
current density, 
xi component

σeE 

If material defined in user-def. coord.

 Tcoord Jl

 τij All S τij shear stress, 
global coord. 
system

If material defined in global coord. sy

 cE ε − et E or Dε
With loss factor damping in frequenc
response analysis

 (1 + jη)cE ε − et E or (1 + jη)Dε

If material defined in user-def. coord.

 Tcoord σl Tcoord
T

 σi All S σi normal 
stress, 
user-defined 
local coord. 
system

 cE εl − et El or Dεl

With loss factor damping in frequenc
response analysis

 (1 + jη)cE εl − et El or (1 + jη)Dεl

 Dil All S Electric 
displacement, 
xi component, 
local coord. sys.

 e εl + εS El or εe El

 Jil T F S Total current 
density, xi 
component, 
local coord. sys.

Jd,il + Jp,il or Jd,il

 Jd,il T S Displacement 
current density, 
xi component, 
local coord. sys.

 Jd,il F S Displacement 
current density, 
xi component, 
local coord. sys.

 jω Dil

 Jp,il F S Potential 
current density, 
xi component, 
local coord. sys.

σeEl 

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

t∂
∂Dil
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sijl

y 

si_t s.

y 

 sys.

sij_t s.

y 

 sys.

sil_t

y 

sijl_t

y 

si

ei

TABLE 8-3:

NAME
 τij All S τij shear stress, 
user-defined 
local coord. 
system

 cE εl − et El or Dεl

With loss factor damping in frequenc
response analysis

 (1 + jη)cE εl − et El or (1 + jη)Dεl

σit F T S σit time 
derivative of 
normal stress, 
global coord. 
system

If material defined in global coord. sy

 cE εt or Dεt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE εt or (1 + jη)jωDε

If material defined in user-def. coord.

 Tcoord σl t Tcoord
T

τijt T S τijt time 
derivative of 
shear stress, 
global coord. 
system

If material defined in global coord. sy

  cE εt or Dεt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE ε or (1 + jη)jωDε

If material defined in user-def. coord.

 Tcoord σl t Tcoord
T

σilt F T S σilt time 
derivative of 
normal stress, 
user-defined 
local coord. 
system

 cE εlt or Dεlt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE εl or (1 + jη)jωDεl

 τijlt F T S τijlt time 
derivative of 
shear stress, 
user-defined 
local coord. 
system

 cE εlt or Dεlt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE εl or (1 + jη)jωDεl

 σi All S Principal 
stresses, 
i=1, 2 , 3

Defined by elpric element

 εi All S Principal 
strains, i=1, 2 , 3

Defined by elpric element

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION
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sixj

eixj

tresca

mises

normD

Ws l 

y 

 

resp.

We l 

resp.

 

q. 

Tai

TABLE 8-3:

NAME
 σixj All S Principal stress 
directions, 
i, j=1, 2 , 3

Defined by elpric element

 εixj All S Principal strain 
directions, 
i, j=1, 2 , 3

Defined by elpric element

 σtresca All S Tresca stress

 σmises All S von Mises 
stress 

 |D| All S Electric 
displacement, 
norm

 Ws All S Strain energy 
density

If material properties defined in globa
coord. sys.

0.5 σ · ε  

,  in frequenc

response analyses

If material properties defined in local
user-defined coord. sys.

,  in freq. 

 We All S Electric energy 
density

If material properties defined in globa
coord. sys.

 E · D  /  2, real(conj(E) · D)/2 in freq. 

If material properties defined in local
user-defined coord. sys.

 El · Dl  /  2, real(conj(El) · Dl)/2 in fre
resp.

 Tai All B Surface traction 
(force/area) in 
xi direction

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

max max σ1 σ2– σ2 σ3–,( ) )
σ1 σ3– )

,(
)

D D⋅

σ ε⋅
2

---------- 1
2
---real σ conj ε( )⋅( )

σl εl⋅
2

-------------- 1
2
---real σl conj εl( )⋅( )

Tax

Tay

Taz

σx τxy τxz

τxy σy τyz

τxz τyz σz

nx

ny

nz

=
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nD

nJ

nJs ts. 

Fig

smon

eson

TABLE 8-3:

NAME

TABLE 8-4:

NAME

ui

V

uit

ui_amp
P I E Z O  P L A N E  S T R A I N

 nD All B Surface charge 
density

 nJ F T B Current density 
outflow

 n · J

 nJs F B Source current 
density

Only for unsymmetric electric curren

  or, 

with weak constraints, the Lagrange 
multiplier for V. 

 Fig All All Body load, face 
load, edge load, 
point load, in 
global 
xi direction

If global coordinate system

If other coordinate system

smon All S Structural 
equation 
available

1 or 0 

eson All S Electrical 
equation 
available

1 or 0 

  PIEZO SOLID APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

nup Ddown Dup–( )⋅

nup Jdown Jup–( )⋅

Fxg

Fyg

Fzg

Fx

Fy

Fz

=

Fxg

Fyg

Fzg

Tcoord

Fx

Fy

Fz

=

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

 ui All All xi displacement  ui

 V All All Electric 
potential

 V

 uit T All xi velocity  uit

 uiamp F All xi displacement 
amplitude

 | ui |
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ui_ph

V_amp

V_ph

ui_t

ui_t_a

ui_t_p

ui_tt

ui_tt_

ui_tt_

disp

ei

exy

Ei

normE

eil

TABLE 8-4:

NAME
 uiph F All xi displacement 
phase

 Vamp F All Electric 
potential 
amplitude

 | V |

 Vph F All Electric 
potential phase

 uit F All xi velocity  jω ui

mp  uitamp F All xi velocity 
amplitude

 ω uiamp

h  uitph F All xi velocity 
phase

 mod (uiph + 90°, 360°)

  uitt F All xi acceleration  −ω2 ui

amp   uittamp F All xi acceleration 
amplitude

 ω2 uiamp

ph   uittph F All xi acceleration 
phase

 mod (uiph + 180°, 360°)

 disp All All Total 
displacement

 εi All S εi normal 
strain, global 
coord. system

 εxy All S εxy shear strain, 
global coord. 
system

 Ei All S Electric field

 Ei All S Electric field

 εil All S εil normal 
strain, 
user-defined 
coord. system

 Tcoord
T ε Tcoord

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

180°
π

------------mod angle ui( ) 2π,( )

180°
π

------------mod angle V( ) 2π,( )

ui( )real( )
i
∑

2

xi∂
∂ui

1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞

xi∂
∂V
⎝ ⎠
⎛ ⎞–

E E⋅
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eijl

Eil

Vil

ei_t

ei_t

exy_t

exy_t

eil_t

exyl_t

cE
harge 

TABLE 8-4:

NAME
 εijl All S εijl shear strain, 
user-defined 
coord. system

 Tcoord
T ε Tcoord

 Eil All S Electric field, 
user-defined 
coord. system

 Tcoord
T E

 Vil All S Electric 
potential 
gradient, 
user-defined 
coord. system

 Tcoord
T 

 εit T S εit normal 
velocity strain, 
global system

 εit F S εit normal 
velocity strain, 
global system

 εxyt T S εxyt shear 
velocity strain, 
global coord. 
system

 εxyt F S εxyt shear 
velocity strain, 
global coord. 
system

 εilt F T S εilt normal 
velocity strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

 εxylt F T S εxylt shear 
velocity strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

 cE All S Stiffness matrix 
components 

, if material is specified on strain-c

form, calculated by a special 
inverting-matrices element.

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

∇V

xi∂
∂uit

xi∂
∂uijω

1
2
---

y∂
∂ut

x∂
∂vt+⎝ ⎠

⎛ ⎞

1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞ jω

sE
1–
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e

epsilo

epsilo om

om

D l

epsilo terial

sigma l 

si s.

y 

 sys.

Di s.

 sys.

TABLE 8-4:

NAME
 e All S Piezoelectric 
coupling matrix 
if material is 
specified on 
strain-charge 
form

nT  εT All S Electric 
permittivity 
with stress field 
constant

 ε0 εrT

nS  εS All S Electric 
permittivity 
with strain field 
constant

If material defined on stress-charge fr

 ε0 εrS

If material defined on strain-charge fr

 D All S Stiffness matrix 
components

For isotropic and anisotropic materia

n εe All S Electric 
permittivity 
matrix 
components

ε0 εr, for isotropic and anisotropic ma

σe freq S Electric 
conductivity 
matrix 
components

For isotropic and anisotropic materia

 σi All S σi normal 
stress, global 
coord. system

If material defined in global coord. sy

 cE ε − et E or Dε
With loss factor damping in frequenc
response analysis

(1 + jη)cE ε − et E or (1 + jη)Dε

If material defined in user-def. coord.

 Tcoord σl Tcoord
T

 Di All S Electric 
displacement, 
xi component

If material defined in global coord. sy

 e ε + εS E or εe E
If material defined in user-def. coord.

 Tcoord Dl

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

dsE
1–

ε0εrT d sE
1– dt⋅ ⋅–
T H E  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S  |  229



230 |  C H A P T E

Ji

 sys.

Jdi

Jdi

Jpi

 sys.

sij s.

y 

 sys.

sil

y 

Dil

Jil

Jdil

TABLE 8-4:

NAME
 Ji T F S Total current 
density, xi 
component

Jd,i + Jp,i or Jd,i

If material defined in user-def. coord.

 Tcoord Jl

 Jd,i T S Displacement 
current density, 
xi component

 Jd,i F S Displacement 
current density, 
xi component

 jω Di

 Jp,i T F S Potential 
current density, 
xi component

σeE 

If material defined in user-def. coord.

 Tcoord Jl

 τij All S τij shear stress, 
global coord. 
system

If material defined in global coord. sy

 cE ε − et E or Dε
With loss factor damping in frequenc
response analysis

 (1 + jη)cE ε − et E or (1 + jη)Dε

If material defined in user-def. coord.

 Tcoord σl Tcoord
T

 σi All S σi normal 
stress, 
user-defined 
local coord. 
system

 cE εl − et El or Dεl

With loss factor damping in frequenc
response analysis

 (1 + jη)cE εl − et El or (1 + jη)Dεl

 Dil All S Electric 
displacement, 
xi component, 
local coord. sys.

 e εl + εS El or εe El

 Jil T F S Total current 
density, xi 
component, 
local coord. sys.

Jd,il + Jp,il or Jd,il

 Jd,il T S Displacement 
current density, 
xi component, 
local coord. sys.

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

t∂
∂Di

t∂
∂Dil
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Jdil

Jpil

sijl

y 

si_t s.

y 

 sys.

sij_t s.

y 

 sys.

sil_t

y 

TABLE 8-4:

NAME
 Jd,il F S Displacement 
current density, 
xi component, 
local coord. sys.

 jω Dil

 Jp,il F S Potential 
current density, 
xi component, 
local coord. sys.

σeEl 

 τij All S τij shear stress, 
user-defined 
local coord. 
system

 cE εl − et El or Dεl

With loss factor damping in frequenc
response analysis

 (1 + jη)cE εl − et El or (1 + jη)Dεl

σit F T S σit time 
derivative of 
normal stress, 
global coord. 
system

If material defined in global coord. sy

 cE εt or Dεt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE εt or (1 + jη)jωDε

If material defined in user-def. coord.

 Tcoord σl t Tcoord
T

τijt T S τijt time 
derivative of 
shear stress, 
global coord. 
system

If material defined in global coord. sy

  cE εt or Dεt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE ε or (1 + jη)jωDε

If material defined in user-def. coord.

 Tcoord σl t Tcoord
T

σilt F T S σilt time 
derivative of 
normal stress, 
user-defined 
local coord. 
system

 cE εlt or Dεlt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE εl or (1 + jη)jωDεl

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION
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sijl_t

y 

sz s.

y 

 

 sys.

sz_t s.

y 

 D)

 sys.

TABLE 8-4:

NAME

kεk
 τijlt F T S τijlt time 
derivative of 
shear stress, 
user-defined 
local coord. 
system

 cE εlt or Dεlt

With loss factor damping in frequenc
response analysis

 (1 + jη)jωcE εl or (1 + jη)jωDεl

 σz All S σz normal 
stress

If material defined in global coord. sy

, or 

With loss factor damping in frequenc
response analysis

, or

If material defined in user-def. coord.

, or 

 σzt All S σzt time 
derivative of 
normal stress

If material defined in global coord. sy

 (M is cE or D)

With loss factor damping in frequenc
response analysis

 (M is cE or

If material defined in user-def. coord.

 (M is cE or D)

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

cE( )3kεk ej3Ej

j
∑–

k
∑ D( )3

k
∑

1 jη+( ) cE( )3kεk ej3Ej

j
∑–

k
∑

1 jη+( ) D( )3kεk

k
∑

cE( )3k εl( )k ej3 El( )j
j
∑–

k
∑

D( )3k εl( )k
k
∑

D( )3k εt( )k
k
∑

1 jη+( ) M( )3kjωεk

k
∑

M( )3k εlt( )k
k
∑
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si

ei

sixj

eixj

tresca

mises

normD

Ws l 

 

freq. 

TABLE 8-4:

NAME
 σi All S Principal 
stresses, 
i = 1, 2, 3

Defined by elpric element

 εi All S Principal 
strains, 
i = 1, 2, 3

Defined by elpric element

 σixj All S Principal stress 
directions, 
i, j = 1, 2, 3

Defined by elpric element

 εixj All S Principal strain 
directions, 
i, j = 1, 2, 3

Defined by elpric element

 σtresca All S Tresca stress

 σmises All S von Mises 
stress 

 normD All S Electric 
displacement, 
norm

 Ws All S Strain energy 
density

If material properties defined in globa
coord. sys.

,  in 

frequency response analyses.

If material properties defined in local
user-defined coord. sys.

,  in 

resp.

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

max max σ1 σ2– σ2 σ3–,( ) )
σ1 σ3– )

,(
)

D D⋅

σ ε⋅
2

----------th 1
2
---real σ conj ε( )⋅( )th

σl εl⋅
2

--------------th 1
2
---real σl conj εl( )⋅( )th
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We l 

 

 

 in 

Tai

nD

nJ

nJs ts. 

Fig

TABLE 8-4:

NAME
 We All S Electric energy 
density

If material properties defined in globa
coord. sys.

,  in

frequency response analyses.

If material properties defined in local
user-defined coord. sys.

, 

frequency response analyses.

 Tai All B Surface traction 
(force/area) in 
xi direction

 nD All B Surface charge 
density

 nJ F T B Current density 
outflow

 n · J

 nJs F B Source current 
density

Only for unsymmetric electric curren

  or, 

with weak constraints, the Lagrange 
multiplier for V. 

 Fig All All Body load, edge 
load, point 
load, in global 
xi direction

If global coordinate system

If other coordinate system

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

E D⋅
2

--------------th 1
2
---real conj E( ) D⋅( )th

El Dl⋅
2

-----------------th 1
2
---real conj El( ) Dl⋅( )th

Tax

Tay

σx τxy

τxy σy

nx

ny

=

nup Ddown Dup–( )⋅

nup Jdown Jup–( )⋅

Fxg

Fyg

Fx

Fy

=

Fxg

Fyg

Tcoord
Fx

Fy

=
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smon

eson

TABLE 8-4:

NAME

TABLE 

NAME

uor

uaxi

w

V

uort

uaxi

w_t

uaxi

w_am

uaxi

w_ph

V_am

V_ph

uaxi

w_t
smon All S Structural 
equation 
available

1 or 0 

eson All S Electrical 
equation 
available

1 or 0 

  PIEZO PLANE STRAIN APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

 uor All All r displacement 
divided by r

 uor

 uaxi All All r displacement  uor · r

 w All All z displacement  w

 V All All Electric 
potential

 V

 uort T All r velocity 
divided by r

 uort

_t  uaxit T All r velocity  uort · r

 wt T All z velocity  wt

_amp  uaxiamp F All r displacement 
amplitude

 | uaxi |

p  wamp F All z displacement 
amplitude

 | w |

_ph  uaxiph F All r displacement 
phase

 wph F All z displacement 
phase

p  Vamp F All Electric 
potential 
amplitude

 | V |

 Vph F All Electric 
potential phase

_t  uaxit F All r velocity  jω  uaxi

 wt F All z velocity  jω  w

180°
π

------------mod angle uaxi( ) 2π,( )

180°
π

------------mod angle w( ) 2π,( )

180°
π

------------mod angle V( ) 2π,( )
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uaxi

w_t_

uaxi

w_t_

uaxi

w_tt

uaxi

w_tt

uaxi

w_tt

disp

er

ez

ephi

erz

exl,

exyl

TABLE

NAME
_t_amp  uaxitamp F All r velocity 
amplitude

 ω  uaxiamp

amp  wtamp F All z velocity 
amplitude

 ω  wamp

_t_ph  uaxitph F All r velocity phase  mod (uaxiph + 90°, 360°)
ph  wtph F All z velocity phase  mod (wph + 90°, 360°)
_tt  uaxitt F All r acceleration  −ω2  uaxi

 wtt F All z acceleration  −ω2  w
_tt_amp  uaxitamp F All r acceleration 

amplitude
 ω2  uaxiamp

_amp  wtamp F All z acceleration 
amplitude

 ω2  wamp

_tt_ph  uaxitph F All r acceleration 
phase

 mod (uaxiph + 180°, 360°)

_ph  wtph F All z acceleration 
phase

 mod (wph + 180°, 360°)

 disp All All Total 
displacement

 εr All S εr normal 
strain, global 
system

 εz All S εz normal 
strain, global 
system

All S normal 
strain

 uor

 εrz All S εrz shear strain, 
global coord. 
system

 eyl  εxl, εyl All S εxl, εyl normal 
strains, 
user-defined 
coord. system

 Tcoord
T ε Tcoord

 εxyl All S εxy shear strain, 
user-defined 
coord. system

 Tcoord
T ε Tcoord

 8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

uaxi2 w2
+

uor
r∂

∂ uor( ) r⋅+

z∂
∂w

εϕ εϕ

1
2
---

z∂
∂ uor( ) r⋅

r∂
∂w

+⎝ ⎠
⎛ ⎞
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er_t

er_t

ez_t

ez_t

ephi

ephi

erz_

erz_

exl_
eyl_

exyl

disp

Ei

norm

TABLE 

NAME
 εrt T S εrt velocity 
normal strain, 
global system

 εrt F S εrt velocity 
normal strain, 
global system

 εzt T S εzt velocity 
normal strain, 
global system

 εzt F S εzt velocity 
normal strain, 
global system

_t T S  velocity 
normal strain

uort

_t F S  velocity 
normal strain

 jω  uor

t  εrzt T S εrzt shear 
strain, global 
coord. system

t  εrzt F S εrzt shear 
strain, global 
coord. system

t, 
t

 εxlt, εylt F T S εxlt, εylt 
velocity normal 
strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

_t  εxylt F T S εxylt velocity 
shear strain, 
user-defined 
coord. system

 Tcoord
T εt Tcoord

 disp All All Total 
displacement

 Ei All S Electric field

E  | E | All S Electric field

8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES

SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

uort r∂
∂ uort( ) r⋅+

jω uor
r∂

∂ uor r⋅+⎝ ⎠
⎛ ⎞

z∂
∂wt

jω
z∂

∂w
⎝ ⎠
⎛ ⎞

εϕt εϕt

εϕt εϕt

1
2
---

z∂
∂ uort( ) r⋅

r∂
∂wt+⎝ ⎠

⎛ ⎞

1
2
---

z∂
∂ uor( ) r⋅

r∂
∂w

+⎝ ⎠
⎛ ⎞ jω

ui( )real( )
i
∑

2

xi∂
∂V
⎝ ⎠
⎛ ⎞–

E E⋅
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Eil

Vil

cE

 a 
nt.

e

epsi

epsi

D

epsi ic 

sigm

TABLE

NAME
 Eil All S Electric field, 
user-defined 
coord. system

 Tcoord
T  E

 Vil All S Electric 
potential 
gradient, 
user-defined 
coord. system

 Tcoord
T 

 cE All S Stiffness matrix 
components 

, if material is specified on 

strain-charge form, calculated by
special inverting-matrices eleme

 e All S Piezoelectric 
coupling matrix 
if material is 
specified on 
strain-charge 
form

lonT  εT All S Electric 
permittivity 
with stress field 
constant

 ε0 εrT

lonS  εS All S Electric 
permittivity 
with strain field 
constant

If material defined on 
stress-charge from

 ε0 εrS

If material defined on 
strain-charge from

 D All S Stiffness matrix 
components

For isotropic and anisotropic 

material

lon εe All S Electric 
permittivity 
matrix 
components

ε0 εr, for isotropic and anisotrop

material

a σe freq S Electric 
conductivity 
matrix 
components

For isotropic and anisotropic 
material 

 8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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∇V

sE
1–

dsE
1–

ε0εrT d sE
1– dt⋅ ⋅–
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sr, d. 

ε

sphi d. 

ε

srz d. 

ε

TABLE 

NAME
sz  σr, σz All S  σr,z normal 
stress, global 
coord. system

If material defined in global coor
sys.

cE ε − et E or Dε
With loss factor damping in 
frequency response analysis

(1 + jη)cE ε − et E or (1 + jη)D

If material defined in user-def. 
coord. sys.

 Tcoord σl Tcoord
T

All S  normal 
stress, global 
coord. system

If material defined in global coor
sys.

cE ε − et E or Dε
With loss factor damping in 
frequency response analysis

(1 + jη)cE ε − et E or (1 + jη)D

If material defined in user-def. 
coord. sys.

 cE εl − et El

 τrz All S  τrz shear 
stress, global 
coord. system

If material defined in global coor
sys.

cE ε − et E or Dε
With loss factor damping in 
frequency response analysis

(1 + jη)cE ε − et E or (1 + jη)D

If material defined in user-def. 
coord. sys.

 Tcoord σl t Tcoord
T

8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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σϕ σϕ
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si d. 

ε

Di d. 

Ji

Jdi

Jdi

Jpi

TABLE

NAME
 σi All S σi normal 
stress, global 
coord. system

If material defined in global coor
sys.

 cE ε − et E or Dε
With loss factor damping in 
frequency response analysis

(1 + jη)cE ε − et E or (1 + jη)D

If material defined in user-def. 
coord. sys.

 Tcoord σl Tcoord
T

 Di All S Electric 
displacement, 
xi component

If material defined in global coor
sys.

 e ε + εS E or εe E

If material defined in user-def. 
coord. sys.

 Tcoord Dl

 Ji T F S Total current 
density, xi 
component

Jd,i + Jp,i or Jd,i

If material defined in user-def. 
coord. sys.

 Tcoord Jl

 Jd,i T S Displacement 
current density, 
xi component

 Jd,i F S Displacement 
current density, 
xi component

 jω Di

 Jp,i T F S Potential 
current density, 
xi component

σeE 

If material defined in user-def. 
coord. sys.

 Tcoord Jl

 8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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t∂
∂Di
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sij d. 

ε

sil

εl

Dil

Jil

Jdil

Jdil

Jpil

TABLE 

NAME
 τij All S τij shear stress, 
global coord. 
system

If material defined in global coor
sys.

 cE ε − et E or Dε
With loss factor damping in 
frequency response analysis

 (1 + jη)cE ε − et E or (1 + jη)D

If material defined in user-def. 
coord. sys.

 Tcoord σl Tcoord
T

 σi All S σi normal 
stress, 
user-defined 
local coord. 
system

 cE εl − et El or Dεl

With loss factor damping in 
frequency response analysis

 (1 + jη)cE εl − et El or (1 + jη)D

 Dil All S Electric 
displacement, 
xi component, 
local coord. sys.

 e εl + εS El or εe El

 Jil T F S Total current 
density, xi 
component, 
local coord. sys.

Jd,il + Jp,il or Jd,il

 Jd,il T S Displacement 
current density, 
xi component, 
local coord. sys.

 Jd,il F S Displacement 
current density, 
xi component, 
local coord. sys.

 jω Dil

 Jp,il F S Potential 
current density, 
xi component, 
local coord. sys.

σeEl 

8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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t∂
∂Dil
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sijl

εl

si_t d. 

sij_ d. 

sil_t

l

sijl

l

TABLE

NAME
 τij All S τij shear stress, 
user-defined 
local coord. 
system

 cE εl − et El or Dεl

With loss factor damping in 
frequency response analysis

 (1 + jη)cE εl − et El or (1 + jη)D

σit F T S σit time 
derivative of 
normal stress, 
global coord. 
system

If material defined in global coor
sys.

 cE εt or Dεt

With loss factor damping in 
frequency response analysis

 (1 + jη)jωcE εt or (1 + jη)jωDε

If material defined in user-def. 
coord. sys.

 Tcoord σl t Tcoord
T

t τijt T S τijt time 
derivative of 
shear stress, 
global coord. 
system

If material defined in global coor
sys.

  cE εt or Dεt

With loss factor damping in 
frequency response analysis

 (1 + jη)jωcE ε or (1 + jη)jωDε

If material defined in user-def. 
coord. sys.

 Tcoord σl t Tcoord
T

σilt F T S σilt time 
derivative of 
normal stress, 
user-defined 
local coord. 
system

 cE εlt or Dεlt

With loss factor damping in 
frequency response analysis

 (1 + jη)jωcE εl or (1 + jη)jωDε

_t  τijlt F T S τijlt time 
derivative of 
shear stress, 
user-defined 
local coord. 
system

 cE εlt or Dεlt

With loss factor damping in 
frequency response analysis

 (1 + jη)jωcE εl or (1 + jη)jωDε

 8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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sr_t d. 

sphi d. 

si

ei

sixj

eixj

tres

mise

TABLE 

NAME

) ),
, sz_t σrt,σzt F T S σrt, σzt time 
derivative of 
normal stress, 
global coord. 
system

If material defined in global coor
sys.

 cE εt or Dεt

With loss factor damping in 
frequency response analysis

 (1 + jη)jωcE εt or (1 + jη)jωDε

If material defined in user-def. 
coord. sys.

 Tcoord σl t Tcoord
T

_t F T S  time 
derivative of 
normal stress, 
global coord. 
system

If material defined in global coor
sys.

  cE εt or Dεt

With loss factor damping in 
frequency response analysis

 (1 + jη)jωcE εt or (1 + jη)jωDε

If material defined in user-def. 
coord. sys.

 cE εl t

 σi All S Principal 
stresses, i = 
1,2,3

Defined by elpric element

 εi All S Principal 
strains, i = 
1,2,3

Defined by elpric element

 σixj All S Principal stress 
directions, i,j = 
1,2,3

Defined by elpric element

 εixj All S Principal strain 
directions, i,j = 
1,2,3

Defined by elpric element

ca  σtresca All S Tresca stress

s  σmises All S von Mises 
stress 
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σϕt
σϕt

max max σ1 σ2– σ2 σ3–,(
σ1 σ3– )

(
)
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norm

Ws  

 

We  

 

in 

Tai

nD

smon

eson

nJ

TABLE

NAME

onj εϕ( ))
----------------------
D  normD All S Electric 
displacement, 
norm

 Ws All S Strain energy 
density

If material properties defined in
global coord. sys.

,  in 

frequency response analyses.

If material properties defined in
local user-defined coord. sys.

, 

 in freq. resp.

 We All S Electric energy 
density

If material properties defined in
global coord. sys.

 E · D  /  2, real(conj(E) · D)/2 in 
freq. resp.

If material properties defined in
local user-defined coord. sys.

 El · Dl  /  2, real(conj(El) · Dl)/2 
freq. resp.

 Tai All B Surface traction 
(force/area) in 
xi direction

 nD All B Surface charge 
density

smon All S Structural 
equation 
available

1 or 0 

eson All S Electrical 
equation 
available

1 or 0 

 nJ F T B Current density 
outflow

 n · Jd

 8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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D D⋅

σ ε⋅
2

---------- 1
2
---real σ conj ε( )⋅( )

σl εl⋅
2

--------------

real σl conj εl( )⋅( )
2

--------------------------------------------
real σϕ c⋅(

2
-------------------------+

Tar

Taz

σr τrz

τrz σz

nr

nz

=

nup Ddown Dup–( )⋅
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nJs

Fig

TABLE 

NAME
 nJs F B Source current 
density

Only for unsymmetric electric 
currents. 

  or, 

with weak constraints, the 
Lagrange multiplier for V. 

 Fig All All Body load, edge 
load, point 
load, in global 
xi direction

If global coordinate system

If other coordinate system

8-5:  PIEZO AXIAL SYMMETRY APPLICATION MODE VARIABLES
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nup Jdown Jup–( )⋅

Frg

Fzg

Fr

Fz

=

Fxg

Fzg

Tcoord
Fr

Fz

=
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 9
G l o s s a r y  
This glossary contains finite element modeling terms in an acoustics context. For 
mathematical terms as well as geometry and CAD terms specific to the COMSOL 
Multiphysics software and documentation, please see the glossary in the COMSOL 
Multiphysics User’s Guide. For references to more information about a term, see 
the index.
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G l o s s a r y  o f  T e rm s
acoustic impedance   At a specified surface, the complex quotient of acoustic pressure 
by normal fluid velocity. SI unit: 1 Pa/(m/s) .

acoustic reactance   The imaginary part of the acoustic impedance.

acoustic resistance   The real part of the acoustic impedance.

admittance   The reciprocal of impedance.

anisotropy   Variation of material properties with direction.

characteristic impedance   The product of the equilibrium density and the speed of 
sound in a medium. SI unit: 1 Pa/(m/s).

compliance   Reciprocal of stiffness.

damping   Dissipation of energy with time or distance.

decibel (dB)   Unit of level when the base of the logarithm used in defining the level is 
the tenth root of ten and the quantities concerned are proportional to power.

Doppler effect   Change in the observed frequency of a wave caused by a time rate of 
change in the effective length of the path of travel between the source and the 
observation point.

effective sound pressure   RMS instantaneous sound pressure at a point during a time 
interval, T, long enough that the measured value is effectively independent of small 
changes in T. SI unit: 1 Pa = 1 N/m2.

eigenmode   A possible propagating mode of an acoustic wave.

impedance   At a specified frequency, the quotient of a dynamic field quantity (such as 
force, sound, pressure) by a a kinematic field quantity (such as vibration velocity, 
particle velocity).

instantaneous sound pressure   Total instantaneous pressure at a point in a medium 
minus the static pressure at the same point. SI unit: 1 Pa = 1 N/m2.
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particle velocity   In a sound field, the velocity caused by a sound wave of a given 
infinitesimal part of the medium relative to the medium as a whole.

PML (perfectly matched layer)   Domain adjoined at a system boundary designed to 
emulate a nonreflecting boundary condition independently of the shape and frequency 
of the incident wave front.

reference sound pressure   See definition in the entry for sound pressure level.

RMS value   Root-mean-square value; for the (complex) sound pressure, p(t), over the 
time interval T1 < t < T2 defined as

For a harmonic pressure wave, , the time interval is taken to be a 
complete period, resulting in pRMS = p0  /√2.

sound energy   Total energy in a given part of a medium minus the energy that would 
exist at the same part in the absence of sound waves. SI unit: 1 J.

sound-energy flux density   See sound intensity.

sound intensity   Average rate of sound energy transmitted in a specified direction at a 
point through a unit area normal to this direction. SI unit: 1 W/m2.

sound pressure   See effective sound pressure.

sound pressure amplitude   Absolute instantaneous sound pressure in any given cycle 
of a sound wave at some specified time. SI unit: 1 W/m2.

sound power density   See sound intensity.

sound pressure level   Ten times the logarithm to the base ten of the ratio of the 
time-mean-square pressure of a sound, in a stated frequency band, to the square of a 
reference sound pressure, pref. For gases, pref = 20 µ Pa, for other media (unless 
otherwise specified) pref = 1 µ Pa. Unit: 1 dB (decibel).

sound source strength   Maximum instantaneous rate of volume displacement 
produced by a source when emitting a harmonic sound wave. SI unit: 1 m3/s. 

pRMS
1

T2 T1–
------------------- Re p t( )[ ] 2 td

T1

T2∫=

p t( ) p0eiωt
=
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specific acoustic impedance   At a point in a sound field, the quotient of sound pressure 
by particle velocity. SI unit: 1 Pa/(m/s).

speed of sound   The rate of change of particle displacement with distance for a sound 
wave. SI unit: 1 m/s.

static pressure   Pressure that would exist at a point in the absence of a sound wave.

stiffness   Ratio of change of force (or torque) to the corresponding change in 
translational (or rotational) displacement of an elastic element.
R  9 :  G L O S S A R Y
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A absorbing boundary conditions 73, 116, 

171

acceleration 175

acoustics

boundary conditions for 62

mathematical models for 9, 62

standard problems in 8

Acoustics Module 3.4

new features in 2

aeroacoustics 108

boundary conditions for 109

Aeroacoustics application mode 112

Aeroacoustics with Flow application 

mode 135

amplitude 56, 147, 169

variables 175, 183, 219

analysis

capabilities 52, 152

damped eigenfrequency 57, 149

eigenfrequency 56

frequency response 55, 147

harmonic 147

modal 57

static 55, 147

transient 58

analysis types 55

for piezoelectric modeling 194

application mode

Solid, Stress-Strain 174

application mode guide 52

Application Mode Properties dialog box 

57, 101, 114, 124, 161, 194

application mode variables

Aeroacoustics 121

Axial Symmetry, Stress-Strain 183

Plane Strain 178

Pressure Acoustics 94

Solid, Stress-Strain 175

application modes

Aeroacoustics 112

Aeroacoustics with Flow 135

Axial Symmetry, Stress Strain 181

Compressible Potential Flow 130

Piezo Axial Symmetry 217

Piezo Plane Strain 216

Piezo Solid 216

piezoelectric 194

Plane Strain 177

Pressure Acoustics 64

Solid, Stress-Strain 174

artificial boundary conditions 29

attenuation coefficient 72

attenuation of reflections 75

axial symmetry

in pressure acoustics 78

symmetry axis 182, 218

Axial Symmetry, Stress Strain application 

mode 181

axial wave number 99, 100

B barotropic fluid 110

Bernoulli equation 110

boundary conditions

absorbing 73, 116, 171

for aeroacoustics 109

for electric currents 208

for modal analysis 104

mass flow 117

matched 29, 73, 84, 105

periodic 77

slit 85, 120

velocity potential 118

vortex sheet 120
I N D E X | 251



252 | I N D E X
boundary modal analysis 99

bulk modulus 62

bulk viscosity 73

C charges 212

circumferential wave number 66

complex impedance 72

complex material 72

complex modulus 150

complex notation 148

complex wave number 72

compliance matrix 145, 200, 201

compressible potential flow 109

Compressible Potential Flow application 

mode 130

constitutive equation 144

constitutive form

piezoelectric material 197

strain-charge 198

stress-charge form 197

constraints 164

coordinate systems for 165, 211

for piezoelectricity 210

general notation for 166

standard notation for 166

continuum application modes

damping 169

Coordinate System Settings dialog box 

155

coordinate systems

defining loads in 168

for constraints 211

for loads 213

for material properties 200, 204

in constraints 165

local geometrical 154

user-defined 154

cylindrical coordinates 181, 217

cylindrical wave 82

D damped eigenfrequency analysis 57, 149

damping 71

at boundaries 28

continuum application modes 169

Delany-Bazley model 73

equivalent viscous 214

loss factor 151, 170, 214, 215

no damping 170

page for specifying 169, 214

piezoelectric 214

Rayleigh 170, 214

stiffness 170, 215

structural 150

damping factor 150

damping models

loss factor 150

Rayleigh 149

structural mechanics 149

Damping page 169, 214, 215

damping ratio 150

decay factor 149

degrees of freedom 26

Delany-Bazley’s method 73

dependent variables 52, 152

dialog box

Application Mode Properties 57, 161, 

194

Coordinate System Settings 155

Elasticity matrix 198

H Matrix 167

Relative permittivity 198

diatomic gas 131

dipole source 62

direct piezoelectric effect 188

dispersion curve 58

Doppler shift 136

E edge conditions 121

eigenfrequency 57



eigenfrequency analysis 56

pressure acoustics 67

eigenvalue 57

elastic waves 171

elasticity matrix 145

Elasticity matrix dialog box 198

Electric BC page 206

electric boundary conditions 206

electric currents

boundary conditions for 208

electric displacement 207

electric potential 207, 208

elkernel element 33

engineering assumption 152

equivalent viscous damping 214

Euler equations 109

evanescent wave components 30

excitation frequency 148, 169, 195

F far-field limit 32

far-field postprocessing 90

far-field region 30

flexibility matrix 145

force potential 131

Fourier domain 55

Fraunhofer diffraction 30

frequency domain 55

frequency response analysis 55, 147, 169

amplitude 147

phase 147

Fresnel numbers 30

G Gaussian pulse 65, 88

general notation for constraints 166

Green’s function 31

guess variables 38, 75, 172

inspecting values of 42

H H Matrix dialog box 167

Hankel function 31

harmonic loads 147, 169

Helmholtz-Kirchhoff integral 31

Higdon conditions 79

I ideal barotropic fluid 110

IEEE standard, for piezo theory 189

impedance 118

impedance boundary condition 77, 86

incoming wave 79, 119

input impedance 118

intensity condition, for sources 89

interface conditions 85, 120

interior boundaries

interface conditions on 85

inverse piezoelectric effect 188

irrotational velocity field 108

isotropic material 144

L large acoustics problems 33

line sources 86

linear elastic materials 144

liquid-gas interface 77

loads 212

amplitude 169

coordinate systems for 168, 213

harmonic 169

page for specifying 167

phase 169

units 168

units for 213, 214

local coordinate systems 154

loss factor 151, 171, 215

loss factor damping 150, 170, 214

M mass damping parameter 171, 215

mass flow 117

matched boundary conditions 29, 73, 84, 

105

material damping 150

material libraries 47
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material orientation

in piezoelectric application modes 198

Material page 163

material properties

coordinate system for 200

settings for 196

materials

isotropic 144

linear elastic 144

piezoelectric 188

matrix

compliance 145, 200, 201

elasticity 145

flexibility 145

piezo coupling 201

mean flow speed of sound 126

MEMS Material Properties library 48

modal analysis 57

boundary conditions for 104

Model M-file 6

modes

evanescent 57

propagating 57

monopole sources 62, 64

multigrid solvers 33

multiphysics models 6

N near-field region 30

neutral boundary conditions 84

new features in version 3.4 2

no-flow condition 117

nonreflecting boundary conditions 29, 84

normal acceleration 78

normal mass flow 117, 127

normal stress 144

normal velocity 119

Nyquist criterion 34

O obliquely incident waves 37

out-of-plane wave number 66, 100, 113, 

125

P page

Constraint 164, 210

Damping 169, 214

Load 167

Material 163

pairs, interface conditions for 85, 120

perfectly matched layers 73, 116, 171

for acoustic waves 37

for elastic waves 171

tutorial example for 40

types of 74, 116

perforated plate 86

periodic boundary conditions 77

phase 56, 147

variables 175, 183, 219

phase factor 66

Piezo Axial Symmetry application mode 

217

piezo coupling matrix 201

Piezo Plane Strain application mode 216

Piezo Solid application mode 216

piezoelectric

analysis types 194

piezoelectric application modes

application mode properties 194

piezoelectric effect 188

Piezoelectric Material Properties library 

47

piezoelectric materials 188

Plane Strain

application mode variables 178

Plane Strain application mode 177

plane wave 82

plane-wave basis directions

number of per UWVF finite element 

93

PMLs. See perfectly matched layers



point conditions 121

point sources 86

Poisson’s ratio 163

porous absorbing materials 28

power condition, for sources 90

pressure acoustics

eigenfrequency analysis 67

time-harmonic analysis 65

transient analysis 64

Pressure Acoustics application mode 64

pressure reference

for sound pressure level 69, 101, 113, 

126

pressure source 77

principal strain 176

direction 176

principal stress 176

direction 176

propagating modes 57

propagation constant 100, 125

Q quality factor 149

R radiation boundary conditions 29, 73, 79, 

116

radiation condition 104, 118

Rayleigh damping 149, 170, 214

Relative permittivity dialog box 198

resolving acoustic waves 26

resonance frequency 57

S scalar variables 162, 195

scattered field

variables for 46

scattered-field formulation 45, 65

second Piola-Kirchhoff stress 151

shear modulus 164, 202

shear strain 144

slit boundary condition 85, 120

Solid, Stress-Strain

application mode variables 175

Solid, Stress-Strain application mode 174

solving large problems 33

sound pressure level 95

of far-field variable 91

pressure reference for 69, 101, 113, 

126

sound-hard boundary 77

sound-hard condition 117

sound-soft boundaries 117

sound-soft boundary 77

sources 62

specific heat ratio 131

speed of sound 64

spherical wave 82

standard acoustics problems 8

standard notation for constraints 166

static analysis 55, 147

stiffness damping 170, 215

stiffness damping parameter 171, 215

strain 144

axial symmetry 182, 217

engineering form 144

principal 176

shear 144

tensor form 144

strain energy 146

strain tensor 144

strain-charge form 198

strain-displacement relation 144

stress 144

normal 144

principal 176

second Piola-Kirchhoff 151

tensor 144

stress-charge form 197

stress-strain relation 144

structural damping 150, 214
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surface charge 207

surface traction 176

symmetry axis 182, 218

symmetry planes

for far-field processing 91

T time domain 55

time-harmonic analysis 55

aeroacoustics 113

pressure acoustics 65

transient analysis 58

aeroacoustics 112

pressure acoustics 64

transient point sources 88

transverse mode 99

typographical conventions 2

U ultraweak variational formulation 27, 92

user-defined coordinate systems 154

UWVF 27, 92

V variables

amplitude 175, 183, 219

dependent 52

phase 175, 183, 219

velocity 175

velocity potential

boundary condition 118

field 110

viscous damping 149

vortex sheet boundary condition 120

W wall boundary 77

wave direction cosines 83

wave number

axial 99, 100

circumferential 66

out-of-plane 66, 100, 113, 125

waveguide 57

Y Young’s modulus 145, 163


	CONTENTS
	Chapter 1: Introduction
	Chapter 2: Acoustics Module Overview
	Capabilities 6
	Fundamentals of Acoustics 8

	Chapter 3: Modeling Acoustics
	Building and Solving an Acoustics Model 14
	Some Aspects of Acoustics Modeling 26
	Perfectly Matched Layers (PMLs) 37
	Scattered-Field Formulation 45
	Material Libraries 47

	Chapter 4: Application Mode Overview
	Application Mode Guide 52

	Chapter 5: Pressure Acoustics
	Theory Background 62
	Application Mode Description 64
	Pressure Acoustics, Modal Analysis 99

	Chapter 6: Aeroacoustics
	Theory Background 108
	Application Mode Description 112
	Aeroacoustics-Modal Analysis 124
	Compressible Potential Flow 130
	Aeroacoustics with Flow 135
	An Example Model-Doppler Shift 136

	Chapter 7: Structural Mechanics Application Modes
	Theory Background 144
	Application Mode Overview 152
	Common Application Mode Features 153
	Solid, Stress-Strain 174
	Plane Strain 177
	Axial Symmetry, Stress-Strain 181

	Chapter 8: Piezoelectric Application Modes
	Theory Background 188
	The Piezoelectric Application Modes 194

	Chapter 9: Glossary
	Glossary of Terms 248


	Introduction
	New Features in the Acoustics Module 3.4
	Typographical Conventions

	Acoustics Module Overview
	Capabilities
	What Can the Acoustics Module Do?
	Which Problems Can You Solve?

	Fundamentals of Acoustics
	What Is Acoustics?
	Some Standard Acoustics Problems


	Modeling Acoustics
	Format for the Model Descriptions
	Building and Solving an Acoustics Model
	Introduction
	Model Definition
	Results and Discussion
	Modeling in COMSOL Multiphysics
	Modeling Using the Graphical User Interface

	Some Aspects of Acoustics Modeling
	Resolving the Waves
	Damping
	Artificial Boundaries
	Evaluating the Acoustic Field in the Far-Field Region
	Solving Large Acoustics Problems Using Multigrid
	Reference

	Perfectly Matched Layers (PMLs)
	PML Implementation
	How to Set Up a PML
	Modeling Using the Graphical User Interface
	Reference

	Scattered-Field Formulation
	Application Modes with Scattered Fields
	Example Model

	Material Libraries
	Piezoelectric Material Properties Library
	MEMS Material Properties Library


	Application Mode Overview
	Application Mode Guide
	Analysis Capabilities
	Application Mode Documentation Notes


	Pressure Acoustics
	Theory Background
	Mathematical Model

	Application Mode Description
	Variables and Space Dimensions
	PDE Formulation
	Application Mode Properties
	Application Scalar Variables
	Subdomain Settings
	Boundary Conditions
	Point and Edge Conditions
	Far-Field Modeling
	The Ultraweak Variational Formulation
	Application Mode Variables
	References

	Pressure Acoustics, Modal Analysis
	Variables and Dimensions
	PDE Formulation
	Application Scalar Variables
	Application Mode Properties
	Subdomain Settings
	Boundary Conditions
	Application Mode Variables


	Aeroacoustics
	Theory Background
	Aeroacoustics
	Compressible Potential Flow

	Application Mode Description
	Variables and Space Dimensions
	PDE Formulation
	Application Scalar Variables
	Application Mode Properties
	Subdomain Settings
	Boundary Conditions
	Point and Edge Conditions
	Application Mode Variables

	Aeroacoustics-Modal Analysis
	Application Mode Properties
	PDE Formulation
	Application Scalar Variables
	Boundary Conditions
	Edge Conditions
	Application Mode Variables
	2D Axisymmetric Geometries
	2D Geometries
	Point Settings

	Compressible Potential Flow
	PDE Formulation
	Application Mode Properties
	Application Scalar Variables
	Subdomain Settings
	Boundary Settings
	Application Mode Variables

	Aeroacoustics with Flow
	An Example Model-Doppler Shift
	Introduction
	Model Definition
	Results and Discussion
	Modeling Using the Graphical User Interface


	Structural Mechanics Application Modes
	Theory Background
	Strain-Displacement Relationship
	Stress-Strain Relationship
	Implementation

	Application Mode Overview
	Common Application Mode Features
	Coordinate Systems
	Properties
	Scalar Variables
	Material
	Constraints
	Loads
	Damping
	Perfectly Matched Layers (PMLs)
	References

	Solid, Stress-Strain
	Variables and Space Dimensions
	Application Mode Parameters
	Application Mode Variables

	Plane Strain
	Material
	Application Mode Parameters
	Application Mode Variables

	Axial Symmetry, Stress-Strain
	PDE Formulation
	Application Mode Variables


	Piezoelectric Application Modes
	Theory Background
	The Piezoelectric Effect
	Piezoelectric Constitutive Relations
	Material Models
	Electrical Formulations

	The Piezoelectric Application Modes
	Application Mode Properties
	Scalar Variables
	Material Properties
	Electric Boundary Conditions
	Constraints
	Loads and Charges
	Structural Damping
	The Piezo Solid Application Mode
	The Piezo Plane Strain Application Mode
	The Piezo Axial Symmetry Application Mode
	Application Mode Variables


	Glossary
	Glossary of Terms

	INDEX
	A
	B
	C
	D
	E
	F
	G
	H
	I
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	Y


